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Chapter 1: Integrating with Other Applications Overview
Integrating OMi with other software products is a great way to extend your IT management capability.
This document describes some of the major integrations between OMi and other HPE products, but
does not constitute a full list of all possible integrations. For a complete list of available product
integrations, see the Integrations Catalog on HPE Software Support.

OMi-OMi Integrations
Integrations between multiple OMi deployments enable the exchange of events by using event
synchronization and topology synchronization.
For more information on working with multiple OMi deployments, see the OMi Administration Guide.

OMi-Configuration Management Systems Integrations
OMi integrates with HPE Universal CMDB to enable sharing topologies (CIs and relationships)
between instances and enabling a consistent CI ID in an environment. The integration uses the
Configuration Management System (CMS) topology. A single instance is configured to be the CMS and
the global ID generator; synchronization is achieved by using the topology synchronization.
For details on setting up these integrations, see the Data Flow Management Guide.

SSL Setup
Ensure that the software products that you are integrating use the same SSL setup. For example, it is
not supported to use HTTP for OO and at the same time HTTPS for OMi, or vice versa.
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Important note: In the following sections, we will refer to the product as BSM, and to the
integration of BSM 9.25 and later, and APM 9.30, with OMi as the APM Integration.
The Application Performance Management (APM) integration of BSM with OMi enables you to:
l

l

l

Design a dashboard in which you see OMi and BSM data displayed side by side. It is possible to drill
down into the BSM data from this dashboard.
Integrate user interface components from separately deployed BSM systems directly into the OMi's
MyWorkspace pages. In this way, relevant information is shown directly within the OMi user
interface, although this data comes from the BSM system.
Use the OMi embedded graphing component to show performance data stored within the Profile
database of the BSM system. For detailed information around business transactions, business
transaction flows, or specific information about location-based monitoring within BSM, it will be
required to drill down into MyBSM pages. For this purpose, OMi provides drill-down operations that
allow to launch the BSM user interface in the context of a specific CI or event.

Supported Versions
l

OMi 10.00 and later

l

BSM 9.25 IP 1 and later

l

APM 9.30

l

l

Older version of BSM 9.2x with additional configuration (see "If your BSM deployment is not
upgraded from BSM 9.24 (or earlier), begin here:" on page 14)
UCMDB Data Flow Probe 10.22.290
Note: To initially synchronize CIs from APM to OMi, in DataFlowProbe.properties, update the
following property:
appilog.agent.local.process.result.filterRedundant.filterIgnoredCIs = false

Understanding the Integration Process
Each instance of the APM Integration is represented in OMi as a connected server. If you are
integrating multiple BSMs, each one will be a separate connected server.
When you integrate BSM with OMi, there are a number of steps that occur behind the scenes:
1. Topology Synchronization. The first step of the integration involves pulling the topology of CIs
from BSM into OMi. This can take some time, and in very large environments can take several
hours.
The topology of domain-specific CIs such as Business Transactions (BTs) and Business
Transaction Flows (BTFs) are not synchronized by default. Instead, we synchronize the Business
Application CI which reflects any status changes to these CIs and any BT/BTF CIs that are
related to it in BSM.
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Note that the following procedure describes how to integrate BSM into OMi by using the default
integration TQLs. If you have any topologies not covered by the out-of-the-box TQLs, create a
custom integration TQL. The TQL needs to be defined on the BSM side. For information on how to
create an integration TQL, see the Modeling Guide.
Topology from BSM can also be synchronized via an external UCMDB. In this case, BSM CIs are
pulled into the UCMDB and then pushed to OMi. For more information on setting up the topology
synchronization with an external UCMDB, see "(external UCMDB only) Step 1: Prepare the
topology synchronization" on page 20.
2. BSM Status Change Alert Creation. After the BSM topology is integrated into OMi, BSM status
change alerts are created within BSM to generate events upon HI or KPI status change.
Forwarding rules then define that these alerts will be sent to OMi. As a result, when a CI's status
changes in BSM, an event is sent to OMi to update the CI's status.
3. Initial Status Synchronization. When setting up the APM-OMi integration, there is an initial
status synchronization so that each CI in OMi receives the status it has in BSM. After the initial
synchronization, whenever a CI's status changes in BSM, OMi receives a status change event.
This event changes the CI's status in OMi, but the event is not displayed in the Event Console.
In general, when a KPI's status changes in BSM, the KPI changes status in OMi. In addition, if an
HI's status changes on one of the CIs that we synchronized from BSM into OMi, this status
change is reflected directly in OMi.
4. Downtime Synchronization. After the above steps are complete, you can synchronize
downtimes, so that any downtimes defined in OMi will also apply to BSM. This includes the
downtime CI, the CIs connected to the downtime, and the scheduling and action configurations
(such as stopping monitoring, sending alerts and emails, and so on). In addition, OMi serves as
the central downtime management location, so you can enable one time initial synchronization of
BSM downtime to OMi, in order to help start managing all downtimes on the OMi side.
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To integrate BSM with an OMi deployment, complete the following steps:
l

"Before You Begin: To integrate a BSM deployment that has been upgraded from BSM 9.24 (or
earlier)" below
If your BSM deployment is not upgraded from BSM 9.24 (or earlier), begin here:

l

"(RTSM only) Step 1: Install the UCMDB Data Flow Probe" on page 18 or "(external UCMDB only)
Step 1: Prepare the topology synchronization" on page 20

l

"Step 2: Set Up TLS and Root Certificates" on page 22

l

"Step 3: Configure Lightweight Single Sign-On" on page 23

l

"Step 4: Create the Integration User" on page 24

l

"Step 5: Set Up an APM Connected Server in OMi and Complete the Integration" on page 25

l

"(APM 9.30 only) Step 6: Enabling Alert and Status Forwarding" on page 28

l

"(APM 9.30 only) Step 7: Creating OMi Authentication User Name and Password" on page 29

l

"(APM 9.30 only) Step 8: Importing Certificates for REST Service" on page 29

l

"(APM 9.30 only) Step 9: Using Unsecured http REST Access" on page 30

l

"Step 10: KPI Assignments in OMi " on page 30

l

"Troubleshooting for the APM-OMi Integration" on page 31

Before You Begin: To integrate a BSM deployment that
has been upgraded from BSM 9.24 (or earlier)
To integrate a BSM 9.25 (or later) deployment that has been upgraded from a running BSM 9.24 (or
earlier), you must complete the following steps first.
If you integrate remotely, copy all the content packs to your computer and then point to the local
location to deploy the package.
1. (For BSM 9.2x only) On your BSM server, check if uCMDB content pack 11.13.859 is installed.
On the BSM system, navigate to:
Admin > RTSM Administration > Administration > Package Manager.
Click the Install Content Pack icon to open the Install Content Pack window. It should show
the following:
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If you see this, it is installed and you can carry on with the next step. If it is not yet installed, install
it by using the Package Manager:
a. Navigate to Admin > RTSM Administration > Administration > Package Manager to
open the RTSM Package Manager.
b. Click

Install Content Pack to open the Install Content Pack window.

c. Select 11* from Version and click Install to install the content pack version 11. Note that you
will only see content packs that are available but not yet installed. Those that are installed,
you will not see here.
2. On your BSM server, import all the packages listed below. Note that you must import these .zip
files, even if these files are already present on the BSM server:
BLE.zip
Business.zip
Diagnostics.zip
OMi_Integration.zip
Sitescope.zip
To get the TQLs from BLE.zip:
a. Navigate to Admin > RTSM Administration > Administration > Package Manager to
open the RTSM Package Manager.
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b. Click

to open the Deploy Packages to Server window and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.
d. Open BLE.zip, then click BLE.zip to see the list of resources.
e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.
To get the TQLs from Business.zip:
a. Navigate to Admin > RTSM Administration > Administration > Package Manager to
open the RTSM Package Manager.
b. Click

to open the Deploy Packages to Server window and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.
d. Open Business.zip, then click Business.zip to see the list of resources.
e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.
To get the TQLs from Diagnostics.zip:
a. Navigate to Admin > RTSM Administration > Administration > Package Manager to
open the RTSM Package Manager.
b. Click

to open the Deploy Packages to Server window and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.
d. Open Diagnostics.zip, then click Diagnostics.zip to see the list of resources.
e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.
To get the TQLs from OMi_Integration.zip:
a. Navigate to Admin > RTSM Administration > Administration > Package Manager to
open the RTSM Package Manager.
b. Click

to open the Deploy Packages to Server window and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.
d. Open OMi_Integration.zip, then click OMi_Integration.zip to see the list of resources.
e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.
To get the TQLs from Sitescope.zip:
a. Navigate to Admin > RTSM Administration > Administration > Package Manager to
open the RTSM Package Manager.
b. Click

to open the Deploy Packages to Server window and click .

c. Navigate to <BSM_HOME>/odb/conf/factory_packages.
d. Open Sitescope.zip, then click Sitescope.zip to see the list of resources.
e. Click Deploy to deploy your resource and click ok in the box Resources have been
deployed successfully.
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To validate that these packages containing individual TQLs have been loaded correctly, you can
look them up in the Modeling Studio. Navigate to:
a. Administration > RTSM Administration > Modeling > Modeling Studio
b. Select Resource Type: Queries. In the list, expand Root and scroll down to verify that CIs_
For_CIStatusChange_in_OMi is present. Next, expand Root > Integration > OMi_
Integration to verify that the following packages are present:
OMi_Sync_Biz
OMi_Sync_BPI
OMi_Sync_Diag_TV
OMi_Sync_SiS
OMi_Sync_SiS_EMS
3. On your BSM or APM deployment, proceed as follows to check whether OMi is configured for
single sign-on configuration. First, read out the values from the JMX console to determine whether
further steps are required:
a. For BSM versions 9.25, open the JMX console on your BSM gateway server by typing in a
web browser:
http://localhost:8080/jmxconsole/HtmlAdaptor?action=inspectMBean&name=Foundations%3Aservice%3DInfrast
ructure+Settings+Manager
b. For BSM versions 9.26 or APM 9.30, open the JMX console on your BSM gateway server by
typing in a web browser:
http://localhost:29000
Navigate to Foundations > Foundations: service=Infrastructure Settings Manager
c. Find the method java.lang.String getGlobalSettingValue().
d. Change contextName to SingleSignOn.
e. Change settingName to lw.sso.configuration.xml.
f. Click Invoke.
In the resulting output, search for the string omi. If the string omi is present twice, your deployment
is configured correctly and no further steps are required.
4. If the resulting output does not contain the string omi, BSM is not yet correctly configured for
integrating with OMi. In this case, you must append the necessary data:
a. On your BSM Gateway Server, copy and paste the entire result output in a text editor and
append the following URLs between the <restURLs> and the </restURLs> tags:
<url>.*/topaz.*/omi.*/integration.*</url>
<url>.*/topaz.*/acweb.*</url>
<url>.*/topaz.*/personalization.*</url>
<url>.*/topaz.*/bsmLight.*</url>
<url>.*/topaz.*/ldapContext.*</url>
<url>.*/topaz.*/bsmLight.*/BPM.*</url>
b. Also append the following between the <inbound> and </inbound> tag:
<service service-pattern=
".*/topaz.*/omi.*/integration.*" service-type="rest">
<in-lwsso refid="ID000001"/>
<in-custom

HPE Operations Manager i (10.12)

Page 17 of 207

OMi Integrations Guide
Chapter 3: How to Integrate BSM with OMi

classname="com.mercury.topaz.reportsExt.login.BsmLwSsoBasicAuthHandler"/>
<in-lwssoAutoCreate refid="ID000002"/>
</service>
c. Copy the entire content from the two steps above.
d. Open the JMX console on your BSM gateway server by typing in a web browser, preferably
Firefox:
http://localhost:<port>/jmxconsole/HtmlAdaptor?action=inspectMBean&name=Foundations%3Aservice%3DInfrast
ructure+Settings+Manager
For BSM 9.25, <port> is 8080.
For BSM 9.26 and APM 9.30, <port> is 29000.
e. Find the method void setGlobalSettingValue().
f. Change the contextName to SingleSignOn.
g. Change the settingName to lw.sso.configuration.xml.
h. Paste the new content into the Value field.
i. Click Invoke.
j. Restart the Mercury AS process.
Note: In a distributed environment, you must manually establish a trust relationship between
your BSM and OMi systems. Run the following command on the BSM data processing
server:
<OMi_HOME>/opr/bin/BBCTrustServer.[bat|sh] <FQND of OMi data processing
server>

(RTSM only) Step 1: Install the UCMDB Data Flow Probe
If you plan a direct integration between BSM-OMi (no external UCMDB) to integrate BSM CIs directly
into the RTSM, complete the following steps. If you plan to synchronize topology from BSM via an
external UCMDB, skip these steps and instead begin with "(external UCMDB only) Step 1: Prepare the
topology synchronization" on page 20.
The UCMDB Data Flow Probe pulls data from BSM to OMi. To install the UCMDB Data Flow Probe for
OMi:
1. Get the UCMDB Data Flow Probe installation bits from the OMi media kit. The UCMDB Data
Flow Probe must be of the same version as the RTSM that OMi uses. The UCMDB Data Flow
Probe can be installed on either the OMi gateway server or data processing server. For more
details on the installation of the Data Flow Probe, see the Data Flow Probe ReadMe on the media
kit.
2. Install the UCMDB Data Flow Probe according to the instructions in the UCMDB Data Flow Probe
Installation Guide. Make sure:
o

The UCMDB Data Flow Probe is connected to OMi.

o

HP BSM is selected as the application server.

HPE Operations Manager i (10.12)

Page 18 of 207

OMi Integrations Guide
Chapter 3: How to Integrate BSM with OMi

o

The OMi gateway server or virtual server name is specified.

3. Set credentials so that the domain name appears in a drop-down list during configuration of the
connected server:
a. Navigate to:
Administration > RTSM Administration > Data Flow Management > Data Flow Probe
Setup
b. Select DefaultDomain(Default) and expand Credentials to go to Generic Protocol.
c. Click
New in the Generic Protocol pane to open the Generic Protocol Parameters
wizard.
d. Leave the default values in the General section.
e. Enter the user name and password of one of the following in the Generic section:
n

BSM user who has SDK permission and is allowed to perform synchronizations

n

BSM administrator

n

Integration user (as described in "Step 4: Create the Integration User" on page 24)

4. Start the Data Flow Probe before integrating BSM, by using
<INSTALL_DIR>/UCMDB/DataFlowProbe/bin/gateway.bat|sh start.
To see whether the UCMDB Data Flow Probe started successfully, check the following log file :
<INSTALL_DIR>/UCMDB/DataFlowProbe/runtime/log/WrapperProbeGw.log
Allow approximately 10 minutes for this process to finish as the Data Flow Probe is uploading a
large number of files from the RTSM.
5. Increase the RTSM timeout in these two places if network latency is likely:
Note: The JMX Console can only be used remotely when its use is configured in BSM or OMi
respectively. For information on how to configure your JMX Console remotely, see the OMi
Administration Guide.
To log in the JMX Console, use the user name sysadmin and the password admin.
a. On your OMi deployment, open the RTSM JMX console in a web browser:
http://localhost:21212/jmx-console/HtmlAdaptor.
Click UCMDB:service=Settings Services.
Click setSettingValue.
For customerID, enter value 1.
For name, enter value task.DataAccess.Manager.getAdapterClassesConfig.timeOut.
For value, enter value <timeout in milliseconds> (default is 20000).
b. Also, in the RTSM JMX console http://localhost:21212/jmx-console/HtmlAdaptor,
Click UCMDB:service=Settings Services.
Click setSettingValue.
For customerID, enter value 1.
For name, enter value configuration.remote.action.timeout.
For value, enter value <timeout in milliseconds> (default is 35000).
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(external UCMDB only) Step 1: Prepare the topology
synchronization
If you plan to synchronize topology via an external UCMDB, follow these steps to synchronize CIs
between BSM, OMi, and the UCMDB. In this case, HPE advises that you use the external UCMDB as
Global ID generator.
Make sure that the Data Flow probe has been installed on the UCMDB server.
If you plan to integrate BSM CIs directly into the RTSM, see "(RTSM only) Step 1: Install the
UCMDB Data Flow Probe" on page 18.
This section includes:
l

"Task 1: Create Integration Point in UCMDB for BSM" below

l

"Task 2: Create Integration Job to pull CIs from BSM" on the next page

l

"Task 3: Create Integration Point in UCMDB for OMi" on the next page

l

"Task 4: Create Integration Job to Push CIs to OMi" on page 22

l

"Task 5: Verify the Topology Synchronization" on page 22

Task 1: Create Integration Point in UCMDB for BSM
Create an integration point in the UCMDB for BSM:
1. In the UCMDB, go to:
Managers > Data Flow Management > Integration Studio
2. Click New Integration Point or Edit, enter a name and description of your choice, and select the
adapter: UCMDB 9.x
3. Enter the following information for the adapter:
o

o

Hostname/IP: <gateway server hostname>
Port: < 80 or 443 depending on your protocol>

o

Protocol: <communication protocol>

o

Remote Machine State: Actual

o

Push Back Ids For Population: Enabled

o

CMDB State (Data Push): Actual

o

Data Flow Probe: CMDB

4. Specify the credentials for the user you created to access the BSM system.
5. Click OK, then click the Save button above the list of the integration points.
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Task 2: Create Integration Job to pull CIs from BSM
Next, create an integration job that will pull the CIs from BSM based on the TQLs specified:
1. Select the Integration Point you created in Step 1. Click the Population tab on the right pane, and
click Create New.
2. Click

Add and go to Root > Integration > OMi_integration.

3. Choose the following five TQLs (running order does not matter for this integration):
o

OMi_Sync_Biz

o

OMi_Sync_BPI

o

OMi_Sync_Diag_TV

o

OMi_Sync_SiS

o

OMi_Sync_SiS_EMS

4. Select the check box Allow Integration Job to delete removed data.
5. In the Scheduler Definition section, define the job schedule.

Task 3: Create Integration Point in UCMDB for OMi
Create an integration point in the UCMDB for OMi:
1. In the UCMDB, go to:
Managers > Data Flow Management > Integration Studio
2. Click New Integration Point or Edit, enter a name and description of your choice, and select the
adapter: UCMDB 10.x
3. Enter the following information for the adapter:
o

Hostname/IP: <gateway/LB server hostname>

o

Port: < 80 or 443 depending on your protocol>

o

Protocol: <communication protocol>

o

Remote Machine State: Actual

o

Push Back Ids for Population: Enabled

o

Push Back Ids for Push: Disabled

o

CMDB State (Data Push): Actual

o

Data Flow Probe: CMDB
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4. Specify the credentials for the user you created to access the OMi system.
5. Click OK, then click the Save button above the list of the integration points.

Task 4: Create Integration Job to Push CIs to OMi
Next, create an integration job that will push the CIs from the UCMDB to OMi based on the TQLs
specified:
1. Select the Integration Point you created in Step 3. Click the Data Push tab on the right pane, and
click Create New.
2. Based on the CIs you would like to push from the UCMDB to OMi, use an appropriate TQL. As a
starting point, you can use RTSMtoCMSSync.
If you use the RTSMtoCMSSync TQL as a starting point, you must make sure that the correct
attributes for your integration are synchronized. Right click any node and select Properties to
bring up the Query Node Properties window. On the Element Layout tab, select Select
attributes for layout. In the Conditions section, adjust the conditions in order to include the
attributes you need. If you would like to include all attributes, set Attributes condition to All.

Task 5: Verify the Topology Synchronization
Run the integration jobs and verify the integration results in the UCMDB Manager.

Step 2: Set Up TLS and Root Certificates
If you have hardened your OMi server, you must configure TLS in the Data Flow Probe and establish
trust between the Data Flow Probe server and the OMi server.
1. Enable TLS in the DFP to connect to OMi:
a. Open <DFP_HOME>/conf/DataFlowProbe.properties.
b. Change the property appilog.agent.probe.protocol from HTTP to HTTPS.
c. Change the property serverPortHttps from 8443 to 443.
2. Establish trust between the DFP server and the OMi server:
a. Import issue of OMi server certificate into JRE’s trust store:
<UCMDB_HOME>/UCMDB/DataFlowProbe/bin/jre/bin/keytool -import -trustcacerts file <CA cert>.pem -alias <ca cert alias> -keystore
<UCMDB_HOME>/UCMDB/DataFlowProbe/bin/jre/lib/security/cacerts
b. Import issue of BSM server certificate into JRE’s trust store:
<UCMDB_HOME>/UCMDB/DataFlowProbe/bin/jre/bin/keytool -import -trustcacerts file <CA cert>.pem -alias <ca cert alias> -keystore
<UCMDB_HOME>/UCMDB/DataFlowProbe/bin/jre/lib/security/cacerts
3. Restart the DFP server.
You must import the root certificate from your certification authority to the OMi and the BSM data
processing servers and gateway servers.
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1. On the OMi gateway and data processing servers, run the following command:
<OMi_HOME>/JRE/bin/keytool.[exe, sh]-import -trustcacerts -file <Root
Certificate of your Certificate Authority> -alias <any name> -keystore <OMi_
HOME>/JRE/lib/security/cacerts
2. On the BSM gateway and data processing servers, run the following command:
<BSM_HOME>/JRE/bin/keytool.[exe, sh]-import -trustcacerts -file <Root
Certificate of your Certificate Authority> -alias <any name> -keystore <BSM_
HOME>/JRE/lib/security/cacerts
3. Restart the OMi and BSM gateway and data processing servers.

Step 3: Configure Lightweight Single Sign-On
Aligning Lightweight Single Sign-On on both deployments enables you to view BSM components in the
OMi user interface.
Set up Lightweight Single Sign-On (LW-SSO) and align initString on both systems. It is good
practice that the product added to the existing environment gets the same key as the already existing
deployments. For example, if OMi is added last, the key needs to be changed in OMi. If more than one
BSM server is connected to the same OMi server, change the initString parameter on the BSM side.
Note: LW-SSO will not work if TLS is enabled for one product but not the other. Make sure that the
TLS setup is consistent between products before trying to configure LW-SSO.
l

In OMi:
a. Navigate to Authentication Management:
Administration > Users > Authentication Management
b. Click the Configure button under the Single Sign-On Configuration list to open the Single
Sign-On Configuration wizard.
c. In the Single Sign-On dialog, select Lightweight.
d. Copy the initString.
e. Click Finish to save your configuration.
For details on configuring LW-SSO, see the OMi Administration Guide.

l

For BSM versions 9.25 and higher and APM version 9.30, perform the following in your BSM or APM
deployment:
a. Navigate to the gateway server and open via browser http://localhost:29000/
b. Insert your credentials which you configured in the Configuration Server Wizard.
c. Search for Topaz:service=LW-SSO Configuration.
d. Paste the initString you copied from OMi in the previous instructions.
e. Click Set to save your changes.
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Step 4: Create the Integration User
Note: This step is not relevant for APM 9.30 or if you use user admin. For APM 9.30, see "(APM
9.30 only) Creating a Standard User with Integration User Role" on the next page.
In this step you will begin by creating your integration user in the BSM JMX console, and then configure
the user by using the BSM user interface.
1. In your BSM deployment (DPS), go to the jmx console: http://localhost:21212/jmx-console
2. Select UCMDB:service=Security Services.
3. Go to createIntegrationUser() and create your integration user using the following values:
customerID: 1
userName: <integration user name>
password: <pwd>
dataStoreOrigin: <any value>
4. Click Invoke.
5. Invoke the getUsersList MBean with customerID=1 to check if the user is shown in the list of
integration users.
6. In your BSM deployment go to Admin > Platform > User and Permissions > User
Management.
7. Select Create New Users with the same user name as the integration user created previously.
8. Click the icon of the user you have just created.
9. Go to the tab Permissions tab.
10. Grant the Administrator role to your integration user.
11. Click Apply Permissions to finish.
Note: You must wait at least ten minutes for the changes to take effect. You can define this in the
following setting:
Navigate to: Admin > Platform > Setup and Maintenance > Infrastructure Settings
Select the context: Applications - Operations Management
Scroll to Operations Management - Topaz Authorization Service Settings
Click the edit button in the line Refresh Interval and enter 10 in the field Value in the Edit Setting
dialog box.

How to Change the Integration User's Password
When you change the integration user's password on the BSM system, the password must be updated
in BSM User Management and in the OMi connected server. To change the integration user's
password, perform the following steps:
1. In your BSM deployment (DPS), go to the jmx console: http://localhost:21212/jmx-console
2. Select UCMDB Service:Security Services.
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3. Go to changeIntegrationUserPassword() and use the following values:
customerID: 1
userName: <integration user name>
password: <new pwd>
4. Click Invoke.
5. In your BSM deployment go to Admin > Platform > User and Permissions > User
Management.
6. Select your integration user in the Groups/Users list.
7. On the General tab, enter the new password in the Password and Confirm Password fields.
Click Apply.
8. In your OMi deployment, navigate to Administration > Setup and Maintenance > Connected
Servers.
9. Edit the APM connected server. On the Server Properties tab, enter the new password in the
Password and Confirm Password fields and save.
10. On the Synchronization tab, re-trigger steps 1-3 to avoid any inconsistencies after the password
change.

(APM 9.30 only) Creating a Standard User with Integration User
Role
Note: Do not perform this step if you upgraded from BSM 9.2x and already created an integration
user. It will be created automatically as part of the upgrade.
For APM 9.30, you need to create a standard user with SDK access permissions.
1. Navigate to APM UI > Administration > Platform > Users and Permissions > User
Management.
2. Create a new user.
3. Click the Permissions tab, and assign an appropriate role to the user.

Step 5: Set Up an APM Connected Server in OMi and
Complete the Integration
Note: This step will auto-detect the target APM version. BSM 9.25 and higher and APM 9.30 are
supported.
In the previous steps, you set up your environment to enable the APM Integration. In the following
section, you will perform the integration. In this step, you enable the following:
l

Configure and initiate topology synchronization.

l

Initiate event, status, and UI integration.

l

Initiate status and downtime synchronization.
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To integrate the configuration items (CIs) that exist in BSM to OMi, perform the following steps:
1. Make sure port 383 is open.
2. On your OMi deployment, navigate to:
Administration > Setup and Maintenance > Connected Servers
3. Click
New and select APM from the drop-down list. The General page of the Create New
Server Connection - APM wizard opens.
4. Enter a Display Name (the Name is entered automatically) and click Next. The Server
Properties page opens.
5. Enter the FQDN of the Application User URL setting:
a. On your BSM deployment, navigate to Admin > Platform > Setup and Maintenance >
Infrastructure Settings.
b. Click the radio button Foundations, then scroll down and select Platform Administration.
c. Scroll down to the Platform Administration - Host Configuration section.
d. Copy the FQDN part of the URL in the Value field of the row with the Name: Default Virtual
Gateway Server for Application Users URL. The FQDN part of the URL is the URL without
https:// and without <port number>.
e. Paste this into Fully Qualified DNS Name in Target Server in the Create New Server
Connection wizard on your OMi deployment.
6. Enter the user name and password of the integration user you created in "Step 4: Create the
Integration User" on page 24.
7. Optional. If the URL Path has changed, you must add the new URL, otherwise leave this field
empty.
If you click Test Connection now, you will receive an error, because no synchronization has
happened at this point.
8. Click Next to go to the Synchronization pane of the Create New Server Connection - APM
wizard.
9. If you plan to synchronize topology from BSM via an external UCMDB, skip this step, as CIs have
already been synchronized during "(external UCMDB only) Step 1: Prepare the topology
synchronization" on page 20.You can proceed directly to "Continue the Setup of BSM in OMi and
Start the Integration" on page 28.
If you integrate BSM CIs directly into the RTSM, click the box on the left of Step 1: Topology in
the Create New Server Connection - APM wizard.
a. If the option Use OMi as Global ID Generator is editable, you must select your desired
global ID generator.
b. If the option Use OMi as Global ID Generator is grayed out, a global ID generator already
exists in your environment. In this case, proceed with selecting your Data Flow Probe.
c. Select the name of your Data Flow Probe from the drop-down list. The Domain Name is
inserted automatically.
d. Click OK to start the topology synchronization and to create the APM integration point.
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Verify the Integration
The previous procedure involves pulling the topology of the CIs from BSM into OMi. This can take
some time, and in very large environments can take several hours.
The following section describes how to verify that the synchronization is complete, in order to continue
with the integration setup.
1. On the OMi server, navigate to:
Administration > Setup and Maintenance > Connected Servers
2. The tooltip in the Connected Servers pane to the right of your connected server tells you the status
of the last executed job. Wait until one integration job ran successfully before continuing. To
update the status, click the Refresh button in the Connected Servers pane.
Additionally, you can check the status of the integration jobs in the RTSM Integration Studio:
3. Navigate to:
Administration > RTSM Administration > Data Flow Management > Integration Studio
On the left-hand side of the Integration Studio, you see a list of all integration points.
4. Select the APM2OMi integration point. You see two integration jobs:
sync_continuous
sync_initial
Wait until at least one of these completes before continuing.
You can start manually either integration job by clicking the full synchronization icon or the delta
synchronization icon.
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Continue the Setup of BSM in OMi and Start the Integration
In this section, you configure event, status, and UI integration.
1. On the OMi server, navigate to:
Administration > Setup and Maintenance > Connected Servers
3. Double-click your APM connected server to open the Edit Server Connection wizard.
4. Go to the Synchronization tab.
5. Click the check box next to Step 2: OMi to APM Setup. This step integrates UI mashup
components and communication certificates and configures OMi server settings in BSM.
6. Click OK to complete the Step 2: OMi to APM Setup portion of the integration.
7. Go back to:
Administration > Setup and Maintenance > Connected Servers
8. Double-click your APM connected server to open the Edit Server Connection wizard.
9. On the synchronization tab, select Step 3: Synchronization. In this step, the following will be
performed:
o

CIs in OMi are updated with KPI status from the corresponding CIs in APM.

o

Downtime definitions are copied from APM to OMi.

10. Optional: OMi serves as the central downtime management location, therefore, you can click the
Synchronize Downtime check box to allow one time initial synchronization of BSM downtime to
OMi, in order to help start managing all downtimes on the OMi side.
11. Click OK to finish the Step 3: Synchronization portion of the integration.

(APM 9.30 only) Step 6: Enabling Alert and Status
Forwarding
For APM 9.30, in order to enable alert and status forwarding, you must manually deploy the OprEvent
template on the OMi side.
1. On your OMi deployment, navigate to:
Administration >Monitoring > Policy Templates.
2. Expand the following:
Templates grouped by type > Events > Event from REST web service
3. Click OprEvent template.
4. Click Assign and Deploy Template.
5. Select all OMi GW systems.
6. Click Next.
7. Click Next.
8. Click Finish.
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(APM 9.30 only) Step 7: Creating OMi Authentication
User Name and Password
As part of the new integration between APM and OMi, embedded OMi under APM no longer exists, and
the integration relies on connecting to OMi via REST.
Creating OMi Authentication User Name and Password
APM 9.30 users need to set an OMi user name and password for sending Events from APM to OMi
1. In OMi, run the following command to set the user name/password for the webservice that APM is
using (same user/password of course as in APM):
<InstallDir>/opr/bin/opr-rest-ws-policy-configuration.{bat,sh} -enable_auth -credentials username <username> [-password <password>]
2. In APM, select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
3. Select Foundations.
4. Select OMi Integrations.
5. In the OMi Integrations - General Settings table:
o

Locate Login and enter the user name you used in step 1 to create your OMi authorization user
name.

o

Locate Password and enter the password you used in step 1 to create your OMi authorization
password.

Use the user name and password that you created above.
6. Save your changes.

(APM 9.30 only) Step 8: Importing Certificates for REST
Service
Note: This step is only required if a secured connection is required. If a secure connection is not
required, complete the instructions in "(APM 9.30 only) Step 9: Using Unsecured http REST
Access" on the next page.
To import the certificates:
1. On the OMi server, retrieve the OMi certificates for the REST service, by entering ovcert -list in a
cmd window.
2. Export the certificate using the following command:
ovcert -exporttrusted -file <location of file> -alias <trusted certificate name>
For example:
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ovcert -exporttrusted -file c:\trust.pem -alias CA_c37b8bd5-5b9b-4626-be18c78ef76040e5_2048
where
c:\trust.pem is the location for the file which will be exported
CA_<UUID>_2048 is the CA certificate of OMi (where <UUID> is the ID retrieved when
using the ovcoreid -ovrg server command).
3. Import the certificate by running the following command from the JRE64/bin folder on the APM
server:
keytool.exe -import -trustcacerts -keystore ..\lib\security\cacerts -storepass changeit -alias
ANYCERTID -file <location of file>
4. Restart the APM server on both the gateway and data processing server.

(APM 9.30 only) Step 9: Using Unsecured http REST
Access
Note: This step is optional only if a secured connection is not required. If a secure connection is
required, complete the instructions in "(APM 9.30 only) Step 8: Importing Certificates for REST
Service" on the previous page.
The default communication method is https. In order to use http, perform the following:
1. Access APM JMX, for example:
http://<localhost>:29000/mbean?objectname=OMi-Integration%3Aservice%3DSettings
2. Enter the URL to connect to OMi using setOmiUrl method, for example:
http://<OMi GW>:30005
3. To view the settings, use the method getOmiUrl.

Step 10: KPI Assignments in OMi
Note: This step is not relevant if you upgraded to APM 9.30 from BSM 9.25 or BSM 9.26, and
already configured this integration.
BSM sends KPI status information for certain CI types to OMi. Per default, this is done for Business
Application CIs, but BSM can also send KPI status changes for other CI Types. Such a KPI status
change is sent to OMi in the form of a special event with a Health Indicator (HI) that contains the KPI
name and the new status. These KPI change events are processed separately from other events and
are not stored in the event database.
When a KPI change event arrives in OMi, the following is triggered:
l

Assuming an “Application Availability KPI change event” arrives, a corresponding Health Indicator
“Application Availability” is created automatically (for the corresponding CI type) and stored in the
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indicator repository.
l

l

If the CI Type does not yet have a KPI assignment for that specific KPI, then a new KPI assignment
is created automatically that uses the HI “Application Availability” to set the KPI “Application
Availability” and no further steps are necessary. The KPI status of the “Application Availability” KPI
will be synchronized automatically.
If the CI Type already has a KPI assignment, then the KPI assignment needs to be adjusted
manually.

Because OMi already has an out-of-the-box KPI assignment for Business Application CIs, you must
perform the following manual steps.
1. In OMi, navigate to Administration > Service Health > CI Status Calculation >
KPI Assignments.
2. Select the CI Types ConfigurationItem > BusinessElement > BusinessApplication.
3. Stop the assignments for BPM and RUM in the Assignments for CI Type:
BusinessApplication pane. These are predefined KPI assignments, which are not suitable for an
OMi system.
4. Click
Add to open the Add KPI Assignment for CI Type: BusinessApplication window.
Specify an appropriate name and description.
5. In the KPI Configurations section, click
window.

New to open the Add KPI To Assignment

6. Leave the default values in the KPI, Business Rule, and Calculated Based on fields, and for
Related Health Indicators, click
Edit to open the Edit Related Health Indicators window.
Move Application Availability to the Selected Health Indicators section. Click Apply and then
Save.
7. Repeat Steps 5 and 6 for Application Performance. Save the KPI Assignment.
8. Click the Synchronize CI Type icon to update all CIs.
For other CI types that already have KPI assignments, perform the following steps:
1. In OMi, navigate to Administration > Service Health > CI Status Calculation >
KPI Assignments.
2. Select the appropriate CI Type.
3. Update the existing KPI assignment and include the new HI, which represents the KPI status
change.
4. Save the KPI Assignment.
5. Click the Synchronize CI Type icon to update all CIs.

Troubleshooting for the APM-OMi Integration
Integrating BSM with a new, second instance of OMi
To integrate BSM with a new instance of OMi, after disconnecting the original OMi system from BSM,
perform the following:
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Note: It is not possible to simultaneously connect two OMi systems to one BSM system. The
original OMi system must first be disconnected before connecting a new OMi instance to BSM.
1. Connect BSM to OMi and execute the topology synchronization following the steps in "Step 5: Set
Up an APM Connected Server in OMi and Complete the Integration" on page 25.
2. After the topology synchronization, go to the OMi Integration Studio and select the Integration
Point with the name "APM2OMi <name of connected server>".
3. On the right side, select one of the two sync_* jobs.
4. On the toolbar, click Clear caches.... After completion, click Full synchronization.
5. The global IDs generated by the new OMi instance are now properly pushed to BSM.

Adjust KPI Assignments
To adjust and troubleshoot KPI assignments in OMi, perform the following:
1. In BSM, create a KPI assignment with the Application Availability KPI type, and any of the
available HIs.
2. Send an event on OMi by using the sendEvent.bat|.sh tool. The event should contain a severity
with the new state of the KPI, a category KpiStatusChange, an ETI Hint containing only the name
of the affected KPI, and a RelatedCiHint with a valid hint for the CI resolver.
Example: In this example, Application Performance has been chosen as the assignment
in step 1.
<OMi_HOME>/opr/support/sendEvent.[bat|sh] -t example -c KpiStatusChange -s
Normal -rch GUCMDB:<GlobalCi_Of_BusinessApplication_CI> -eh "Application
Performance"
3. In OMi, navigate to Administration > Service Health > CI Status Calculation > KPI
Assignments. In the CI Types pane, select ConfigurationItem > BusinessElement
> BusinessApplication.
4. In the Assignments for CI Type: BusinessApplication pane, select the Assignment Name of
the assignment that contains Application Availability, Availability Performance and click
Edit to edit the KPI assignment.
5. In the resulting Edit KPI Assignment for CI Type window, click KPI Configurations to open
the pane.
6. Select the KPI Application Availability and click
window.
7. Click

Edit to open the Edit KPI for Assignment

Edit in Related Health Indicators to open the Edit Related Health Indicators window.

8. Select the HI Application Availability and add it to the list of selected health indicators.
Note: If you do not see any HIs in the Edit Related Health Indicators windows, wait until CI
status changes have been forwarded from BSM to OMi. The forwarding of CI status changes
is triggered by the first change of a CI status of any CI that is present in BSM and has been
synchronized to OMi. These adjustments can only be done once a corresponding CI status
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event has been received in OMi. Otherwise you will not see the Application Performance or
Application Availability HIs.
9. Click Apply, then click Save to save your changes in the Edit KPI For Assignment editor, click
Save to save your changes in the Edit KPI Assignment for CI Type window.
10. Perform steps 6 to 10 for the Application Performance HI and KPI.
11. Click Synchronize CI Type for the assignment to take effect on existing CIs.

BSM Status Forwarding Settings
In BSM, additional settings control CI status forwarding from BSM to OMi. In most cases, you do not
need to change these settings. In BSM, navigate to Admin > Platform > Setup and Maintenance >
Infrastructure Settings. Select Foundations: OMi Integration. Edit the settings as desired.
For example, the HI Statuses Sync - CITs configuration file in the OMi Integration - General
Settings section is an XML file that defines the CITs with HIs that should be forwarded to OMi. If
desired, you can edit this XML file to change the CITs whose HIs will be forwarded from BSM to OMi.

Failed to re-direct topology from BSM9.2x to OMi 10.11
If you integrate SitesScope with BSM 9.26 for OMi features (topology and events) and upgrade BSM
9.26 to OMi 10.11, the integration between OMi and SiteScope does not behave as it used. You will not
see the new topology and events from your existing SiteScope in the new upgraded OMi.
Workaround: Reset the BSM integration in SiteScope and delete the integration in OMi10.11's
Connected server and re-integrate SiteScope from OMi10.11.
To reset the BSM integration in SiteScope:
1. Log in to SiteScope with your user ID and password.
2. Go to Preferences > Integration Preferences.
3. Edit the existing BSM integration.
4. Click the BSM Preferences Available Operations tab and click Reset.
5. Click OK. The BSM integration is deleted.
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BSM user interface components can be directly integrated into OMi Workspaces to view and drill down
to detailed BSM information.

Create an BSM User Interface Element
1. On the OMi server, navigate to:
Workspaces > My Workspace
2. Create a new page:
a. Click the New Page icon on the top left of the toolbar.
b. Click Add Component in the graphics on the left to open the Component Gallery.
c. Select APM from the list on the left of the Component Gallery to display the BSM
components.
d. Double-click the desired BSM.
It is not possible to apply a filter to the user interface components from the BSMs that are displayed in
OMi.
The following BSM use cases are supported:
1. Selecting BSM components from the OMi components gallery and opening them in a frame inside
the OMi components dashboard.
2. Wiring in case of a CI change. For example, a CI 1 is selected and its associated data is
displayed. If now a different CI, CI 2, is selected, the data displayed changes to data associated
with CI 2.
The following components are currently available in OMi:
1. Platform Components
Top View
Hierarchy View
APM Based Impact
2. BPM Components
Application Summary
BPM Performance Matrix
BPM Performance Status
BPM Error Summary Distribution by Category/Type
Application Health Business Summary
BPM Error Summary Distribution by Location/BPM Custom Attributes
BPM Error Summary Distribution by Transaction
Metrics Over Time
3. RUM Components
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Application Health Performance
Application Health Availability
RUM Event Count By classification
4. SiteScope components
Cross Performance Reports
SiteScope Multi View
5. Service Level Management components
SLA Summary
Current Status Snapshot
Historic Status Snapshot
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Integration
There are several OMi Integration Infrastructure setting that will enable you to customize your BSMOMi Integration.
To customize the BSM-OMi integration:
1. In the BSM application, select Admin > Platform > Setup and Maintenance > Infrastructure
Settings.
2. Select Foundations > OMi Integration.
3. Configure the OMi Integration settings as follows:
o

HI Statuses Sync - CITs configuration file. Define which CI types to include in the HI status
synchronization. The following CI types are included by default: node, running_software,
business_application. You can add additional CI types or remove existing ones. The CI type
name is the internal name (not the display name, for example, the display name is business_
application, not Business Application). You can view the CI type name under RTSM > CIT
manager.

o

KPIs list per CI type (Business Application). Define which KPI to use for synchronizing the
KPI status change. The following CI type is included by default: Application Availability and
Application Performance for CI type business_application. You can add additional KPIs
and CI types or remove existing ones. Keep in mind that the TQL integration for topology
synchronization jobs need to be modified to cover the same CI type. If the CIs and the GID are
missing from OM, no status change will be reflected.

o

Events chunk size. Size of chunk of events sent during initial KPI/HI synchronization. You
can enter a number between 1 and 500.

o

Interval between session. Interval between events chunks sending sessions (seconds). You
can enter a number between 1 and 10.

o

Event forwarding CI Alert name if status improved. Enter the event description that is
generated when status changes and becomes better.

o

Event forwarding CI Alert name if status worsened. Enter the event description that is
generated when status changes and becomes worse.

In addition, you can use the tql - CIs_For_CIStatusChange_in_OMi to define which CI types to use to
synchronize KPI status changes.
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Chapter 6: How to Create and Forward End User
Management Alerts to OMi
It is best practice to forward End User Management (EUM) related information to OMi. With EUM
alerts, you can:
l

Configure granular trigger conditions based event based triggers or time based triggers. For
example, you can send an alert when a transaction fail or exceeds a specified amount of time.

l

Filter the alert by transaction, location, or mobile device

l

Configure the notification frequency

By creating EUM alerts, you can pass critical Business Process Management (BPM) transactions and
CIs that are not part of the integration to OMi. When you create EUM alerts you should tailor them
according to your specific requirements. In the Actions tab, be sure to select the generating event
alert action. Events that are created in this manner, are automatically forwarded to OMi as part of the
integration predefined forwarding rules.
For information about creating and managing EUM alerts, see the BSM Application Administration
Guide.
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Part III: Operations Manager i HPE SiteScope Integration
This part of the guide contains the following chapters:
l

"SiteScope Integration - Overview" on page 39
This chapter provides the SiteScope integration overview.

l

"SiteScope Integration - Tasks" on page 40
This chapter describes various tasks that you must perform to configure and use the SiteScope
integration.

l

"How to Create a Connection to a SiteScope Server" on page 49
This chapter describes how to create a connection to a SiteScope server and explains how
configured SiteScope connected servers are chosen for deployment.
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Chapter 7: SiteScope Integration - Overview
SiteScope is an agentless monitoring solution that enables you to remotely monitor the availability and
performance of your IT infrastructure (for example, servers, operating systems, network devices,
network services, applications, and application components). OMi provides a script that enables you to
import templates from a SiteScope server so that you can include them in aspects.
SiteScope templates contain information about the remote servers they monitor. When you import
SiteScope templates, OMi exports the templates from the SiteScope and transforms them into the OMi
policy templates. For more information on importing templates and important considerations that need
to be taken into account, see the OMi Administration Guide.
Before deploying the policy template, OMi replaces the value %%HOST%% with the list of remote servers
to which the policy template is assigned. Based on the connected server configuration, OMi then
selects the SiteScope server that qualifies for monitoring the remote servers and deploys the policy
template to that server. The SiteScope server finally creates the corresponding monitors and starts
monitoring the remote servers.
To be able to assign and deploy a SiteScope policy template, the SiteScope server must be set up as a
connected server in OMi and a node CI must exist for the system in Monitored Nodes. In addition, the
remote systems that SiteScope monitors must be represented as node CIs in the RTSM.
Note: Inactive SiteScope connected servers cannot be used for deployment. For example, if you
deactivate a SiteScope connected server that has SiteScope policy templates assigned to it, this
server will not be used for deployment until you activate it by using the Connected Servers
manager or the ConnectedServers command-line interface. See the OMi Administration Guide for
more information.
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This section describes the tasks that you must perform to configure and use the SiteScope integration:
l

"How to Migrate the SiteScope Integration from BSM 9.2x" below

l

"How to Set Up the SiteScope Integration" on the next page

l

"How to Connect to a SiteScope Server That Requires TLS" on page 44

l

"How to Import Templates from a SiteScope Server" on page 45

l

"How to Assign SiteScope Policy Templates to Remote Servers" on page 45

l

"How to Combine Policy Templates into an Aspect or Management Template" on page 46

l

"How to Configure Drill Down to SiteScope" on page 47

l

"How to Drill Down to SiteScope" on page 47

How to Migrate the SiteScope Integration from BSM 9.2x
The SiteScope systems integrated with BSM 9.2x are imported into OMi automatically during the
upgrade.
However, if you customized the Health Indicator and CI Type Mapping content delivered by BSM 9.2x
(this content consists of the ciSubTypes.xml, meas2eti.xml, and userDefinedCiType.xml files and
is downloaded and used by SiteScope systems when they connect to BSM), the updated files are not
imported automatically during the upgrade. Therefore, you must retrieve them from the SiteScope
system integrated with BSM 9.2x and import them to OMi manually.
You can skip the import step if no customizations were made. In this case, the default Health Indicator
and CI Type Mapping content located in the <OMi_HOME>/conf/sis/content directory will be used.
To import the Health Indicator and CI Type Mapping content modified in the BSM version you are
upgrading from, proceed as follows:
1. On the SiteScope system, copy the following files to a temporary directory on the OMi system:
<SiteScope_install_dir>/conf/integration/bsm/ciSubTypes.xml
<SiteScope_install_dir>/conf/integration/bsm/meas2eti.xml
<SiteScope_install_dir>/conf/integration/bsm/userDefinedCiType.xml
2. Change to the temporary directory on the OMi system and run the following command:
<OMi_HOME>/bin/opr-sis-file-manager.[bat|sh] -import ciSubTypes.xml
meas2eti.xml userDefinedCiType.xml
As a result, the specified files are uploaded to the OMi database.
To edit the uploaded content, use the opr-sis-file-manager.[bat|sh] command-line interface
located in the <OMi_HOME>/bin directory. To retrieve the uploaded content, use the -export option. To
commit the changes, use the -import option. For more information on the opr-sis-file-manager
command-line interface, see the OMi Administration Guide.

HPE Operations Manager i (10.12)

Page 40 of 207

OMi Integrations Guide
Chapter 8: SiteScope Integration - Tasks

Post-Migration Steps
The updated SiteScope server works with certificates that use 2048-bit keys. Because the previous
Certificate Authority worked with certificates that use 1024-bit keys, the SiteScope serverKeystore
stores certificates with an outdated key size. Follow these steps to regenerate the certificates with
2048-bit keys:
1. On the SiteScope server, remove the serverKeystore file located in <SiteScope root
directory>\groups
2. Regenerate the certificate: keytool -genkey -dname "CN=www.example.com,
OU=department, O=company, L=location, ST=state, C=countryCode" -alias myAlias keypass keypass -keystore ..\..\groups\serverKeystore -storepass keypass keyalg "RSA" –validity valdays
3. Export the certificate from the generated server key store: keytool -exportcert -alias
myAlias -file <SiteScope root directory>\certificate_name.cer -keystore
..\..\groups\serverKeystore
4. On the OMi gateway server, import the certificate into the OMi Java trust store: keytool -import
-trustcacerts -alias myAlias -file cert.cer –keystore
..\..\groups\serverKeystore
5. Restart the SiteScope service and restart OMi.
The SiteScope systems are migrated as inactive connected servers that do not get registered by OMi
until they get activated. To activate (enable) a migrated SiteScope connected server:
1. Open the Connected Servers manager from Administration:
Administration > Setup and Maintenance > Connected Servers
2. Select the SiteScope connected server you want to enable and click

Activate.

Note: Inactive SiteScope connected servers appear dimmed in the list of connected servers.

How to Set Up the SiteScope Integration
Before you can start monitoring a configuration item (CI) with SiteScope, you must configure the
SiteScope integration with OMi by carrying out the following steps:
1. Install the Operations Agent on the SiteScope system.
Install Operations Agent from the SiteScope installer package, or download it from the
HPE Software Support (in the Search box, type "Operations Agent", select the relevant version,
under Document Type, select Patches, and locate the installation file).
On Windows:
a. Log in to the node with administrator privileges.
b. Go to the directory where you extracted the contents of the ISO file.
c. Run the following command to install the agent:
cscript oainstall.vbs -i -a
On Linux:
a. Log on to the node with root privileges.
b. Go to the directory where you extracted the contents of the ISO file.
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c. Run the following command to start the installation:
./oainstall.sh -i -a
For more detailed installation instructions, see the Operations Agent Installation Guide, available
from the HPE Software Support site.
Note:
o

Use the -includeupdates installation to install Operations Agent with prepackaged
hotfixes. For details, see the Operations Agent Installation Guide.

2. Configure the Operations Agent.
This task registers the sisconfig subagent process (used for Monitoring Automation to deploy
monitoring to SiteScope), and installs the policy signing tool (used by SiteScope to install policies
locally).
a. Run the SiteScope Configuration Tool on the SiteScope server:
n

On Windows: Select Start > All Programs > HP SiteScope > Configuration Tool.

n

On Linux (graphic mode): Run <SiteScope install Directory>/bin/config_tool.sh

n

On Linux (console mode): Run <SiteScope install Directory>/bin/config_tool.sh
-i console.

For more details on using the SiteScope Configuration Tool, see the HPE SiteScope
Deployment Guide.
b. In the Configure HP Operations Agent installed separately option (HP Operations Agent
option in console mode), select Configure HP Operations Agent to complete the installation
of the Operations Agent.
c. Restart SiteScope.
d. If the agent is installed on a Red Hat ES Linux 6.0 environment, after installing the Operations
Agent, check the installation status in the log files.
i. In the SiteScope log, check if the installation completed successfully by searching for
the results of installOATask.
Log file name: HPSiteScope_config_tool.log
Log file location on Windows platforms: win- %temp%
Log file location on UNIX/Linux platforms: /temp or /var/temp
ii. In the Operations Agent log files:
Log file name: oainstall.log, oapatch.log
Log file location on Windows platform: %ovdatadir%\log
Log file location on UNIX/Linux platforms: /var/opt/OV/log
3. Configure event integration with OMi.
a. Log in to SiteScope, and navigate to Preferences > Integrations Preferences.
b. Click New Integration, and in the resulting window select HP Operations Manager
Integration.
c. Enter the FQDN on the OMi server.
d. Check the following boxes:
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i. Enable sending events
ii. Connect directly to BSM
iii. Prefer events over metric in BSM Service Health (global preference)
e. Uncheck the Enable exporting templates to HP Operations Manager box.
f. Click Connect to activate the agent.
Note: If you have not configured certificate auto-granting, you must manually grant the
certificate request in OMi:
n

Navigate to Administration > Setup and Maintenance > Certificate Requests

n

Select the certificate request.

n

Click the Grant icon.

g. Click Install Polices, then click Analyze to verify the configuration.
h. In the Test Integration section, enter a test message, and click Send Test Message. Then
click Send Test Event. Click OK to close the window, then click OK in the following Disable
Policy Result window. Verify that both events are in the OMi Event Browser.
4. Configure the integration with Monitoring Automation and the RTSM.
a. In OMi, create a connected server for the SiteScope server. For information on creating a
connected server, see "How to Create a Connection to a SiteScope Server" on page 49.
b. Verify that the integration has been configured automatically in SiteScope:
n

In SiteScope, navigate to Preferences > Integration Preferences.

n

You will see a new BSM integration configured as a result of creating the connected server
in OMi.

c. Configure all pre-existing monitors to set Service Health based on events.
Now that you have integrated SiteScope with OMi, any pre-existing monitors have been
updated with an HPE Integrations Settings section. In this section, the BSM Service Health
Preferences show Service Health is affected by Metrics. This setting must be changed to
Events, so that events carry indicators to set Service health. To change the BSM Service
Health Preferences from Metrics to Events:
i. In the monitor tree, right-click the SiteScope container and select Global Search and
Replace.
ii. In the wizard, select all monitors. In the Choose Changes tab, check the BSM Service
health affected by box and set the associated drop down list to Events.
d. Verify that the topology has been created in the RTSM.
i. In OMi, navigate to Administration > RTSM Administration > IT Universe
Manager.
ii. Search for all node CIs. You should now see one or more new CIs created by
SiteScope.
iii. Troubleshooting: If topology is not appearing in the RTSM, you can check for errors in
the SiteScope logs.
If you see an error in <SiteScope>\logs\bac_integration\discovery.log, clear the
topology cache on SiteScope:
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l

Set the SiteScope service.

l

Delete the 4 files in <SiteScope>\discovery\hsqldb directory

l

Start the SiteScope service.

l

Re-synchronize the topology. Log in to SiteScope and navigate to Preferences >
Integration Preferences. Edit BSM Integration, and in the resulting window click
Re-Synchronize under BSM Preferences Available Operations.

5. Configure templates in SiteScope and import them. For details, see the OMi Administration Guide.

How to Connect to a SiteScope Server That Requires TLS
To connect to a SiteScope server that requires TLS, OMi must trust the root certificate that was used to
sign the SiteScope certificate. This is done by adding the root certificate to the CA keystore of the OMi
server and to the CA keystore of the SiteScope server.
Complete one of the following procedures depending on the type of certificate that was used to sign the
SiteScope certificate:
Note: If the OMi server runs a Linux operating system, replace the paths in the following
procedures with their Linux equivalents.
l

Certificate from a certificate authority. If the SiteScope certificate was signed with a certificate
from a certificate authority, import the certificate to the SiteScope CA keystore and to the CA
keystore of the OMi server:
a. Obtain the root certificate (and any other intermediate certificate) from the certificate authority.
b. On the SiteScope server to which you want to deploy policies, import the root certificate (and
any other intermediate certificate) to the SiteScope CA keystore. Type:
C:\SiteScope\java\bin\keytool -importcert -alias <yourCA> -file
<CAcertificateFile> -keystore C:\SiteScope\java\lib\security\cacerts
When prompted for the password, type the keystore password. (The default password is
changeit.)
c. On the OMi server to which you want to export SiteScope templates, import the root certificate
(and any other intermediate certificate) to the OMi CA keystore. Type:
<OMi_HOME>\JRE\bin\keytool -importcert -alias <yourCA> -file
<CAcertificateFile> -keystore <OMi_HOME>\JRE\lib\security\cacerts
When prompted for the password, type the keystore password. (The default password is
changeit.)
d. Restart SiteScope, so that the newly imported certificate will be recognized and used by the
integration.

l

SiteScope self-signed certificate. If the SiteScope certificate is a self-signed certificate (for
example, a certificate that was created and configured with the SiteScope tool ssl_util), export the
self-signed certificate from SiteScope and import it to the CA keystores of the OMi server and
SiteScope:
a. On the SiteScope server, export the self-signed certificate, type:
C:\SiteScope\java\bin\keytool -exportcert -keystore
C:\SiteScope\groups\serverKeystore -alias sitescope -file <certificateFile>
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When prompted for the keystore password, type the password that was specified when using
the ssl_util tool.
b. On the SiteScope server, import the self-signed certificate to the SiteScope CA keystore. Type:
C:\SiteScope\java\bin\keytool -importcert -file <certificateFile> -keystore
C:\SiteScope\java\lib\security\cacerts
When prompted for the password, type the keystore password. (The default password is
changeit.)
c. Copy the certificate to the OMi server to which you want to export SiteScope templates.
d. On the OMi server, import the self-signed certificate to the OMi CA keystore. Type:
<OMi_HOME>\JRE\bin\keytool -importcert -file <certificateFile> -keystore <OMi_
HOME>\JRE\lib\security\cacerts
When prompted for the password, type the keystore password (the default password is
changeit).
e. Restart SiteScope, so that the newly imported certificate will be recognized and used by the
integration.
f. Required if both OMi and SiteScope use HTTPS setup. Import the SiteScope serverKeystore to
the OMi CA keystore:
i. Copy the SiteScope serverKeystore, located in C:\SiteScope\groups\serverKeystore,
to the following location in OMi: <OMi_HOME>\JRE\lib\security
ii. Import the serverKeystore to OMi cacerts:
<OMi_HOME>\JRE\bin\keytool -importkeystore -destkeystore cacerts deststorepass <keypass> -srckeystore /tmp/serverKeystore -srcstorepass
<keypass>
For <keypass>, define the keystore password that you set in SiteScope.
iii. Restart SiteScope and the OMi gateway server.

How to Import Templates from a SiteScope Server
1. Make sure the SiteScope templates that you want to import meet the requirements. See the OMi
Administration Guide for more information.
2. On the OMi server, open a command prompt and run the ConfigExchangeSIS command-line
interface to import templates from a SiteScope server.
For example, the following command loads the templates that are in the template container called
"Template Examples" from sitescope1.example.com:
<OMi_HOME>\opr\bin\ConfigExchangeSIS.bat -username <OMi login name> -password
<OMi password> -sis_group_container <sitescope template folder> -sis_hostname
<sishost> -sis_port <sisport> -sis_user <login> -sis_password <password>
For more information on the ConfigExchangeSIS command-line interface, see the OMi
Administration Guide.

How to Assign SiteScope Policy Templates to Remote Servers
1. Prerequisites: Make sure the tasks described in "How to Set Up the SiteScope Integration" on
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page 41 and "How to Import Templates from a SiteScope Server" on the previous page are
completed.
2. Assign the SiteScope policy template to the remote servers (that is to the node CIs) that you want
to monitor. Do not assign the template to the SiteScope server itself. For information about
assigning a policy template, aspect, or management template to a CI, see the OMi Administration
Guide.
3. Every SiteScope policy template typically includes a hostname parameter that resolves to the
remote server to be monitored. If this value is not already set, edit the value of this parameter
during the assignment and enter the symbolic value %%HOST%%.
Alternatively, set the CI attribute PrimaryDNSName as the default value of this parameter on the
aspect or management template level.
Before deploying the policy template, OMi replaces the value %%HOST%% with the list of remote
servers to which the policy template is assigned.
Tip: Set %%HOST% or the CI attribute PrimaryDNSName already in the template in SiteScope
before importing it to OMi. If the host instance parameter is already set at policy template
level, you do not need to provide a value when assigning the policy template (aspect or
management template) to a CI.

How to Combine Policy Templates into an Aspect or Management Template
To combine the SiteScope policy template and the agent-based policy template into one aspect or
management template, proceed as follows:
1. Prerequisites: Make sure the tasks described in "How to Set Up the SiteScope Integration" on
page 41 and "How to Import Templates from a SiteScope Server" on the previous page are
completed.
2. Using the Management Templates and Aspects manager, combine the SiteScope policy template
and the agent-based policy template into one aspect or management template and assign it to the
CI you want to monitor. Do not assign the template to the SiteScope server itself.
When combining two templates, consider how to group the parameters from the SiteScope policy
template and the agent-based policy template, for example:
The policy DBmonAgentBased (type Measurement Threshold) has an instance parameter named
database_instance with the dependent parameters user, password and port=1521. The policy
DBmonAgentLess (type SiteScope) has an instance parameter INSTANCE with the dependent
parameters HOST=%%HOST%%, USER, PASSWORD, PORT=1521. Both policies must be combined into
one aspect called DBmon with only one instance parameter on an aspect level.
To combine the parameters:
a. Group the database_instance and INSTANCE parameters together and name the group, for
example, DBinstance.
b. Group the remaining parameters: user and USER into DBUser, password and PASSWORD into
DBpassword, port and PORT into DBport.
c. Make a group named DBhost consisting of HOST=%%HOST%% and make it hidden, the reason for
this being that displaying the combined hostname parameter can lead to cosmetic issues and
therefore should not be visible to the user. Moreover, this parameter is redundant, since the
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Measurement Threshold policy template does not require it and the hostname is already
defined through the assignment target.

How to Configure Drill Down to SiteScope
With drill down to SiteScope configured, OMi users can right-click a configuration item (CI) or health
indicator (HI) in OMi, and then select Go to SiteScope to open the related monitor in SiteScope. The
SiteScope UI opens in a popup browser window and displays the monitor that sends health information
for the selected CI or HI.
Complete the following steps for each SiteScope server for which you want to enable drill down:
1. Make sure the SiteScope server is integrated with OMi. For details, see "How to Set Up the
SiteScope Integration" on page 41.
2. Make sure OMi is configured to add the user role information to the LW-SSO token:
a. Navigate to Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
b. Select Foundations, and use the list to set the administration context to Single Sign-on.
c. Make sure the value of Add user roles information to LW-SSO token is true.
3. Make sure the passphrase string for LW-SSO in SiteScope matches the string in OMi:
a. In OMi, navigate to Authentication Management:
Administration > Users > Authentication Management
b. Copy the value of Token Creation Key (initString) to the clipboard.
c. In the SiteScope UI, open Preferences > General Preferences > LW SSO Settings.
Replace the value of LW SSO Init String with the value copied from the OMi server.
Alternatively, on the SiteScope server, edit the LW-SSO configuration file:
<SiteScope root directory>/conf/lwsso/lwssofmconf.xml
Replace the value of the attribute initString with the value copied from the OMi server and
save the file.
d. Restart SiteScope.
4. In OMi, assign the user role SiteScope Drilldown Role to all users that should be allowed to drill
down to SiteScope. The role is contained in the OMi Content Pack and grants the users view
permission in SiteScope.
Optional. To grant OMi users additional permissions in SiteScope, create a user role with the
name SiteScope Drilldown Role in SiteScope and define the additional permissions as required.

How to Drill Down to SiteScope
When SiteScope monitors are used to set the status of a configuration item (CI), you can drill down
from the CI (or from a health indicator (HI) on the CI) to a SiteScope monitor that contributes to the HI's
status.
1. Access menu commands from a CI or HI in a My Workspace page or component, for example
360° View, Top View, View Explorer, Health Indicator, or the SiteScope Multi-View component.
Select Go to >SiteScope. The SiteScope UI opens directly to the parent group of the relevant
monitor.
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If monitors from multiple groups contribute to the CI's or HI's status, the Drilldown to SiteScope
dialog box opens. Select the monitor to which you want to drill down and open it in SiteScope.
The Drilldown to SiteScope dialog box displays the following hierarchy:
o

The root level shows health indicators.
If you open the dialog box for a CI, one or more HIs that contribute to the CIs status are listed.
If you open the dialog box for an HI, this HI appears as the root.

o

The level below the root shows the SiteScope systems (connected server name) that have
monitors contributing to the HI.

o

The lowest level shows the SiteScope monitors that contribute to the HI.
Note: In the System Monitors view, if you select Go to > SiteScope from a monitored CI,
SiteScope opens the monitor's parent group. If you select this from a group CI, SiteScope
opens directly to the group.

2. Select a SiteScope monitor, and click Drilldown.
For details on working with SiteScope, see SiteScope Help.
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SiteScope Server
This task describes how to create a server connection to a SiteScope server. It also lists the criteria
used to determine the SiteScope server that is most suitable for deploying SiteScope monitors.
l

"How to Create a Connection to a SiteScope Server" below

l

"How To Determine the Target SiteScope Server for Deployment" on the next page

How to Create a Connection to a SiteScope Server
1. Open the Connected Servers manager from Administration.
2. In the Connected Servers pane, click
Connection dialog box opens.

New and select SiteScope. The Create New Server

3. In the General page, provide the following information and make the following selections:
a. Enter a display name, a unique internal name (if you want to replace the automatically
generated name), and optionally, a description of the connection being specified.
b. Select Active to enable the server connection immediately.
c. Select Default to set the SiteScope server as a default server.
If you are creating the first SiteScope server, this option is selected by default and disabled. If
a SiteScope server already exists and this option is used when creating a new SiteScope
server, the default server is changed to the newly created SiteScope server.
Click Next to open the Server Properties page.
4. In the Server Properties page, provide the following information:
a. Under SiteScope WebService, enter the fully qualified DNS name of the host system of the
SiteScope server, as well as the user name, password, and port number. Click Set default
port to set a default port number (8443 for secure communication or 8080 if secure
communication is not used).
If you are using secure communication (default), make sure the Use Secure HTTP option is
selected.
Note: To integrate SiteScope with OMi, you must use the credentials of a SiteScope
administrator user.
b. Under SiteScope Installation, enter the operating system of the host system of the
SiteScope server and the version number of the SiteScope server. Note that the SiteScope
version number must not contain letters.
c. Click Test Connection to check that the specified connection attributes are correct. If an
error link is displayed, check the error message, correct the connection information, and retest the connection.
Note: For the connection test to be successful, you must have an event integration with
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SiteScope. There must be a trusted relationship between OMi servers and the SiteScope
server. After SiteScope is integrated with OMi, the Test Connection check will return a
successful result.
Click Next to go to the SiteScope Settings page.
5. In the SiteScope Settings page, provide the following information:
a. Under OMi Credentials, specify the user name and password for the OMi superadmin user.
b. Under Proxy Server (required if SiteScope uses a proxy to communicate to OMi), enter the
fully qualified DNS name of the proxy system, as well as the proxy user name, the password
associated with the proxy user and the proxy port number.
c. Under Topology Settings, enter the default routing domain from which the SiteScope
topology data is collected (the default value is DefaultDomain).
The routing domain is a continuous region of an IP network within which routing is possible
without any intervening Network Address Translation (NAT) devices. The RTSM uses the
routing domain to determine the reconciliation rules and workflows that are applied to a
network range.
Additionally, specify the number of days for SiteScope to synchronize topology data with OMi
(the default value is 7).
Click Finish to save the newly created server connection. You can also verify that an integration
has been configured automatically in SiteScope, but logging in to SiteScope and navigating to
Preferences > Integration Preferences. You will see a new BSM integration configured as a
result of creating the connected server in OMi.
Note: The Health Check page is only available when health checking is globally enabled in the
infrastructure settings and when you edit a SiteScope connected server. When you create a new
connected server, as described in this task, the default settings from the infrastructure settings are
applied.

How To Determine the Target SiteScope Server for Deployment
The following criteria determine the SiteScope server that is most suitable for deploying SiteScope
monitors:
l

l

One SiteScope server. If you have one configured SiteScope Connected Server, this server is
always used as the target for deploying monitors.
Multiple SiteScope servers. For environments with multiple SiteScope servers, OMi, by default,
selects the SiteScope server with the most free license points as the target for deployment.
If there is more than one SiteScope server with a sufficient number of free license points, OMi
chooses one server at random. To prevent OMi from randomly selecting the SiteScope server to be
used for deployment, configure a Groovy server selection script:
a. Open Infrastructure Settings from Administration.
b. Select Applications and use the list to set the administration context to Monitoring
Automation.
c. Go to the Monitoring Automation - Proxy Deployment Scripts section.
d. Open the HP SiteScope server selection script edit window (click the associated

HPE Operations Manager i (10.12)

button to

Page 50 of 207

OMi Integrations Guide
Chapter 9: How to Create a Connection to a SiteScope Server

open the Edit Setting dialog box).
The Edit Setting dialog box displays the script name and script content. Deployment script
templates are located at:
<OMi_HOME>/opr/examples/deployment-server-selection
e. Select the script that meets your needs, paste it into the script field replacing the <XML/> tag,
and configure it appropriately. You can choose a script to select the SiteScope manager by
using domain names, IP address ranges, or the one with the most available license points.

Domain Name Example
def domainNameMap = ["":"sis.example.com",
".*.example.com":"test.example.com"]
Comma-separated list with the following regular expression format: "domain name
pattern":"test.example.com"
If the node domain name of the potential SiteScope server fits the "domain name pattern", the
value is taken to find the SiteScope connected server by using the Display Name, Name or
DNS Name values.
".*" can be used as a wildcard, for example, for ".*hpe\\.com" to match "hpe.com" or
"internal.hpe.com".
Tip: Specify an empty domain name for a default server in case no other domain names
match.

IP Address Example
def ipMap = ["":"sis.example.com", "192\\.168\\.2\\..*":"test.example.com"]
The expression is specified as a string and the "\" must also be escaped. Hence, "\\." is
required to escape the dot.
Comma-separated list with the following format: "IP pattern":"sis server name"
If the IP address of the potential SiteScope server fits the "IP pattern", the value is taken to
find the SiteScope connected server by using the IP address of the system.
".*" can be used as a wildcard, for example, for "192\\.168\\.2.*" to match "192.168.2.10"
or "192.168.204.88".
Tip: Specify an empty IP address for a default server in case no other IP addresses match.
f. Click Save.
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HPE Operations Manager (OM) can be integrated into your OMi environment to become a data source
for OMi. OM for Windows, OM for UNIX (UX and Solaris), and OM for Linux are supported.
After you install both OMi and OM, follow the described procedures to connect OMi and OM. This
connection enables bidirectional synchronization of events between the two systems, tool execution,
and instruction text retrieval. The connection configuration requires you to establish a trust relationship
between the OMi and OM systems, as well as to configure a message forwarding policy.
The integration between OMi and OM provides you with the following capabilities:
l
l

l

OM events > OMi. Events from OM are displayed in the OMi Event Browser.
OM events > OMi health indicators. After you set up the integration, if the OM events have
corresponding health indicators defined, these health indicators automatically affect the status of the
relevant Configuration Items (CIs) in OMi applications such as Service Health. For an introduction to
health indicators, see the OMi User Guide.
OMi Actions, Tools, and Instructions. You can specify tools, for example, to ping a system.
These tools are launched from events or the Actions panel and run on the associated CI. The tools
are designed to help users solve common problems quickly and efficiently. All available tools are
launched in the context of a CI. The selection of tools a particular user sees in context menus
depends on the tools that are available for the CI affected by a particular event.
Events received in the OMi Event Browser may contain event-related actions configured in OM. If
event-related actions exist, you can run these actions from the OMi console. OM actions can be
either operator-initiated, or can run automatically when an event occurs. For a complete overview of
available actions and how to run them, see OMi Help.
Operators working with the OM message browser can see additional instructions for the selected
message. It is equally helpful for OMi operators to be able to access this information when using OM
servers to forward events to OMi. This information is displayed in the Instructions tab of the Event
Browser. For details, see the OMi User Guide.

l

OM topology > RTSM topology. The OM topology can synchronize with the OMi RTSM topology.
Using topology synchronization, the OM services are synchronized with OMi, and by using
corresponding mapping rules, they are transformed into CIs stored in the RTSM. For details, see the
OMi Administration Guide.
Note: If the OM topology is not synchronized with the RTSM topology using the OMi topology
synchronization mechanism, the Monitored by property of the OMi CIs corresponding to the
OM services may be empty. As a consequence, these CIs are not displayed in the System
Monitors only Perspective, System Hardware Monitoring, and System Software Monitoring
views.
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1.

Establish a trust relationship between OMi and OM
For connection and communication between OMi and OM hosts, establish a trust relationship
between all the servers.
For task details, see "How to Establish a Trust Relationship for a Server Connection" on page 55.
To verify the trusted relationship, see "How to Verify the Trusted Relationship" on page 58.

2.

Set up the OM server as a connected server
Set up the OM server as a connected server so that you can run actions and tools from OMi, and
retrieve instructions from the OM server.
For task details, see "How to Create a Connection to an OM Server" on page 59.

3.

Synchronize the topology
To populate the OMi database (RTSM) with the configuration item (topology) and service data
from OM, you must synchronize the topology. Topology synchronization is configured to update all
specified servers with the topology and service data from the OM server.
For task details, see "How to Run Topology Synchronization" on page 62.

4.

Configure the OM forwarding policy
To enable event synchronization between OM and OMi, set up a message forwarding policy on the
OM server. The policy includes the node name of the target OMi server. Alternatively, specify the
load balancers, if configured, or one Gateway Server for each OMi installation, as appropriate for
your high-availability arrangement.

5.

o

OM for Windows. For task details, see "How to Configure the OM for Windows Forwarding
Policy" on page 67.

o

OM for UNIX or Linux. For task details, see "How to Configure the OM for UNIX or Linux
Forwarding Policy" on page 70.

Validate event synchronization
Validate event synchronization and test the connection between OM and OMi.
For task details, see "How to Validate Event Synchronization" on page 73.
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For connection and communication between OMi and OM hosts or other OMi hosts, you must
establish a trust relationship between the systems.
In OM server pooling, the virtual server must have a certificate that is trusted by all OM hosts in the
server pool and by all OMi hosts.
Note: The trust relationship must be set up on all nodes (data processing servers, gateway
servers, manager-of-manager configurations, load balancers, and reverse proxies). However,
some load balancer technologies include a by-pass or pass-through functionality for incoming
encrypted messages to its pool members. When using such technologies, the trust relationship on
the load balancer node is not required if you are load balancing on the recommended OSI layer 2 or
4.
To establish a trust relationship between the data processing servers and external server
systems:
1. On the OMi data processing server, execute the following command:
BBCTrustServer[.bat|sh] <external_server>
Replace <external_server> with the FQDN of the external system (for example, ommgmtsv).
Note: The value of <external_server> should be the virtual name if the OM server is part of
a server pool or runs in a high-availability (HA) cluster.
When asked if to add a certificate to the trust store, enter y.
If the trusted certificate already exists, the tool asks you if you want to overwrite the existing
certificate. To replace the existing certificate with a new one, enter y.
2. OM servers only:
Note:
OM for Windows: Starting with patches OMW_00121 (32-bit) and OMW_00122 (64-bit), the
BBCTrustServer tool is already installed in the %OvInstallDir%\contrib\OVOW folder.
OM for UNIX or Linux: Starting with OM server version 9.10.220, the BBCTrustServer tool
is already installed in the /opt/OV/bin directory.
If you have the appropriate OM patch or version, you can skip this step.
a. Locate the following files on the OMi data processing server:
<OMi_HOME>/opr/lib/cli/opr-cli.jar
<OMi_HOME>/opr/bin/BBCTrustServer.bat
<OMi_HOME>/opr/bin/BBCTrustServer.sh
b. OM for Windows only: Copy the files to the machine that is running the OM for Windows
management server.
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Copy opr-cli.jar to %OvInstallDir%\java\opr-cli.jar.
Copy BBCTrustServer.bat to %OvBinDir%\BBCTrustServer.bat.
c. OM for UNIX and Linux only: Copy the files to the machine that is running the OM for UNIX or
Linux management server.
Copy opr-cli.jar to /opt/OV/java/opr-cli.jar.
Copy BBCTrustServer.sh to /opt/OV/bin/BBCTrustServer.sh.
Change the permissions of the BBCTrustServer tool by entering the following command:
chmod 555 /opt/OV/bin/BBCTrustServer.sh
3. If you do not have a load balancer or a reverse proxy, or your load balancer is configured to work on
OSI layers 2 or 4 (recommended by HPE), execute the following command on the external
system:
BBCTrustServer.[bat|sh] <load_balancer_or_single_gateway_server_or_RP_or_Server_
Pool_Virtual_Interface>
When asked if to add a certificate to the trust store, enter y.
If the trusted certificate already exists, the tool asks you if you want to overwrite the existing
certificate. To replace the existing certificate with a new one, enter y.
4. If you are using a reverse proxy or your load balancer is configured to work on OSI layer 7, you
must exchange the certificates manually:
a. On the OMi data processing server, execute the following command:
ovcert -exporttrusted -file <omi.cer>
b. On the external system, execute the following command:
ovcert -exporttrusted -file <other.cer>
c. Copy <other.cer> from the external system to the OMi data processing server.
d. Copy <omi.cer> from the OMi data processing server to the external system.
e. On the OMi data processing server, execute the following commands:
ovcert -importtrusted -file <other.cer>
ovcert -importtrusted -file <other.cer> -ovrg server
f. On the external system, execute the following commands:
ovcert -importtrusted -file <omi.cer>
ovcert -importtrusted -file <omi.cer> -ovrg server
5. If you are using a load balancer or a reverse proxy, where your data sources are not
communicating directly with the OMi gateway servers, make sure that port 383 is routed through
the load balancer to the OMi gateway servers.
If the load balancer or the reverse proxy is configured to pass through traffic directly (OSI layers 2
or 4), skip to the next step. If configured to work on OSI layer 7, perform as follows:
o

The certificate on the load balancer must be installed for port 383 (or the port that you
configured for secure communication).

o

Communication between the load balancer and the gateway server systems must be secured.

o

The load balancer must possess a server certificate for authentication so that the external
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systems can connect successfully. The load balancer must also validate client certificates
presented by external clients (for example, OM servers).
o

The load balancer must possess a client certificate for authentication with OMi.

a. Issue a certificate for the load balancer from the OMi data processing server:
ovcm -issue -file <certificate file> -name <Fully Qualified Domain Name of Virtual
Interface or Reverse Proxy> [ -pass <passphrase>]
b. Import this certificate as a server and client certificate into your load balancer.
For details on the required format, see your load balancer documentation. You can use
openssl to convert the certificates into the required format.
6. Check the connection between the servers. For details, see "How to Verify the Trusted
Relationship" on page 58.
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After establishing a trust relationship between the OMi Data Processing Server and external systems,
check the connection between the two systems. You can do this while setting up your connected
server in the Server Properties of the Create New Server Connection dialog box by selecting
Test Connection. You can also do this by using the command-line interface:
To check the connection between the OMi server environment and an external system:
1. From the external host, verify that communication to the OMi installation is possible (the return
value should be eServiceOk) by executing the following command on the external server system:
bbcutil -ping https://<load_balancer_or_single_gateway_server_or_RP_or_Server_Pool_
Virtual_Interface>
Example of the command result:
https://<HPE OMi servername>: status=eServiceOK
coreID=7c66bf42-d06b-752e-0e93-e82d1644cef8 bbcV=06.10.105
appN=ovbbccb appV=11.03.031 conn=1 time=1094 ms
2. From all OMi Gateway Server hosts, verify that communication with the external server host is
possible (the return value should be eServiceOk) by executing the following command:
bbcutil -ping https://<external server hostname>
Example of the command result:
https://<external_host_server_name>: status=eServiceOK
coreID=0c43c032-5c94-7535-064a-f7654a86f2d3 bbcV=06.10.070
appN=ovbbccb appV=11.03.031 conn=7 time=140 ms
Troubleshooting:
If the bbcutil –ping command executes but does not return eServiceOk, you may need to restart the
ovc processes on the system that is not responding by running the following commands:
l

Linux: /opt/OV/bin/ovc –kill and /opt/OV/bin/ovc –start

l

Windows: ovc –kill and ovc –start
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OMi can forward events, run actions and tools on the OM server, and retrieve instructions from the OM
server. Credentials for the OM web service are required for this processing.
1. In the Connected Servers pane, click
New and select Operations Manager for Windows or
Operations Manager for UNIX. The Create New Server Connection dialog box opens.
2. In the General page, complete the following information:
a. Enter a display name, a unique internal name, if you want to replace the automatically
generated name, and (optional) a description of the connection being specified.
b. Select Active if you want to enable the server connection immediately.
c. Click Next to open the Server Properties page.
3. In the Server Properties page, complete the following information:
a. Enter the fully qualified domain name of the host system of the OM server.
If the host system is a high-availability cluster, enter the fully qualified domain name of the
cluster package where the OM server is installed.
If OM is installed in a server pooling environment, add the virtual interface as the first OM
server. Add all physical pool servers separately as connected servers.
b. Enter the Integration User name used to log on to the OM server.
For OM for Windows servers, specify both the domain to which the host system belongs and
the user name as follows:
<DOMAIN>\<user name>
If the host system is not part of a domain, replace <DOMAIN> with the hostname of the system.
HPE recommends to use a dedicated user so that it is clear which events are owned by and
being worked on in OMi.
Note: All messages forwarded from OM systems are treated as allowing read and write.
Any changes made to these events result in back synchronization to the originating OM
server.
For OM for Windows, the selected user must have at least PowerUser rights and must be
a member of the HP-OVE-Admins group and the local administrators group (for example,
HP-OVE-User).
For OM for UNIX or Linux, only the Integration User (opc_adm) has the necessary OM
administrator rights to be able to synchronize topology and execute tools.
c. Select the Sync Updates check box if you want to synchronize the event updates back to the
OM server.
Optional. It is possible to customize the way events and change notifications are delivered to
this server by using Advanced Delivery Options:
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n

Serial — Events and change notifications are delivered serially in the order in which they
were received.

n

Serial per Source — (Default) Each originating server is provided with a dedicated
outgoing request delivery path. For each individual outgoing request delivery path, events
and change notifications are delivered serially in the order in which they were received.
This can increase the throughput for delivery of events and change notifications when
many events are received from multiple originating servers, while maintaining the incoming
order.

n

Parallel— The configured number of outgoing request delivery paths is used when
forwarding events and change notifications. This can further increase the throughput for
delivery of events and change notifications. However, because the source of the event is
not considered, maintenance of the incoming order cannot be guaranteed.

d. Specify if you want to forward dynamic topology information from the OMi instance to which
you are logged on, to the OM instance that you are currently configuring.
Note: If you change the status of the Forward Dynamic Topology to this Target
Server check box, you must restart the WDE process on all gateway servers. To do so,
run the following commands:
<OMi_HOME>/opr/support/opr-support-utils.[bat|sh] -stop wde
<OMi_HOME>/opr/support/opr-support-utils.[bat|sh] -start wde
In most cases, you should leave this check box clear. Otherwise, OMi will resend the
topology data received from one OM server to the rest of OM servers. This may lead to
unexpected consequences on OM servers (for example, a deleted node on an OM server may
reappear after some time, or new nodes may appear on an OM server after you add a node by
using a data collector, such as SiteScope).
e. Click Test Connection to check that the specified connection attributes are correct. If an
error link is displayed, check the error message, correct the connection information, and retest
the connection.
f. Click Next to open the Outgoing Connection page.
4. The outgoing connection is used to receive instructions, and execute tools and actions on external
nodes.
Note: If you edit outgoing connection properties (for example, integration user, password, and
port), you must restart the MercuryAS process for the changes to take effect.
Complete the following information:
o

If you are using this server for receiving instructions, and executing tools and actions on
external nodes, enter the password for the integration user and the port required to access the
server for receiving instructions, and executing tools and actions. The default port value is
automatically inserted and can be restored by using Set default port.
Note: For OM for Windows, the selected user must have at least PowerUser rights and
must be a member of the HP-OVE-Admins group and the local administrators group.
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For OM for UNIX or Linux, the Integration User must have OM administrator rights (opc_
adm) to be able to synchronize topology and execute tools.
Optional. If you are using secure communication (default), make sure that the Use Secure
HTTP option is selected, and apply a certificate by using one of the following methods:
n

Import from File — Opens the file browser and enables you to navigate to and specify a
Base64 Encoded X.509 certificate file for the server connection.

n

Retrieve from Server — Retrieve a certificate from the host system specified in this
server connection.
Note: In a clustered OM for Windows environment, the IIS web server on all cluster nodes
must have the same certificate. If different, valid certificates are used, problems such as
tools execution may be experienced after switching to a node with a different certificate.
For more details, see the article available at
https://softwaresupport.hpe.com/km/KM01211399.
Note: Secure communication is necessary for OM server pooling environments. However,
do not use the Import from File or Retrieve from Server options.
Set up a trusted relationship between all OM and OMi servers as described in "How to
Establish a Trust Relationship for a Server Connection" on page 55.

o

If you are using an alternative server for providing instructions, and executing actions and
tools, select Use other Server, and then select a server from the list. For the physical servers
in a server pooling environment, select the virtual interface connected server.
Note: Avoid selecting an alternative action execution server that creates a loop and
results in specifying the connected server as the action execution server. Select an
alternative action execution server or use the Use this Server option.

Click Test Connection to check that the specified connection attributes are correct. If an error
link is displayed, check the error message, correct the connection information, and retest the
connection.
5. Click Finish.
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Before configuring the forwarding of topology (node and service) data to OMi from OM servers,
complete the following configuration steps in OMi:
l

l

l
l

Establish a trust relationship between the Data Processing Server and the OM server. For details,
see "How to Establish a Trust Relationship for a Server Connection" on page 55.
Add the OM server as a connected server to OMi. For details, see "How to Create a Connection to
an OM Server" on page 59.
Optional. Import content packs. For details, see the OMi Administration Guide.
Optional. Use the opr-sdtool.[bat|sh] command line tool to upload new or changed
synchronization packages from the file system to the database. For details, see the OMi
Extensibility Guide.
Note: You can also use the Content Manager to import and export the existing synchronization
packages in the Content Manager format.

After ensuring that the OM server is added to OMi as a connected server, configure the forwarding of
topology (node and service) data on the OM server.
The following sections describe how to configure topology synchronization:
l

"How to Configure Topology Synchronization on OM for Windows Systems" below

l

"How to Migrate from Scheduled Synchronization on OM for Windows Systems" on the next page

l

"How to Configure Topology Synchronization on OM for UNIX or Linux Systems" on page 64

l

"How to Migrate from Scheduled Synchronization on OM for UNIX or Linux Systems" on page 65

How to Configure Topology Synchronization on OM for Windows Systems
This section describes how to configure topology synchronization on OM for Windows management
servers. For further details, see the OM for Windows documentation.
To forward topology data to OMi, complete the following steps on the OM for Windows
management server from which you want to receive topology information:
1. Prerequisite. Make sure that the minimum patch level for the OM for Windows management server
is installed:
o

Version 8.16: Patch OMW_00121 or superseding patch

o

Version 9.00: Patch OMW_00122 or superseding patch

2. Prerequisite. Configure trusted certificates for multiple servers.
In an environment with multiple servers, you must configure each server to trust certificates that
the other servers issued.
3. In the console tree, right-click Operations Manager, and then click Configure > Server.... The
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Server Configuration dialog box opens.
4. Click Namespaces, and then click Discovery Server. A list of values appears.
5. Add the hostname of the server to List of target servers to forward discovery data. If there is
more than one target server, separate the hostnames with semicolons, for example:
server1.example.com;server2.example.com
If the target server uses a port other than port 383, append the port number to the hostname, for
example:
server1.example.com:65530;server2.example.com:65531
6. Make sure that the value of Enable discovery WMI listener is true. This is the default value.
7. Click OK to save your changes and close the Server Configuration dialog box.
8. Restart the OvAutoDiscovery Server service for your changes to take effect:
net stop "OvAutoDiscovery Server"
net start "OvAutoDiscovery Server"
9. Start the initial synchronization of topology data:
a. In the console tree, select Tools > HP Operations Manager Tools.
b. Right-click Synchronize Topology and select All Tasks > Launch Tool....
The startInitialSync.bat tool is started and begins to send all the topology data to the
configured target management servers.

How to Migrate from Scheduled Synchronization on OM for Windows Systems
This section describes how to migrate from scheduled synchronization on OM for Windows
management servers. For further details, see the OM for Windows documentation.
To migrate from scheduled synchronization, complete the following steps on the OM for
Windows management server from which you want to receive topology information:
1. Prerequisite. Make sure that the minimum patch level for the OM for Windows management server
is installed:
o

Version 8.16: Patch OMW_00121 or superseding patch

o

Version 9.00: Patch OMW_00122 or superseding patch

2. Clear the agent repository cache on the OM management server by using the following command:
%OvBinDir%\ovagtrep -clearall
3. Remove the service auto-discovery policies from the OM management server node:
%OvBinDir%\ovpolicy -remove DiscoverOM
%OvBinDir%\ovpolicy -remove DiscoverOMTypes
4. Synchronize the policy inventory on the OM management server:
a. In the console tree, right-click the management server.
b. Select All Tasks > Synchronize inventory > Policies.
The management server creates a deployment job to retrieve the inventory from the local
agent.
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5. Make sure the listener process is running:
a. In the console tree, right-click Operations Manager, and select Configure Server.
The Server Configuration dialog box opens.
b. Click Namespaces, and select Discovery Server.
A list of values appears.
c. Set the value of Enable discovery WMI listener to true. This is the default value.
d. Click OK to save your changes and close the Server Configuration dialog box.
e. Restart the OvAutoDiscovery Server service for your changes to take effect:
net stop "OvAutoDiscovery Server"
net start "OvAutoDiscovery Server"
6. Start the initial synchronization of topology data:
a. In the console tree, select Tools > HP Operations Manager Tools.
b. Right-click Synchronize Topology and select All Tasks > Launch Tool....
The startInitialSync.bat tool is started and begins to send all the topology data to the
configured target servers.

How to Configure Topology Synchronization on OM for UNIX or Linux Systems
This section describes how to configure topology synchronization on OM for UNIX or Linux
management servers. For further details, see the OM for UNIX or Linux documentation.
To forward topology data to OMi, complete the following steps on the OM for UNIX or Linux
management server from which you want to receive topology information:
1. Prerequisite. Make sure that the minimum patch level for the OM 9.10 for UNIX or Linux
management server is installed:
o

HP-UX: Patch PHSS_42736 or superseding patch

o

Linux: Patch OML_00050 or superseding patch

o

Solaris: Patch ITOSOL_00772 or superseding patch

2. Prerequisite. Configure trusted certificates for multiple servers.
In an environment with multiple servers, you must configure each server to trust certificates that
the other servers issued.
3. Prerequisite. Set up the forwarding target (OMi Gateway Server, Reverse Proxy, or Load
Balancer) in the node bank as a managed node. To do so, run the following command:
/opt/OV/bin/OpC/utils/opcnode -add_node node_name=<node_name> net_type=NETWORK_
IP mach_type=<machine_type> group_name=<group_name> node_label=<node_name>

In this instance, <machine_type> relates to the operating system of the OMi host system, MACH_
BBC_WIN2K3_X64 (Windows) or MACH_BBC_LX26RPM_X64 (Linux), whereas <group_name> relates
to the operating system of the OM server host system, hp_ux, solaris, or linux.
4. Type the following command to enable topology synchronization:
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/opt/OV/contrib/OpC/enableToposync.sh -online -target <comma_separated_server_
list>
Replace <comma_separated_server_list> with the fully qualified domain name of the target
management server. If you have more than one target management server, separate each server
name with a comma (,). Do not include spaces in the server list.
This command restarts the service discovery server. The source management server begins to
send any topology data changes immediately.
5. Type the following command to start the initial synchronization of topology data:
/opt/OV/bin/OpC/startInitialSync.sh

How to Migrate from Scheduled Synchronization on OM for UNIX or Linux
Systems
This section describes how to migrate from scheduled synchronization on OM for UNIX or Linux
management servers. For further details, see the OM for UNIX or Linux documentation.
To migrate from scheduled synchronization, complete the following steps on the OM for UNIX
or Linux management server from which you want to receive topology information:
1. Prerequisite. Make sure that the minimum patch level for the OM 9.10 for UNIX or Linux
management server is installed:
o

HP-UX: Patch PHSS_42736 or superseding patch

o

Linux: Patch OML_00050 or superseding patch

o

Solaris: Patch ITOSOL_00772 or superseding patch

2. Clear the agent repository cache on the management server by using the following command:
/opt/OV/bin/ovagtrep -clearall
3. Remove the service auto-discovery policies from the management server node:
/opt/OV/bin/ovpolicy -remove DiscoverOM
/opt/OV/bin/ovpolicy -remove DiscoverOMTypes
4. Deassign the service auto-discovery policies from the management server node:
/opt/OV/bin/OpC/utils/opcnode -deassign_pol node_name=<management_server> net_
type=NETWORK_IP pol_name=DiscoverOMTypes pol_type=svcdisc
/opt/OV/bin/OpC/utils/opcnode -deassign_pol node_name=<management_server> net_
type=NETWORK_IP pol_name=DiscoverOM pol_type=svcdisc
/opt/OV/bin/OpC/opcragt -dist <management_server>
Replace <management_server> with the name of the management server.
5. Type the following command to enable topology synchronization:
/opt/OV/contrib/OpC/enableToposync.sh -online
This command restarts the service discovery server. The source management server begins to
send any topology data changes immediately.
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6. Type the following command to start the initial synchronization of topology data:
/opt/OV/bin/OpC/startInitialSync.sh
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To enable event synchronization between OM and OMi, set up a message forwarding policy on the OM
server. The policy includes the node name of the target OMi server. Alternatively, specify the load
balancers, if configured, or one Gateway Server for each OMi installation, as appropriate for your highavailability arrangement.
Before setting up a policy and to avoid overwriting the current settings, verify if a policy of the type
Server-based Flexible Management is already active on the OM for Windows server. If a policy does
not exist, create a new policy as described in "Create a New Policy" below. If a policy already exists
and is active, adapt the policy as described in "Adapt an Active Policy" on the next page.

Create a New Policy
To set up a new policy on OM for Windows, complete the following steps:
1. Start the OM for Windows console as follows:
Start > Programs > HP > HP Operations Manager
2. In the left pane of the OM for Windows console, select the following:
Policy management > Policies grouped by type > Server Policies > Server-based Flexible
Management
3. Verify that no Server-based Flexible Management policy exists. If such a policy does exist, go to
"Adapt an Active Policy" on the next page.
4. Right-click Server-based Flexible Management (or a blank space in the right pane), and then
select New > Policy.
The Server-based Flexible Management Editor dialog opens.
5. In the General tab text pane, insert the following policy text:
TIMETEMPLATES
# none
RESPMGRCONFIGS
RESPMGRCONFIG DESCRIPTION "Forward all messages to OMi"
SECONDARYMANAGERS
ACTIONALLOWMANAGERS
MSGTARGETRULES
MSGTARGETRULE DESCRIPTION "Forward all messages rule"
MSGTARGETRULECONDS
MSGTARGETRULECOND DESCRIPTION "Forward all messages"
MSGTARGETMANAGERS
MSGTARGETMANAGER
TIMETEMPLATE "$OPC_ALWAYS"
OPCMGR IP 0.0.0.0 "<OMi fully qualified host name>"
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Note: This forwards all messages to OMi. If you want to reduce the number of messages to
be sent, modify the text of the policy so that only a selected subset of messages is sent to
OMi. For details, see the OM documentation.
6. Replace <OMi fully qualified host name> in the policy text with the fully qualified hostname
of the Gateway server to receive OM messages (for example, HPEGwSrv.example.com).
In deployments involving a load balancer, a NAT device, or a reverse proxy, use the fully qualified
hostname of the system used to access the Gateway server (for example,
VirtualSrv.example.com).
7. Click Check Syntax to check for syntax errors in the new policy text.
8. After correcting any syntax errors, click Save and Close.
9. In the Save As dialog box that opens, enter a name and a description for the new policy.
10. Click OK to close the Save As dialog.
11. From the Policy Management folder, right-click the policy, and the select All Tasks > Deploy on.
12. In the Deploy server policy on dialog box that opens, select the name of your OM management
server.
13. Click OK to deploy the server-based flexible management policy on the OM for Windows
management server.

Adapt an Active Policy
If a message forwarding policy already exists on the OM for Windows system, complete the following
steps to edit this policy and add another message target manager to it:
1. Start the OM for Windows console as follows:
Start > Programs > HP > HP Operations Manager
2. In the left pane of the OM for Windows console, select the following:
Policy management > Server policies grouped by type > Server-based Flexible
Management
3. In the right pane of the OM for Windows console, double-click the existing policy that you want to
edit. The Server-based Flexible Management Editor dialog opens.
If such a policy does not exist, go to "Create a New Policy" on the previous page.
4. Add another message target manager as shown in the following example policy text:
TIMETEMPLATES
# none
RESPMGRCONFIGS
RESPMGRCONFIG DESCRIPTION "Forward all messages to OMi"
SECONDARYMANAGERS
ACTIONALLOWMANAGERS
MSGTARGETRULES
MSGTARGETRULE DESCRIPTION "Forward all messages rule"
MSGTARGETRULECONDS
MSGTARGETRULECOND DESCRIPTION "Forward all messages"
MSGTARGETMANAGERS
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MSGTARGETMANAGER
TIMETEMPLATE "$OPC_ALWAYS"
OPCMGR IP 0.0.0.0 "<First Target Manager>"

MSGTARGETMANAGER
TIMETEMPLATE "$OPC_ALWAYS"
OPCMGR IP 0.0.0.0 "<OMi fully qualified host name>"
Note: This forwards all messages to OMi. If you want to reduce the number of messages to
be sent, modify the text of the policy so that only a selected subset of messages is sent to
OMi. For details, see the OM documentation.
5. Replace <OMi fully qualified host name> in the text with the fully qualified hostname of the
Gateway server that should receive OM messages (for example, HPEGwSrv.example.com).
In deployments involving a load balancer, a NAT device, or a reverse proxy, use the fully qualified
hostname of the system used to access the Gateway server (for example,
VirtualSrv.example.com).
6. Click Check Syntax to check for syntax errors in the new policy text.
7. After correcting any syntax errors, click Save and Close.
8. Redeploy the server-based flexible management policy on the OM for Windows management
server.
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To enable event synchronization between OM and OMi, you must set up a message forwarding policy
on each OM management server with the node name of the load balancer, if configured, or one
Gateway Server, as appropriate for your high-availability arrangement.
Before setting up a policy, make sure that the forwarding target is set up as a node (see "Set up a
Forwarding Target in the OM for UNIX or Linux Node Bank" below). In addition, verify if the msgforw
policy is already active on the OM for UNIX or Linux server. If the msgforw does not exist, create a
new policy as described in "Create a New Policy" below. If the msgforw policy already exists and is
active, adapt the policy as described in "Adapt an Active Policy" on the next page.

Set up a Forwarding Target in the OM for UNIX or Linux Node Bank
Note: Make sure that the SNMP agent is running before adding a managed node to the OM
database.
The forwarding target (OMi Gateway Server, Reverse Proxy, or Load Balancer) must be set up in the
node bank as a managed node. You must add the managed node by using the opcnode command line
tool:
/opt/OV/bin/OpC/utils/opcnode -add_node node_name=<node_name> net_type=NETWORK_IP
mach_type=<machine_type> group_name=<group_name> node_label=<node_name>

In this instance, <machine_type> relates to the operating system of the OMi host system, MACH_BBC_
WIN2K3_X64 (Windows) or MACH_BBC_LX26RPM_X64 (Linux), whereas <group_name> relates to the
operating system of the OM server host system, hp_ux, solaris, or linux.
To verify that the node was added successfully, run the following command:
/opt/OV/bin/OpC/utils/opcnode -list_nodes

Create a New Policy
To set up a new message forwarding policy on OM for UNIX or Linux, complete the following steps:
1. Change to the work_respmgrs directory as follows:
cd /etc/opt/OV/share/conf/OpC/mgmt_sv/work_respmgrs/
Note: Policy template files can be found in /etc/opt/OV/share/conf/OpC/mgmt_sv/tmpl_
respmgrs.
2. Create a new policy file by using the following command:
vi <policy file name>
3. Insert the following text into the new policy file:
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TIMETEMPLATES
# none
RESPMGRCONFIGS
RESPMGRCONFIG DESCRIPTION "Forward all messages to OMi"
SECONDARYMANAGERS
ACTIONALLOWMANAGERS
MSGTARGETRULES
MSGTARGETRULE DESCRIPTION "Forward all messages rule"
MSGTARGETRULECONDS
MSGTARGETRULECOND DESCRIPTION "Forward all messages"
MSGTARGETMANAGERS
MSGTARGETMANAGER
TIMETEMPLATE "$OPC_ALWAYS"
OPCMGR IP 0.0.0.0 "<OMi fully qualified host name>"

Note: This forwards all messages to OMi. If you want to reduce the number of messages to
be sent, modify the text of the policy so that only a selected subset of messages is sent to
OMi. For details, see the OM documentation.
4. Replace <OMi fully qualified host name> in the text with the fully qualified hostname of the
Gateway server that should receive OM messages (for example, HPEGwSrv.example.com).
In deployments involving a load balancer, a NAT device, or a reverse proxy, use the fully qualified
hostname of the system used to access the Gateway server (for example,
VirtualSrv.example.com).
5. Enter the following command to check for syntax errors in the new policy text:
/opt/OV/bin/OpC/opcmomchk -msgforw <policy file name>
6. After correcting any syntax errors, copy the policy to the msgforw policy file in the respmgrs
directory as follows:
cp <policy file name> /etc/opt/OV/share/conf/OpC/mgmt_sv/respmgrs/msgforw
7. Inform the server processes to reread the configuration as follows:
/opt/OV/bin/ovconfchg
Message forwarding from OM to OMi is now configured and enabled.

Adapt an Active Policy
If the message forwarding policy already exists on the OM for UNIX or Linux system, complete the
following steps to edit this policy and add another message target manager to it:
1. Change to the work_respmgrs directory as follows:
cd /etc/opt/OV/share/conf/OpC/mgmt_sv/work_respmgrs/
Note: Policy template files can be found in /etc/opt/OV/share/conf/OpC/mgmt_sv/tmpl_
respmgrs/.
2. Edit the existing policy to which you want to add the OMi server as a target as follows:
vi <policy file name>

HPE Operations Manager i (10.12)

Page 71 of 207

OMi Integrations Guide
Chapter 17: How to Configure the OM for UNIX or Linux Forwarding Policy

3. Add another message target manager as shown in the following policy text:
# none
RESPMGRCONFIGS
RESPMGRCONFIG DESCRIPTION "Forward all messages to OMi"
SECONDARYMANAGERS
ACTIONALLOWMANAGERS
MSGTARGETRULES
MSGTARGETRULE DESCRIPTION "Forward all messages rule"
MSGTARGETRULECONDS
MSGTARGETRULECOND DESCRIPTION "Forward all messages"
MSGTARGETMANAGERS
MSGTARGETMANAGER
TIMETEMPLATE "$OPC_ALWAYS"
OPCMGR IP 0.0.0.0 "<First Target Manager>"

MSGTARGETMANAGER
TIMETEMPLATE "$OPC_ALWAYS"
OPCMGR IP 0.0.0.0 "<OMi fully qualified host name>"
Note: This policy forwards all messages to OMi. If you want to reduce the number of
messages to be sent, modify the text of the policy so that only a selected subset of
messages is sent to OMi. For details, see the OM documentation.
4. Replace <OMi fully qualified host name> in the text with the fully qualified hostname of the
Gateway Server system that should receive OM messages (for example,
HPEGwSrv.example.com).
In deployments involving a load balancer, a NAT device, or a reverse proxy, use the fully qualified
hostname of the system used to access the Gateway Server system (for example,
VirtualSrv.example.com).
5. Enter the following command to check for syntax errors in the new policy text:
/opt/OV/bin/OpC/opcmomchk -msgforw <policy file name>
6. After correcting any syntax errors, copy the policy to the msgforw policy file in the respmgrs
directory as follows:
cp <policy file name> /etc/opt/OV/share/conf/OpC/mgmt_sv/respmgrs/msgforw
7. Inform the server processes to reread the configuration as follows:
/opt/OV/bin/ovconfchg
Message forwarding from OM to OMi is now configured and enabled.
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This chapter provides you with instructions on how to validate event synchronization and test the
connection between OM and OMi.
Note: Make sure that you configured OM to enable OMi users to use tools, actions, and instruction
text. You configure this in the Connected Servers manager in OMi. For details, see "How to Create
a Connection to an OM Server" on page 59.

Verify Message Forwarding from OM to OMi
To check if the message forwarding policy for sending messages from OM to OMi is configured
correctly, follow these steps:
1. Make sure the OMi servers are running.
2. Make sure at least one open message interface policy is deployed on your OM system. For
instructions and details, see the OM documentation.
3. On the OM system, open a command or shell prompt and create a new message by executing the
following command:
Windows:

o

opcmsg a=App o=Obj msg_text="Hello"
UNIX or Linux:

o

/opt/OV/bin/OpC/opcmsg a=App o=Obj msg_text="Hello"
If you configured the message forwarding policy correctly, the message arrives at the OM server
and is forwarded to OMi. You can view the events with the OMi Event Browser.
Note: If the message is sent multiple times, no new message is generated by OM. These
messages are regarded as duplicates and only the message duplicate count is increased.
To generate a new message, modify the message text. For example:
o

Windows:
opcmsg a=App o=Obj msg_text="Hello_002"

o

UNIX or Linux:
/opt/OV/bin/OpC/opcmsg a=App o=Obj msg_text="Hello_002"

Synchronize OMi Events with OM Messages
To check if a change to an event in OMi that is already synchronized between OMi and OM is
resynchronized in OM, change the severity of an event as follows:
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1. Make sure the OMi platform is running.
2. Log on to the OMi platform management console.
3. Select Applications > Operations Management.
4. In the Event Browser, select the event for which you want to change the severity. Choose the
event that was already synchronized in OM and OMi and change its severity, for example, from
minor to major.
5. Access the General tab of the Event Details pane.
6. From the Severity drop-down list, choose another severity (for example, major), and then click
Save.
7. In the OM event browser, verify the severity of this event and make sure it was set to the new
severity value.
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To set up OMi in an environment managed by OM, follow these steps:
1. Before installing OMi, run the following command on all data processing servers and gateway
servers:
ovconfchg -ns sec.cm.client -set CERTIFICATE_SERVER <FQDN of primary DPS>
2. Install and configure OMi according to the OMi Installation and Upgrade Guide.
3. Integrate OM as described in "Workflow: Configuring Connections Between Operations Manager i
and OM" on page 54.

Optional. How to Set Up Forwarding Targets for
OM Agent Node Creation
To ensure that events are assigned to the correct CIs, the nodes in the OMi RTSM or UCMDB need to
be synchronized with the OM node bank(s). You can use the OM Agent Node Creation Forwarding
Targets infrastructure setting to forward topology data from operations agents monitored by OMi to a
specified OM for Linux or Windows server(s). After the topology information is forwarded from OMi, a
node is created in the OM for Linux or Windows server. The platform of the synchronized node is
displayed as other in OM for Linux and n/a in OM for Windows.
To set up a forwarding target for the creation of an agent node, edit the OM Agent Node Creation
Forwarding Targets infrastructure setting:
1. In OMi, navigate to
Administration > Setup and Maintenance > Infrastructure Settings
2. Select Applications and use the list to select the Operations Management context. Scroll down
to Operations Management - HPOM Topology Synchronization Settings.
3. Next to the OM Agent Node Creation Forwarding Targets setting, click

Edit Item.

4. Enter your target server in the Value field.
If you want to enter more than one target server, separate them with a semi-colon.
5. Click ok to save.
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The following table shows the correspondence between the fields of an OMi event and an OM
message.
OM Message
OMi Event Attribute

OM Message Attribute

ID

Message ID

Title

Message Text

Description
Lifecycle State/State
(depending on space)

Description
N/A

Solution
Severity

Solution
Severity

Priority
Category

Priority
Message Group

Subcategory
Type

OM Custom Message
Attribute (CMA)

SubCategory
Message Type

Related CI Hint

RelatedCiHint
(incoming to OMi)

HPOM Service ID

Service Name

Related CI

N/A

Node

N/A

Node Hint, DNS Name, IP Address,
Core ID

node

NodeHint
(incoming to OMi)

Source CI Hint, DNS Name, IP
Address, Core ID

genNode

SourceCiHint
(incoming to OMi)

Originating Server

origin

Sending Server

sender

Assigned User

owner
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OM Message
OMi Event Attribute

Assigned Group

OM Message Attribute

N/A

C (Event Browser)

CauseEventId
(synchronized back to
OM)

Because there is a parent event, the
current event will be shown as being a
symptom.
C (Event Browser)

OM Custom Message
Attribute (CMA)

N/A

Because there is at least one child event,
the current event will be shown as being a
cause.
Custom Attributes

CustomMessageAttributes

Time Created

CreationTime

Time State Changed

N/A

Time Received

ReceivedTime

Duplicate Count

NumberOfDuplicates

ETI Hint

EtiHint
(incoming to OMi)

User Action

Operator Initiated Action

Automatic Action

Automatic Action

Application

Application

Object

Object

Key
(only in details)

MessageKey

Close Events with Key

Pattern of 1.
MessageKeyRel

Original Data

OriginalText

(This field is not displayed, but events that
have this attribute arrive as closed.)

logOnly

Match Information

policy, conditionId
(unmatched)
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OM Message
OMi Event Attribute

OM Message Attribute

Original ID
(only in details)

origId

Correlation Rule

N/A

Source CI

N/A

No Duplicate Suppression

Event Type Indicator/ETI
part of CI (after :)
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This section contains troubleshooting information about OM integration-related issues.

Cleanup after switching OM to another OMi server
After reconnecting OM to another OMi server, for example after activating a disaster recovery
environment, you should delete the buffered messages on the OM system for the old OMi server. If the
messages are left in the forwarding buffer, there may be some performance degradation as the system
regularly tries to deliver them without success. They also consume some disk space. It is not possible
to re-direct these messages to the new OMi server, and these cannot be synchronized.
Note: All messages currently in the buffer are deleted. It is not possible to distinguish between
different targets and messages for other targets are also deleted.

To delete the forwarding buffer files on OM for Windows:
1. Stop the server processes: vpstat -3 -r STOP
2. Delete all files and folders contained within the following directories:
<OvDataDir>\shared\server\datafiles\bbc\snf\data
<OvDataDir>\shared\server\datafiles\bbc\snf\OvEpMessageActionServer
3. Restart the server processes: vpstat -3 -r START

To delete the forwarding buffer files on OM for UNIX:
1. Stop the server processes: ovc -kill
2. Delete all files and folders contained within the following directories:
/var/opt/OV/shared/server/datafiles/bbc/snf/data
/var/opt/OV/share/tmp/OpC/mgmt_sv/snf/opcforwm
3. Restart the server processes: ovc -start

Specifying the URL of a Load Balancer
If the OM server is connected to OMi by using a load balancer, the URL of the load balancer
(http://<load balancer>:80) must be specified in the infrastructure setting:
Foundation > Platform Administration > Host Configuration > Default Virtual Gateway Server
for Data Collectors URL
Note: If you omit this setting, event synchronization might get confused as it is using the wrong
sender hostname (the physical gateway server in place of the virtual system name).
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Chapter 22: Operations Manager i - Service
Manager Integration Overview
This section describes the integration between HPE Service Manager and Operations Manager i.
If your setup uses an external UCMBD, follow the steps provided in "OMi-SM Integration with
UCMDB" on page 129.
If not, follow the steps provided in "OMi-SM Integration with RTSM" on page 85.

Versions
In general, the information provided in this guide is for integrating OMi with SM 9.4x.
Caution: When integrating OMi with SM 9.40, make sure that one of the following patches are
applied:
l

HPSM_00700 - Service Manager 9.40.2001 p2 - Server for Linux

l

HPSM_00701 - Service Manager 9.40.2001 p2 - Server for Solaris

l

HPSM_00702 - Service Manager 9.40.2001 p2 - Server for Windows

l

HPSM_00706 - Service Manager 9.40.2001 p2 - OMi Integration

Integration Options
OMi-SM Integration Options with RTSM
The following figure shows the options for integrating OMi and SM when using the RTSM. For
detailed information, see "OMi-SM Integration with RTSM" on page 85.
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o

CIs synchronization between SM and OMi. To enable operators of all systems to see the
same CIs, important service, business application, and infrastructure CIs should be synchronized
between all systems. Synchronized CIs are a prerequisite for all other integration features. For
details, see "RTSM-Service Manager Integration" on page 87.

o

Incident forwarding between SM and OMi. OMi enables you to forward events from OMi to
SM. Forwarded events and subsequent event changes are synchronized back from SM to OMi.
You can also drill down from OMi events to SM incidents or from SM incidents to OMi events. For
details, see "Event Forwarding from OMi to SM (RTSM)" on page 95.

o

Downtime forwarding from SM to OMi. You can create downtimes (also known as outages) in
OMi based on Requests for Changes in SM. This is done in two steps. First, scheduled downtime
CIs are created in OMi based on RFCs in SM. Then, a BSM downtime CI is created based on the
scheduled downtime. For details, see "Downtime Forwarding from Service Manager to OMi
(RTSM)" on page 112.

o

Downtime notification from OMi to SM. OMi can send downtime start and end events to SM to
notify operators when a downtime occurs. This provides additional information to the SM operator
in case of a downtime that was not driven by an RFC. For details, see "Sending downtime
notifications from OMi to SM (RTSM)" on page 119.

o

View planned changes and incident details. This integration enables you to view planned
changes and incident details in the Changes and Incidents and Hierarchy components in OMi. For
details, see "View Changes and Incidents in OMi (RTSM)" on page 120.

o

The Business Impact Report integration enables Service Manager operators to launch an impact
report from an incident in the context of the incident's affected CI. This opens an OMi KPI over
time page, displaying the affected CI and impacted CIs and services, which allows the operator to
categorize and prioritize the incident accordingly. For details, see "Business Impact Report (BIR)
(RTSM)" on page 127.
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OMi-SM Integration Options with UCMDB
The following figure shows the options for integrating OMi and SM when using a UCMDB. For detailed
information, see "OMi-SM Integration with UCMDB" on page 129.

l

l

l

l

l

CIs synchronization between SM and UCMDB. To enable operators of all systems to see the
same CIs, important service, business application, and infrastructure CIs should be synchronized
between all systems. Synchronized CIs are a prerequisite for all other integration features. With an
external UCMDB, CIs are synchronized from SM to the UCMDB system and vice versa (for details,
see "UCMDB-Service Manager Integration" on page 131), and from the UCMDB system to OMi and
vice versa (for details, see "OMi-UCMDB Integration" on page 131). In this case, the UCMDB acts
as Global ID generator.
Incident forwarding between SM and OMi. OMi enables you to forward events from OMi to SM.
Forwarded events and subsequent event changes are synchronized back from SM to OMi. You can
also drill down from OMi events to SM incidents or from SM incidents to OMi events. For details, see
"Event Forwarding from OMi to SM (UCMDB)" on page 139.
Downtime forwarding from SM to OMi. You can create downtimes (also known as outages) in
OMi based on Requests for Changes in SM. This is done in two steps. First, scheduled downtime
CIs are created in UCMDB based on RFCs in SM. Then, a BSM downtime CI is created in OMi
based on the scheduled downtime. For details, see "Downtime Forwarding from Service Manager to
OMi (UCMDB)" on page 157.
Downtime notification from OMi to SM. OMi can send downtime start and end events to SM to
notify operators when a downtime occurs. This provides additional information to the SM operator in
case of a downtime that was not driven by an RFC. For details, see "Sending downtime notifications
from OMi to SM (UCMDB)" on page 164.
View planned changes and incident details. This integration enables you to view planned
changes and incident details in the Changes and Incidents and Hierarchy components in OMi. For
details, see "View Changes and Incidents in OMi (UCMDB)" on page 165.
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l

The Business Impact Report integration enables Service Manager operators to launch an impact
report from an incident in the context of the incident's affected CI. This opens an OMi KPI over time
page, displaying the affected CI and impacted CIs and services, which allows the operator to
categorize and prioritize the incident accordingly. For details, see "Business Impact Report (BIR)
(UCMDB)" on page 172.
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Chapter 23: OMi-SM Integration with RTSM
This section describes integrating OMi with Service Manager in the case where the RTSM contained in
OMi is used as CMDB.
This section includes:
l

"Data Flow Probe" below

l

"Create User Accounts for the OMi-SM Integration (RTSM)" on the next page

l

(prerequisite) "RTSM-Service Manager Integration" on page 87

l

"Enable LW-SSO for the OMi-SM Integration (RTSM)" on page 87

l

"View Actual State in SM (RTSM)" on page 94

l

"Event Forwarding from OMi to SM (RTSM)" on page 95

l

"Downtime Forwarding from Service Manager to OMi (RTSM)" on page 112

l

"Sending downtime notifications from OMi to SM (RTSM)" on page 119

l

"View Changes and Incidents in OMi (RTSM)" on page 120

l

"Business Impact Report (BIR) (RTSM)" on page 127

Data Flow Probe
The OMi-SM Integration uses a Data Flow Probe to exchange data. This DFP can be installed on one
of the OMi Gateway or Data Processing Server systems or on a separate system. HPE recommends
installing it on an OMi Gateway system as this avoids setting up an additional system.
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The Data Flow Probe is necessary for
l

Populating the RTSM with CIs & Relationships

l

Pushing CIs & Relationships to SM

l

Federating Incidents and Changes into RTSM

l

Populating the RTSM with downtimes

Create User Accounts for the OMi-SM Integration
(RTSM)
The OMi-SM integration requires integration accounts to be set up for the two systems to access each
other.
1. In Service Manager, create an operator record with system administration privileges, and give it a
descriptive name, like OMiSMIntegrUser.
To create a dedicated integration user account in SM:
a. Log on to SM as a system administrator.
b. Type contacts in the SM command line, and press ENTER.
c. Create a new contact record for the integration user account.
i. In the Full Name field, type a full name. For example, RTSM.
ii. In the Contact Name field, type a name. For example, RTSM.
iii. Click Add, and then OK.
d. Type operator in the SM command line, and press ENTER.
e. In the Login Name field, type the user name of an existing system administrator account, and
click Search.
The system administrator account displays.
f. Create a new user account based on the existing one:
i. Change the Login Name to the integration account name you want (for example, rtsm).
ii. Type a Full Name. For example, RTSM.
iii. In the Contact ID field, click the Fill button and select the contact record you have just
created.
iv. Click Add.
v. Select the Security tab, and change the password.
vi. Click OK.
This is the user account that the OMi server uses to access Service Manager. It is used to forward
events, push CIs to, and retrieve incidents and RFCs from Service Manager. Remember the user
name and password you specify here, as the OMi system will need them to access the Service
Manager target server in later steps.
2. On each OMi server, create a user account with system administration privileges. This account is
used by SM to access the OMi system to retrieve the actual state information of a CI. Give it a
descriptive name, like SMOMiIntegrUser.
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Remember the user name and password you specify here, as Service Manager will need the
accounts to access the OMi server(s) in later steps.

RTSM-Service Manager Integration
Many of the integration features require that Configuration Items (CIs) exist in both Service Manager
and OMi. To enable operators of both systems to see the same CIs, they should be synchronized
between the two systems. For details about how to integrate OMi RTSM with Service Manager, see
the HPE Service Manager Universal CMDB Integration Guide. This integration, which synchronizes
important CIs, such as services, business applications and infrastructure CIs, is a prerequisite for all
other integration features.

Enable LW-SSO for the OMi-SM Integration (RTSM)
Lightweight Single Sign-On (LW-SSO) is optional but recommended for the OMi-SM Integration. You
have different LW-SSO configuration choices depending on your needs. The following describes how
LW-SSO can be used in the OMi-SM workflow.

LW-SSO options for the OMi-SM integration
When OMi creates an incident from an OMi event record
OMi creates an incident from an OMi event record by sending RESTful-based requests to Service
Manager. The incident ID is then stored in the event record.
LW-SSO is NOT needed in this process. A dedicated Service Manager user account was specified
when configuring the Service Manager integration in OMi. OMi uses this dedicated user account when
calling the Service Manager RESTful Web Service to create the incident.

When an OMi user views the incident details
The user can log in to Service Manager and view the incident details by using the incident ID stored in
the event record.
If the user wants to view the incident details by clicking the incident link from the event record, LWSSO can be used; otherwise a Service Manager login prompt will appear.
LW-SSO is optional for this process. To enable LW-SSO for this process, configure LW-SSO in both
the Service Manager server and Web tier (because the server needs to trust the Web tier), as well as in
OMi.

When Service Manager synchronizes the OMi incident status back to OMi
When a user has updated the OMi incident, Service Manager calls the OMi server's RESTful Web
Service to update the incident changes to the OMi event record.
LW-SSO is NOT needed in this process. A dedicated OMi user account was specified when the
Incident Exchange (OMi - SM) integration was set up in SMIS, and Service Manager uses this user
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account when calling the OMi server's RESTful Web Service to synchronize the incident status back
to the OMi event record.

When a user views the event details or the Business Impact Report from an OMi
incident
The user clicks the View OMi Event option or Launch Business Impact Report from the incident to
view the event details or Business Impact Report.
LW-SSO is optional for this process. If you enable LW-SSO in the Service Manager Web tier and in
OMi, the OMi login prompt is bypassed.
Required user permissions
In order to be able to view events, a user needs to be assigned a role with sufficient permission to read
events. To manage permissions in OMi, select:
Administration > Users > Users, Groups, and Roles
Select a role or create a new one. In the Permissions section, go to the Operations Console category,
select Events and specify the actions users can perform on Events assigned to user.
You can optionally grant the permission to view events not assigned to each user.

When CIs are synchronized between OMi/UCMDB and SM
LW-SSO is NOT needed in this process. Dedicated users are specified in the OMi-UCMDB, UCMDBSM and OMi-SM integration points.

Configuring LW-SSO for the OMi-SM integration
To use LW-SSO for the SM-OMi integration, LW-SSO must be enable for both products. In SM, you
must enable LW-SSO in both the SM server and web tier.

Step 1: Configure LW-SSO in the SM server
Service Manager servers, version 9.30 and later, support Lightweight Single Sign-On (LW-SSO). A
Service Manager integration can pass an authentication token to Service Manager and does not require
re-authentication. This simplifies the configuration of Single Sign-On for HPE solutions by removing the
need to use Symphony Adapter (which proxies LW-SSO-based authentication with the Service
Manager Trusted Sign-On solution).
Enabling LW-SSO in the Service Manager server enables web service integrations from other HPE
products (for example, Release Control) to bypass Service Manager authentication if the product user
is already authenticated and a proper token is used; enabling LW-SSO in both the Service Manager
server and web tier enables users to bypass the login prompts when launching the Service Manager
web client from other HPE applications.
Note: Existing integrations that use the Symphony Adapter and Trusted Sign-On rather than this
new LW-SSO mechanism can continue to work.
To configure LW-SSO in the Service Manager server:
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1. Go to the <Service Manager server installation path>/RUN folder, and open lwssofmconf.xml
in a text editor.
2. Make sure that the enableLWSSOFramework attribute is set to true (default).
3. Change the domain value example.com to the domain name of your Service Manager server host.
Note: To use LW-SSO, your Service Manager web tier and server must be deployed in the
same domain; therefore you should use the same domain name for the web tier and server. If
you fail to do so, users who log in from another application to the web tier can log in but may
be forcibly logged out after a while.
4. Set the initString value. This value MUST be the same with the LW-SSO setting of the other
HPE product you want to integrate with Service Manager.
Note:
l
LW-SSO version 2.5 is supported.
l

l

Optionally, you can change attributes paddingModeName, keySize, encodingMode,
engineName, and cipherType. However, you must make sure that they are same with the
LW-SSO setting of the other HPE product that you want to integrate with Service Manager.
Do not change the other configurations, such as the content in tag <restURLs>, and the
attribute of tag <service>.

Example:
<?xml version="1.0" encoding="UTF-8"?>
<lwsso-config xmlns="http://www.hpe.com/astsecurity/idmenablmentfw/lwsso/2.0">
<enableLWSSO enableLWSSOFramework="true"
enableCookieCreation="true" cookieCreationType="LWSSO" />
<web-service>
<inbound>
<restURLs>
<url>.*7/ws.*</url>
<url>.*sc62server/ws.*</url>
<url>.*/ui.*</url>
</restURLs>
<service service-type="rest" >
<in-lwsso>
<lwssoValidation>
<domain>example.com</domain>
<crypto cipherType="symmetricBlockCipher" engineName="AES"
paddingModeName="CBC" keySize="256" encodingMode="Base64Url"
initString="This is a shared secret passphrase"</crypto>
</lwssoValidation>
</in-lwsso>
</service>
</inbound>
<outbound/>
</web-service>
</lwsso-config>
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Step 2: Configure LW-SSO in the SM Web Tier
If Lightweight Single Sign-On (LW-SSO) is enabled in the Service Manager Web tier, integrations from
other HPE products will bypass Service Manager authentication when launching the Service Manager
Web client, provided that the HPE product user is already authenticated and a proper token is used.
Note:
l
To enable users to launch the Web client from another HPE product by using LW-SSO, you
must also enable LW-SSO in the Service Manager server.
l

Once you have enabled LW-SSO in the web tier, web client users should use the web tier
server's fully-qualified domain name (FQDN) in the login URL:
http://<myWebtierHostName>.<myDomain>:<port>/webtier-x.xx/index.do

The following procedure is provided as an example, assuming that the Service Manager Web tier is
deployed on Tomcat.
To configure LW-SSO in the Service Manager Web tier:
1. Open the <Tomcat>\webapps\< Service Manager Web tier>\WEB-INF\web.xml file in a text
editor.
2. Modify the web.xml file as follows:
a. Set the <serverHost> parameter to the fully-qualified domain name of the Service Manager
server.
Note: This is required to enable LW-SSO from the web tier to the server.
b. Set the <serverPort> parameter to the communications port of the Service Manager server.
c. Set the secureLogin and sslPort parameters.
n

If you do not want to configure TLS between Tomcat and the browser, set
secureLogin to false.

n

We recommend that you enable secure login in a production environment. Once
secureLogin is enabled, you must configure TLS for Tomcat. For details, see the
Apache Tomcat documentation.

d. Change the value of context parameter isCustomAuthenticationUsed to false.
e. Remove the comment tags (<!-- and -->) enclosing the following elements to enable LW-SSO
authentication.
<!-<filter>
<filter-name>LWSSO</filter-name>
<filter-class>com.hp.sw.bto.ast.security.lwsso.LWSSOFilter</filterclass>
</filter>
-->
......
<!-<filter-mapping>
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<filter-name>LWSSO</filter-name>
<url-pattern>/*</url-pattern>
</filter-mapping>
-->

f. Save the web.xml file.
3. Open the <Tomcat>\webapps\<Service Manager Web tier>\WEBINF\classes\lwssofmconf.xml file in a text editor.
4. Modify the lwssofmconf.xml file as follows:
a. Set the value of enableLWSSOFramework to true (default is false).
b. Set the <domain> parameter to the domain name of the server where you deploy your Service
Manager Web tier. For example, if your Web tier's fully qualified domain name is
mywebtier.domain.hpe.com, then the domain portion is domain.hpe.com.
Note: To use LW-SSO, your Service Manager web tier and server must be deployed in
the same domain; therefore you should use the same domain name for the web tier and
server. If you fail to do so, users who log in from another application to the web tier can
log in but may be forcibly logged out after a while.
c. Set the <initString> value to the password used to connect HPE applications through LWSSO (minimum length: 12 characters). For example, smintegrationlwsso. Make sure that
other HPE applications (for example, Release Control) connecting to Service Manager
through LW-SSO share the same password in their LW-SSO configurations.
d. In the <multiDomain> element, set the trusted hosts connecting through LW-SSO. If the
Service Manager web tier server and other application servers connecting through LW-SSO
are in the same domain, you can ignore the <multiDomain> element ; If the servers are in
multiple domains, for each server, you must set the correct DNSDomain (domain name),
NetBiosName (server name), IP (IP address), and FQDN (fully-qualified domain name) values.
The following is an example.
<DNSDomain>example.com</DNSDomain>
<NetBiosName>myserver</NetBiosName>
<IP>1.23.456.789</IP>
<FQDN>myserver.example.com</FQDN>

Note: As of version 9.30, Service Manager uses <multiDomain> instead of
<protectedDomains>, which is used in earlier versions. The multi-domain functionality is
relevant only for UI LW-SSO (not for web services LW-SSO). This functionality is based
on the HTTP referrer. Therefore, LW-SSO supports links from one application to another
and does not support typing a URL in a browser window, except when both applications
are in the same domain.
e. Check the secureHTTPCookie value (default: true).
n

If you set secureHTTPCookie to true (default), you must also set secureLogin in the
web.xml file to true (default); if you set secureHTTPCookie to false, you can set
secureLogin to either true or false. In a production environment, you are
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recommended to set both parameters to true.
n

If you do not want to use TLS, set both secureHTTPCookie and secureLogin to
false.

Here is an example of lwssofmconf.xml:
<?xml version="1.0" encoding="UTF-8"?>
<lwsso-config
xmlns="http://www.hp.com/astsecurity/idmenablmentfw/lwsso/2.0">
<enableLWSSO
enableLWSSOFramework="true"
enableCookieCreation="true"
cookieCreationType="LWSSO"/>
<webui>
<validation>
<in-ui-lwsso>
<lwssoValidation id="ID000001">
<domain>example.com</domain>
<crypto cipherType="symmetricBlockCipher"
engineName="AES" paddingModeName="CBC" keySize="256"
encodingMode="Base64Url"
initString="This is a shared secret passphrase"/>
</lwssoValidation>
</in-ui-lwsso>
<validationPoint
enabled="false"
refid="ID000001"
authenicationPointServer="http://server1.example.com:8080/bsf"/>
</validation>
<creation>
<lwssoCreationRef useHTTPOnly="true" secureHTTPCookie="true">
<lwssoValidationRef refid="ID000001"/>
<expirationPeriod>50</expirationPeriod>
</lwssoCreationRef>
</creation>
<logoutURLs>
<url>.*/goodbye.jsp.*</url>
<url>.*/cwc/logoutcleanup.jsp.*</url>
</logoutURLs>
<nonsecureURLs>
<url>.*/images/.*</url>
<url>.*/js/.*</url>
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<url>.*/css/.*</url>
<url>.*/cwc/tree/.*</url>
<url>.*/sso_timeout.jsp.*</url>
</nonsecureURLs>
<multiDomain>
<trustedHosts>
<DNSDomain>example.com</DNSDomain>
<DNSDomain>example1.com</DNSDomain>
<NetBiosName>myserver</NetBiosName>
<NetBiosName>myserver1</NetBiosName>
<IP>xxx.xxx.xxx.xxx</IP>
<IP>xxx.xxx.xxx.xxx</IP>
<FQDN>myserver.example.com</FQDN>
<FQDN>myserver1.example1.com</FQDN>
</trustedHosts>
</multiDomain>
</webui>
<lwsso-plugin type="Acegi">
<roleIntegration
rolePrefix="ROLE_"
fromLWSSO2Plugin="external"
fromPlugin2LWSSO="enabled"
caseConversion="upperCase"/>
<groupIntegration
groupPrefix=""
fromLWSSO2Plugin="external"
fromPlugin2LWSSO="enabled"
caseConversion="upperCase"/>
</lwsso-plugin>
</lwsso-config>

f. Save the lwssofmconf.xml file.
5. Open the <Tomcat>\webapps\<Service Manager Web tier>\WEBINF\classes\application-context.xml in a text editor.
6. Modify the application-context.xml as follows:
a. Add lwSsoFilter to filterChainProxy:
/**=httpSessionContextIntegrationFilter,
lwSsoFilter,anonymousProcessingFilter
Note: If you need to enable web tier LW-SSO for integrations and also enable trusted
sign-on for your web client users, add lwSsoFilter followed by preAuthenticationFilter, as
shown in the following:
/**=httpSessionContextIntegrationFilter,
lwSsoFilter,preAuthenticationFilter,anonymousProcessingFilter.
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b. Uncomment bean lwSsoFilter:
<bean id="lwSsoFilter"
class="com.hp.ov.sm.client.webtier.lwsso.LwSsoPreAuthenticationFilter">
c. Save the application-context.xml file.
7. Repack the updated Service Manager web tier files and replace the old web tier .war file
deployed in the <Tomcat>\webapps folder.
8. Restart Tomcat so that the configuration takes effect.

Step 3: Configure LW-SSO in OMi
l

In OMi:
a. Navigate to Authentication Management:
Administration > Users > Authentication Management
b. Click the Configure button under the Single Sign-On Configuration list to open the Single
Sign-On Configuration wizard.
c. In the Single Sign-On dialog, select Lightweight.
d. Paste the initString you copied above from JMX to get/set Token Creation Key (initString) to
the Token Creation String (initString).
e. Click Finish to save your configuration.
For details on configuring LW-SSO, see the OMi Administration Guide.

View Actual State in SM (RTSM)
To display the Actual State information in the SM configuration item form, do the following:
1. Log on to SM as a system administrator.
2. Click System Administration > Base System Configuration > Miscellaneous > System
Information Record.
3. Click the Active Integrations tab.
4. Select the HP Universal CMDB option.
The form displays the UCMDB web service URL field.
5. In the UCMDB web service URL field, type the URL to the Universal CMDB web service API.
The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService
6. Specify the credentials for the user you created in "Create User Accounts for the OMi-SM
Integration (RTSM)" on page 86 to access the OMi server.
7. Click Save. SM displays the message: Information record updated.
8. Log out of the SM system.
9. To verify that the setup worked, log back into the SM system with an administrator account. The
Actual State section will be available in CI records pushed from OMi.
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Event Forwarding from OMi to SM (RTSM)
OMi enables you to forward events from OMi to Service Manager, which then become incidents in
Service Manager. Subsequent event/incident changes are synchronized between Service Manager and
OMi. You can also drill down from OMi events to Service Manager incidents and vice versa.
Follow the steps below to set up an incident exchange between Service Manager and OMi.
This section includes:
l

"Step 1: Configure the Service Manager server as a connected server in OMi" below

l

"Step 2: (optional) Configure an Event Forwarding Rule " on page 97

l

"Step 3: Configure the OMi integration in Service Manager" on page 98

l

"Step 4: Configure Launch of Service Manager Incident Details from OMi" on page 103

l

"(optional) Step 5: Attribute Synchronization" on page 104

l

"Step 6: Test the Event Forwarding and Cross Launches" on page 108

l

"Advanced Configuration" on page 109

Step 1: Configure the Service Manager server as a connected
server in OMi
To synchronize events and event changes between OMi and Service Manager incidents, configure
Service Manager as a target connected server in the OMi Connected Servers manager.
To configure the Service Manager server as a target connected server, perform the following steps:
1. Navigate to the Connected Servers manager:
Administration > Setup and Maintenance > Connected Servers
2. Click the New button and select External Event Processing. The Create New Server
Connection - External Event Processing dialog box opens.
3. In the General page, in the Display Name field, enter a name for the target Service Manager
server. By default, the Name field is filled automatically. For example, if you enter Service
Manager 1 as the Display Name for the target Service Manager server, Service_Manager_1 is
automatically inserted in the Name field. You can specify your own name in the Name field, if you
want to change it from the one suggested automatically.
Note: Make a note of the name of the new target server (in this example, Service_Manager_
1). You need to provide it later as the username when configuring the Service Manager server
to communicate with the server hosting OMi.
Optional: Enter a description for the new target server.
Make sure that you select the Active check box.
Click Next to open the Server Properties page.
4. In the Server Properties page, select Service Manager System in the mandatory CI Type field.
Then, enter the Fully Qualified DNS Name of the Service Manager target server.
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Click Next to open the Integration Type page.
5. In the Integration Type page, complete the following information:
a. Select Call Script Adapter as the integration type.
b. From the Script Name menu, select the Service Manager Groovy script adapter
sm:ServiceManagerAdapter.
c. Click Next to open the Outgoing Connection page.
6. In the Outgoing Connection page, enter the credentials (user name, password, and port number)
required to access the Service Manager target server and to forward events to that server:
a. In the User Name field, enter the user name for the integration user you set up in Service
Manager.
b. In the Password field, enter the password for the user you specified. Repeat the password
entry in the Verify Password field.
c. In the Port field, specify the port configured on the Service Manager side for the integration
with OMi.
To find the port number to enter:
n

If you are using default ports in Service Manager, select or clear Use Secure HTTP as
appropriate, and then click Set default port. The port is set automatically.
Note: If you do not want to use secure HTTP, make sure that the Use secure HTTP
check box is cleared.
If the Use Secure HTTP check box is selected, download and install a copy of the
target server’s TLS certificate by using the Retrieve from Server or Import from
File link, if the certificate is available in a local file.

n

If you need to find the port number, access the following file on your Service Manager
system:
<Service Manager root directory>/HP/Service Manager
<version>/Server/RUN/sm.cfg
In the sm.cfg file, check for the sm -loadBalancer line and add the port entry at the end
of the line. The line looks similar to this:
sm -loadBalancer -httpPort:13080
Enter the appropriate value of the port used by Service Manager in the Port field of the
Outgoing Connection page.

d. Select the Enable Synchronize and Transfer Control check box.
If the Enable Synchronize and Transfer Control check box is selected, an OMi operator can
transfer ownership of the event to the target connected server by using the Transfer Control
option in the Event Browser context menu.
If it is not selected, the Synchronize and Transfer Control option is not available from the
Event Browser context menu or from the list of forwarding types for configuring forwarding
rules.
e. Test the connection by clicking the Test Connection link in the upper center of the dialog box.
A Success or ERROR hyperlink is displayed. Click the link to get a more detailed message.
f. Click Next to open the Event Drilldown page.
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7. If you want to drill down into Service Manager, in addition to automatically generating Service
Manager incidents from OMi events, you need to specify the fully qualified DNS name and port of
the Service Manager system into which you want to perform the incident drill down.
Note: To enable incident drill down to Service Manager, you must install a web tier client for
your Service Manager server according to your Service Manager server installation or
configuration instructions.
In the Event Drilldown page, configure the server where you installed the web tier client
along with the configured port used.
If you do not specify a server in the Event Drilldown page, it is assumed that the web tier
client is installed on the server used for forwarding events and event changes to SM, and
receiving event changes back from Service Manager.
If nothing is configured in the Event Drilldown dialog box, and the web tier client is not
installed on the Service Manager server machine, the web browser will not be able to find the
requested URL.
Select or clear the Use Secure HTTP check box according to your configuration.
Click Next to open the Incoming Connection page.
8. To enable event changes to be synchronized back from Service Manager to OMi, you must
provide credentials for the Service Manager server to access the server hosting OMi.
a. In the Incoming Connection page, select the Accept event changes from external event
processing server check box, and then enter a password that the Service Manager server
requires to connect to the server hosting OMi.
Note: Make a note of this password. You need to provide it later when configuring the
Service Manager server to communicate with the server hosting OMi. This password is
associated with the user name (Service_Manager_1) you configured in Service Manager.
If Enable Synchronize and Transfer Control was previously selected, the Accept
event changes from external event processing server option is assumed and cannot
be disabled.
b. Click Finish. The target Service Manager server appears in the list of Connected Servers.
9. If you have SM 9.34 or higher, perform the following additional steps:
a. Reopen the Service Manager connected server that you configured in the previous steps. To
do so, double-click the connected server entry in the connected servers list.
b. Copy the ID of the connected server (displayed in the lower right corner of the General tab)
and save it. You need to specify this ID as omi.mgr.id on the Service Manager system.
An example of a connected server ID is as follows:
ID: 22f42836-fd36-473e-afc9-a81290f4f73b

Step 2: (optional) Configure an Event Forwarding Rule
Once you have configured the Service Manager server as a connected server in OMi, you can forward
events manually by using Transfer Control To from the Context Menu. If you want to automatically
forward events, you can configure an Event Forwarding Rule for the OMi server.
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1. Open the Event Forwarding manager:
Administration > Event Processing > Automation > Event Forwarding
2. In the Event Forwarding Rules pane, click the
Event Forwarding Rules dialog box.

New Item button to open the Create New

3. Enter a display name, and (optional) a description of the event forwarding rule being specified.
4. Select Active. A rule must be active in order for its status to be available in Service Manager.
5. Select an event filter for the event forwarding rule from the Events Filter list. The filter determines
which events to consider for forwarding.
Filters for Event Forwarding Rules can screen events based on the following date-related event
attributes which, for example, help you to ignore outdated events:
o

Time Created

o

Time Received

o

Time Lifecycle State Changed

4. If no appropriate filter is already configured, create a new filter as follows:
a. Click the
New Item button to open the Filter Configuration dialog box. You can choose
between New Simple Filter or New Advanced Filter.
b. In the Display Name field, enter a name for the new filter, in this example, FilterCritical.
Clear the check boxes for all severity levels except for the severity Critical.
Click OK.
c. You should see your new filter in the Select an Event Filter dialog box (select it, if it is not
already highlighted).
Click OK.
6. Under Target Servers, select the target server you configured in the previous step on connecting
servers. Click the Add button next to the target servers selection field. You can now see the
connected server's details. In the Forwarding Type field, select the Synchronize and Transfer
Control forwarding type. Although other selections are technically possible, only Synchronize and
Transfer Control is supported by Service Manager.

Step 3: Configure the OMi integration in Service Manager
Service Manager can integrate with more than one OMi server. To configure more than one server, first
complete "Configure the Instance Count in the Service Manager-OMi integration template" below
before adding integration instances. To proceed with the default of one server, skip to "Add an SMOMi
integration instance for each OMi server" on the next page.

Configure the Instance Count in the Service Manager-OMi integration template
To integrate Service Manager with more than one OMi server, configure the Instance Count setting in
the SMOMi integration template, as described below.
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1. Log on to Service Manager as a system administrator.
2. Type db in the command line, and press Enter.
3. In the Table field, type SMISRegistry, and click Search.
The SMIS integration template form opens.
4. Click Search.
A list of SMIS integration templates opens.
5. Select SMOMi from the list.
6. In the Instance Count field, change the value of 1 to the number of OMi servers that you want to
integrate with Service Manager. For example, if you need two OMi servers, change the value to 2.
7. Click Save.

Add an SMOMi integration instance for each OMi server
Once you have completed configuration in OMi, you are ready to add and enable a separate integration
instance in Service Manager for each OMi server.
To add and enable an Incident Exchange (OMi - SM) integration instance:
1. Log on to Service Manager as a system administrator.
2. Click Tailoring > Integration Manager.
3. Click Add.
The Integration Template Selection wizard opens.
4. Select SMOMi from the Integration Template list.
Note: Ignore the Import Mapping check box, which has no effect on this integration.
5. Click Next.
6. Complete the integration instance information:
o

Modify the Name and Version fields to the exact values you need.

o

In the Interval Time (s) field, enter a value. For example: 600. If an OMi opened incident fails
to be synchronized back to OMi, Service Manager will retry the failed task at the specified
interval (for example, 600 seconds).

o

In the Max Retry Times field, enter a value. For example: 10. This is the maximum allowed
number of retries for each failed task.

o

(Optional) In the SM Server field, specify a display name for the Service Manager server host.
For example: my_Local_SM.

o

(Optional) In the Endpoint Server field, specify a display name for the OMi server host. For
example: my_OMi_1.

o

(Optional) In the Log File Directory field, specify a directory where log files of the integration
will be stored. This must be a directory that already exists on the Service Manager server host.
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o

(Optional) In the Log Level field, change the log level from INFO (default) to another level. For
example: WARNING.

o

(Optional) If you want this integration instance to be automatically enabled when the Service
Manager Server service is started, select Run at system startup.

7. Click Next. The Integration Instance Parameters page opens.
8. On the General Parameters tab, complete the following fields as necessary:
Field

Sample Value

Description

omi.server.url

http://<servername>:oprgateway/rest/synchronization/event

This is the URL address of the
OMi server's RESTful web
service. Replace
<servername> with the fully
qualified domain name of your
OMi server.

http.conn.timeout

30

The HTTP connection timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds), and
15 (seconds) is used if this
field is empty.

http.rec.timeout

30

The HTTP receive timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds), and
15 (seconds) is used if this
field is empty.

http.send.timeout

30

The HTTP send timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds), and
15 (seconds) is used if this
field is empty.
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Field

Sample Value

Description

sm.mgr.id

55436DBE-F81E-4799-BA0565DE9404343B

The Universally Unique
Identifier (UUID) automatically
generated for this instance of
Service Manager.
Note: This field is
automatically completed
each time when you add
an SMOMi integration
instance. Do not change
it, otherwise the
integration will not work
properly.

omi.reference.prefix

urn:x-hp:2009:opr:

The prefix of the BDM External
Process Reference field,
which will be present in
incoming synchronization
requests from the OMi server.
Note: This field is
automatically completed
and has a fixed value. Do
not change it.

sm.reference.prefix

urn:x-hp:2009:sm:

The prefix of the BDM External
Process Reference field,
which will be present in
outgoing synchronization
requests from Service
Manager.
Note: This field is
automatically completed
and has a fixed value. Do
not change it.

omi.eventdetail.baseurl http://<servername>/oprconsole/opr-evtdetails.jsp?eventId=

The basic URL address of the
event detail page in OMi.
Replace <servername> with
the fully qualified domain name
of your OMi server.

9. On the General Parameters and Secure Parameters tabs, enter three parameter values that you
specified when configuring the Service Manager server as a connected server in OMi. The
following table lists the parameters, whose values you can copy from your OMi server.
To copy the parameter values from OMi, follow these steps:
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a. Log on to OMi as a system administrator.
b. Navigate to Admin > Operations Management > Setup > Connected Servers.
c. Locate your Service Manager server configuration entry and double-click anywhere on the
entry pane.
d. On the General tab, copy the ID string at the bottom into the omi.mgr.id field in Service
Manager.
e. On the Incoming Connection tab, copy the User Name and Password to the username
and Password fields in Service Manager, respectively.

Field
omi.mgr.id
(on the
General
Parameters
tab)

Sample
Value

Description

f3832ff4The Universally Unique Identifier (UUID) automatically
a6b9-4228generated in OMi for the target Service Manager server.
9fedNote: This parameter was introduced to support multiple
b79105afa3e4
OMi servers. Service Manager uses the UUID to identify
from which OMi server an incident was opened. Be aware
that if you delete the connected server configuration for the
Service Manager server in OMi and then recreate the same
configuration, OMi generates a new UUID. You need to
reconfigure the integration instance by changing the old
UUID to the new one.
Tip: If you have only one OMi server, you can simply
remove this parameter (remove both the parameter name
and value) from the integration instance.

username
SM_Server
omi.mgr.id
(on the
General
Parameters
tab)

This is the user name that the Service Manager server uses to
synchronize incident changes back to the OMi server.

Password
SM_Server_
(on the
Password
Secure
Parameters
tab)

This is the password that the Service Manager server uses to
synchronize incident changes back to the OMi server.

10. Click Next twice, and then click Finish.
Note: Leave the Integration Instance Mapping and Integration Instance Fields settings blank.
This integration does not use these settings.
Service Manager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.
11. Enable the integration instance.
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12. If you have multiple OMi servers, repeat the steps above for the rest of your OMi servers.

Step 4: Configure Launch of Service Manager Incident Details from
OMi
If you want to be able to drill down to Service Manager incidents from the OMi Event Browser, you need
to configure the Service Manager web tier in the sm:ServiceManagerAdapter script in OMi.
1. Navigate to Connected Servers in OMi:
Administration > Setup and Maintenance > Connected Servers
Click the Manage Scripts icon.
2. Select the sm:ServiceManagerAdapter script, and click the Edit Item button.
3. Click the Script tab and locate the following text in the Groovy script:
private static final String SM_WEB_TIER_NAME = 'webtier-9.30'
4. Change the value of webtier-9.30 to the value required to access the Service Manager web tier
client.
The drill-down URL is made up like this:
http://<FQDN of Service Manager web tier server>/<web path to Service
Manager>/<URL query parameters>
In this instance, <FQDN of Service Manager web tier server> is the fully qualified DNS
name of the Service Manager server where the web tier client is installed. This part of the URL is
added automatically (together with http:// or https://) according to the values that you
provided when you configured Service Manager as a target connected server in the Connected
Servers manager. The address of the Event Drilldown page of the Connected Server makes up the
rest of the URL. For details, see the previous step on connecting servers.
An example of a drill-down URL:
http://smserver.example.com/SM930/index.do?ctx=docEngine&file=probsummary&query
=number%3D%22IM10216%22&queryHash=bf52f465
In this example, you need to replace webtier-9.30 with SM930. All the other parts of the URL are
configured automatically.
5. When finished editing, save the new version of the script. Note that the script can always be
reverted to its original version.
For details, see the OMi Administration Guide.
6. If you are using SM 9.34 or lower, set the values of the querysecurity parameter and the
querySecurity Web parameter from the default values (true) to false in the SM web tier
configuration file web.xml.
For details about the querysecurity parameter and the querySecurity Web parameter, see
Service Manager Online Help.
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(optional) Step 5: Attribute Synchronization
Attribute Synchronization Using Groovy Scripts
When the SM incident is initially created from an OMi event, event attributes are mapped to the
corresponding SM incident attribute. Out of the box, after the initial incident creation, whenever the
incident or event subsequently changes, only a subset of the changed event and incident attributes are
synchronized. The following describes how to customize the list of attributes to synchronize upon
change. If you want to change the out-of-the-box behavior regarding which attributes are updated, you
can specify this in the Groovy script used on the OMi side for synchronization or incident creation. In
the Groovy script, you can specify which fields are updated in SM, and which fields are updated in OMi.
You can also specify custom attributes in the Groovy script.

Bidirectional Synchronization of Attributes
Individual OMi event attributes can be synchronized from an OMi event to the corresponding SM
incident, whenever the event is changed in OMi. Similarly, individual SM incident attributes can be
synchronized from an SM incident to the corresponding event in OMi, every time the event is changed
in SM. To change the attributes that are synchronized from an OMi event to a corresponding SM
incident, change the attributes included in the SyncOPRPropertiesToSM list in the Groovy script. To
change the attributes that are synchronized from an SM incident to an OMi event, change the attributes
included in the SyncSMPropertiesToOPR list in the Groovy script. By default, the state, solution, and
cause attributes are synchronized from OMi events to their corresponding SM incidents, and the
incident_status and solution attributes are synchronized from an SM incident to the corresponding
OMi event.
To enable synchronization of all attributes in both directions, you can set the SyncAllProperties
variable to true. In this case, all other variables will be ignored.
Example:
l

private static final Set SyncOPRPropertiesToSM = ["state", "solution", "cause"]

l

private static final Set SyncSMPropertiesToOPR = ["incident_status", "solution"]

The following table lists the OMi event attributes that can by synchronized with an SM incident, and the
matching SM incident attributes that can be synchronized with an OMi event:
OMi event attribute SM incident attribute
title

name

description

description

state

incident_status

severity

urgency

priority

priority

solution

solution
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Unidirectional Synchronization of Attributes
The assigned_user, assigned_group, and cause event properties can be synchronized from an OMi
event to a corresponding SM incident. To synchronize these attributes, add them to the
SyncOPRPropertiesToSM list in the groovy script.
Example:
l

private static final Set SyncOPRPropertiesToSM = ["assigned_user", "assigned_
group", "cause"]

Individual OMi event properties can be synchronized to a corresponding SM incident Activity Log.
Updates are not synchronized back from the SM incident Activity Log to the corresponding OMi event.
To change the properties that are synchronized, add the desired properties to the
SyncOPRPropertiesToSMActivityLog list in the Groovy script. By default, the title, description,
state, severity, priority, annotation, duplicate_count, cause, symptom, assigned_user, and
assigned_group properties are synchronized.
Example:
l

private static final Set SyncOPRPropertiesToSMActivityLog = ["title",
"description", "priority"]

The following list includes all properties that can by synchronized from OMi events to the SM incident
Activity Log:
l

title

l

description

l

state

l

severity

l

priority

l

solution

l

annotation

l

duplicate_count

l

assigned_user

l

assigned_group

l

cause

l

symptom

l

control_transferred_to

l

time_state_changed

Custom Mappings for Custom Attributes
You can define your own mappings for custom attributes between OMi and SM. These mapping can be
either unidirectional, if the attributes are only contained in one map, or bidirectional, if the attributes are
contained in both maps. To create custom mappings for custom attributes, you can edit the
MapSM2OPRCustomAttribute and MapOPR2SMCustomAttribute lists in the Groovy script. These maps
are empty by default.
Example:
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l

l

private static final Map <String, String> MapSM2OPRCustomAttribute =
[“MySMAttribute” : “MyOMiCustomAttribute”]
private static final Map <String, String> MapOPR2SMCustomAttribute = [
“MyOtherOMiCustomAttribute” : “MyOtherSMAttribute”, “MyThirdOMiCA”, “activity_
log”]

Mapping OPR Lifecycle States to BDM Lifecycle States
Individual OPR event state and SM incident status changes may be selected for synchronization. Out
of the box, only the "closed" state is synchronized in both directions. To change this behavior, add the
desired states to the appropriate list, SyncOPRStatesToSM or SyncSMStatusToOPR.
Examples:
l

l

private static final Set SyncOPRStatesToSM = ["closed", "in_progress",
"resolved"]
private static final Set SyncSMStatusToOPR = ["closed", "resolved"]

In the example, the OPR event lifecycle states closed, in_progress, and resolved are synchronized
to the SM incident status, and SM incident statuses closed and resolved are synchronized to the
OPR event state.
Note: The special state "*" denotes all states, so to synchronize all OPR event states to the SM
incident status property, specify the following:
private static final Set SyncOPRStatesToSM = ["*"]
Additionally, two maps are used to specify the mapping of the OPR event lifecycle state to the BDM
incident status. The maps are named MapOPR2SMStatus and MapSM2OPRState. Out of the box, all
possible states have a mapping.
Examples:
l

l

private static final Map MapOPR2SMStatus = ["open": "open", "in_progress": "workin-progress", "resolved": "resolved", "closed": "closed"]
private static final Map MapSM2OPRState = ["accepted": "open", "assigned":
"open", "open": "open", "reopened": "open",
"pending-change": "in_progress", "pending-customer": "in_progress", "pendingother": "in_progress",
"pending-vendor": "in_progress", "referred": "in_progress", "suspended": "in_
progress",
"work-in-progress": "in_progress", "rejected": "resolved", "replaced-problem":
"resolved",
"resolved": "resolved", "cancelled": "resolved", "closed": "closed"]

Tips for customizing Groovy Scripts
This section provides some tips about customizing Groovy scripts. It contains a few selected
examples of what you can customize. To see further items that can be modified, see the configuration
section of a Groovy script.
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In the configuration section of the Groovy script, you can define and modify the attributes that are to be
synchronized between OMi and SM. The configuration section of the Groovy script also contains the
default value mappings for lifecycle state, severity, and priority. You can also modify these, and it is
possible to define the mappings for in-going and out-going requests differently.
More advanced configuration can be done in other parts of the Groovy script if required.
The beginning and the end of the configuration section of the Groovy script is marked as follows:
//
//*BEGIN Configuration: Customization of properties for synchronization*
//
...
...
//
// *END Configuration: Customization of properties for synchronization*
//

Note: Modifications to Groovy scripts are not overwritten by patches and hotfixes. Your
customized version of a script will remain after an update or a patch. If you want to use the newer
version of a script, make a copy of your version, revert back to the predefined version, and then
reapply your changes.
The mapping from OMi to SM is compliant to BDM 1.1 incident web service specifications. The
mapping of the BDM 1.1 incident web service to SM is specified in SM in the BDM Mapping Manager.
For more information about the BDM Mapping Manager, see Service Manager Online Help.

Avoiding Errors with Large TQL Queries
If the Groovy script executes a TQL query that produces a large number of results, an error message
appears informing you about the TQL query result exceeding the size limit. As a consequence, the
integration event is not sent. It is possible, however, to increase this limit by modifying the value of the
tql.compound.link.max.visited.objects setting.
Note: To check the default value of the tql.compound.link.max.visited.objects setting, from
the JMX console, select UCMDB:service=Settings Services, and then locate the
showSettingsByCategory method and enter TQL Settings as the category name.
To modify the value of the tql.compound.link.max.visited.objects setting, follow these steps:
1. From the JMX console, select UCMDB:service=Settings Services.
2. Click setSettingValue.
3. Enter tql.compound.link.max.visited.objects as the name of the setting you want to modify
and a new value for it.
Caution: Increasing the value of the tql.compound.link.max.visited.objects setting also
increases the load on the RTSM. Therefore, make sure to carefully consider how much to increase
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this value.

Syntax Errors
The ServiceManagerAdapter Groovy script uses the Apache Wink client to communicate with
Service Manager. It therefore will throw a ClientWebException when there is an HTTP error status
returned by Service Manager.
If you get a syntax error when customizing your Groovy scripts, you will get an event in the event
browser with a detailed description of the error. In addition, you may view the opr-event-syncadapter.log log file for information about how to resolve the error. You can find this log file at the
following location:
<Gateway Server root directory>/log/opr-scripting-host/opr-event-sync-adapter.log

Step 6: Test the Event Forwarding and Cross Launches
To test the event forwarding, forward an event manually to SM and then verify that the event is
forwarded to SM as expected, and that the cross launches work in both directions.
1. Open an OMi Event Browser.
2. Select an event and select Transfer Control To in the Context Menu. Select the SM target
system.
3. Select the Forwarding tab.
4. In the External Id field, you should see a valid SM incident ID after a few seconds.
5. Verify that the incident appears in the Incident Details in Service Manager by using the cross
launch (see next step).
If the event drill-down connection is not configured, verify the forwarding by using the following:
a. In the Forwarding tab in the OMi Event Browser, copy or note the incident ID from the External
Id field.
b. In the Service Manager user interface, navigate to:
Incident Management > Search Incidents
c. Paste or enter the incident ID in the Incident Id field.
d. Click the Search button. This takes you to the incident in the Incident Details.
6. Test the cross launch from OMi to SM:
Click the hyperlink created with the incident ID. A browser window opens, which takes you
directly to the incident in the Incident Details in Service Manager.
7. Test the cross launch from SM to OMi:
In the Incident Details in Service Manager, click More and then select View OMi Event. A
browser window opens, which takes you directly to the event in the Event Browser in OMi.
Note: The View OMi Event option displays only when the omi.mgr.id parameter in the
corresponding SM-OMi integration instance is set correctly.
8. Close the incident in Service Manager.
9. Verify that the change in the state of the incident (it is now closed) is synchronized back to OMi.
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You should not be able to see the event that was closed in SM in the active Event Browser, but it
should now be in the Closed Events Browser.

Advanced Configuration
Configure forwarding of affected business services from OMi to SM
Service Manager versions 9.40 and higher support the display of multiple affected business services
associated with an event in OMi. By default, when an event is created in OMi that affects more than
one business service CI, all affected services are automatically forwarded to SM. The most critical
service is displayed on the "Primary Service" tab in SM, and all other affected services are displayed
on the "Impacted Services" tab.
If you only want to forward the most critical affected service associated with an event from OMi to SM,
you can change the ForwardAllAffectedBusinessServices flag in the sm:ServiceManagerAdapter
script to false.
1. Navigate to Connected Servers in OMi:
Administration > Setup and Maintenance > Connected Servers
Click the Manage Scripts icon.
2. Select the sm:ServiceManagerAdapter script, and click the Edit Item button.
3. Click the Script tab and search for ForwardAllAffectedBusinessServices. Change the value to
false.
4. When finished editing, save the new version of the script. Note that the script can always be
reverted to its original version. For details, see the OMi Administration Guide.

Configure automatic closure for OMi incidents in SM
Incidents created from OMi events will be automatically closed when the corresponding OMi event is
closed. You can also configure SM incidents created from OMi events to be automatically closed after
a predefined amount of time since they were last updated (or resolved if they have not been updated
after being resolved).
The workflow is as follows:
1. An incident is opened from OMi.
2. If the Schedule Condition is met, the system creates a schedule record for the incident. The
schedule record will expire at a future time based on the Calc Expression.
3. A user updates the incident and saves the changes.
4. The Reset alerts if expression on the Alerts tab of the probsummary object definition is
evaluated. If it evaluates to true, the Expiration time of the schedule record is updated based on
the Calc Expression. By default, the expiration time of the schedule record is updated only when
the incident has a category of incident.
5. When the schedule record expires, the Alert Condition is evaluated. If it evaluates to true, the
incident is automatically closed.
To enable automatic closure for OMi incidents:
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1. Configure the global settings in the Incident Management Environment record.
a. In SM versions lower than 9.40, click System Administration > Ongoing Maintenance >
Environment Records > Incident Management Environment.
In SM versions 9.40 and higher, click Incident Management > Administration >
Environment.
b. Change the following settings as necessary.
Field

Value

Close Incident
Automatically?

This option disables or enables the automatic closure of OMi incidents
at the global level.
n If this option is not selected, no incidents will be automatically
closed.
If this option is selected, incidents will be automatically closed
under specified conditions.
Default: Not selected
n

Closure Code

This value will be copied to the Closure Code field of incidents when
they are automatically closed.
Default: Automatically Closed

Solution

This description will be appended to the end of the Solution field of
incidents when they are automatically closed.
Default: This incident which belongs to OMi has been closed
automatically.

c. Click Save.
d. Restart the Service Manager server.
Note: If you have made any changes to any of the configuration options in the Incident
Management Environment record, the Service Manager server must be restarted for the
changes to take effect.
2. Configure the alert definition that determines when an incident should be closed.
Note: The alert and problem processes must be running to enable the successful closure of
OMi incidents.
a. Click Tailoring > Document Engine > Alerts.
b. In the Alert Name field, enter: OMI Auto-Close.
c. Click Search. The OMiAuto-Close alert definition detail form opens.
Caution: These fields in the alert definition are used to control automatic closure of OMi
incidents. You can change the default values of these fields. However, you must be
aware of the risk that automatic closure of OMi incidents will not work properly if the
Schedule Condition and Alert Condition fields are not configured correctly.
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Field

Value

Schedule
Condition

This expression is used to determine if an incident should be scheduled for
automatic closure.
Default: jscall("SMOMi.isAutoCloseAndResolved").
An incident is scheduled for automatic closure when the following conditions
are met.

Alert
Condition

n

The Close Incident Automatically? option in the Incident Management
Environment record is selected.

n

In the incident record, the Do not close this incident automatically
option is not selected.

n

The incident has a status of Resolved.

This expression is evaluated when an incident is about to be automatically
closed. If it evaluates to true, the incident is closed.
Default: jscall("SMOMi.isAutoCloseEnabled").
An incident is closed when the following conditions are met.
n

The Close Incident Automatically? option in the Incident Management
Environment record is selected.

n

In the incident record, the Do not close this incident automatically
option is not selected.

Calc
This expression is used to determine how much time will elapse before an
Expression incident is automatically closed.
Default: $L.alert.time=update.time in $L.file+'7 00:00:00'.
The default value means the amount of time elapsed is equal to seven days
since the incident was last updated.
3. Configure alert information in the probsummary object.
The OMi autoclose alert definition is configured to only be used by OMi incidents. The closure time
is reset each time the incident is updated. If the closure time is reached without the incident being
updated then Service Manager will automatically close the incident.
a. Click Tailoring > Document Engine > Objects.
b. In the File name field, enter probsummary and press ENTER. The probsummary object
definition is displayed.
c. Select the Alerts tab.
The Reset alerts if expression is used to reset the automatic closure time of OMi incidents.
Default: category in $L.file="incident" and not null(1 in
external.process.reference in $L.file).

Configure TLS for the Incident Exchange integration
When OMi is configured to accept https connections only, you must configure TLS for the integration. If
you do not do so, changes on an incident that is created from OMi cannot be synchronized back to OMi.
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Note: The following steps describe how you do so by using the built-in keytool in Service Manager,
and the file paths are for Windows only. Be sure to change the file paths accordingly if your Service
Manager system is running on Unix.
To configure TLS for the integration, follow these steps:
1. Import the OMi root certificate to the Service Manager server trusted keystore.
The following is an example of the command line:
<SM Install path>\server\RUN\jre\bin\keytool -import -alias myCA -file <.pem
file of your BSM root certificate> -keystore <SM Install
path>\Server\RUN\jre\lib\security\cacerts -storepass <changeit>
Note: Where: changeit is the default password of the trusted keystore. Change it to your own
password if you have changed it.
2. Add the following parameters to the Service Manager server configuration file (<SM install
path>\Server\RUN\sm.ini):
truststoreFile:<SM install path>\Server\RUN\jre\lib\security\cacerts
truststorePass:<changeit>
3. Restart the Service Manager Server service.

Downtime Forwarding from Service Manager to OMi
(RTSM)
You can create downtimes (also known as outages) in OMi based on Requests for Changes (RFCs) in
SM. This is done in two steps. First, scheduled downtime CIs are created in OMi based on RFCs in
SM. Then, a BSM downtime CI is created based on the scheduled downtime.
You can also send downtime start and end information from OMi to SM to notify operators of when a
downtime occurs, especially if the downtime was not driven by an RFC in SM. For more information on
this integration, see "Sending downtime notifications from OMi to SM (RTSM)" on page 119
Notes:
1. For Changes/Tasks that have final approval phases defined in Service Manager Integration
Suite (SMIS), the downtimes will be synchronized after the Changes/Tasks get final
approval.
2. Only downtimes that end at a future time will be synchronized.
3. Select the Configuration Item(s) Down checkbox when scheduling downtimes in
Changes/Tasks.
4. The SLA scheduler needs to be started in the System Status form.
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Step 1: Add an SMBSM_DOWNTIME integration instance in SM
To set up the integration from Service Manager to OMi, you must add an instance of this integration in
the Service Manager Integration Suite (SMIS). Note that additional setup is required on the OMi side for
integration from OMi to Service Manager.
To add the SMBSM_DOWNTIME instance:
1. Click Tailoring > Integration Manager. Integration Instance Manager opens.
2. Click Add. The Integration Template Selection wizard opens.
3. Select SMBSM_DOWNTIME from the Integration Template list. Ignore the Import Mapping
check box, which has no effect on this integration.
4. Click Next. The Integration Instance Information page opens.
5. Do the following:
o

Modify the Name and Version fields to the exact values you need.

o

In the Interval Time(s) field, enter a value based on your business needs in regard to downtime
exchange frequency. Note that a short interval time can be safe because the next scheduled
task will not start until the previous task is completed and the interval time passed.

o

In the Max Retry Times field, enter a value. This is the maximum allowed number of retries (for
example, 10) for each failed task.

o

In the Log File Directory field, specify a directory where log files of the integration will be
stored. This must be a directory that already exists on the Service Manager server. By default,
logging message is output to sm.log.

o

(Optional) In the SM Server field, specify a display name for the Service Manager server host.
For example: my_local_SM.

o

(Optional) In the Endpoint Server field, specify a display name for the OMi server host. For
example: my_BSM_1.

o

(Optional) In the Log Level field, change the log level from INFO (default) to another level. For
example: WARNING.

o

(Optional) If you want this integration instance to be automatically enabled when the Service
Manager Server service is started, select Run at system startup.

6. Click Next. The Integration Instance Parameters page opens.
7. On the General Parameters tab, complete the following fields as necessary:
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Name

Category Value

WithdrawDowntime General

true/false

Description
Set this value to true: When authorized users
are manually changing the phase of a change
record which has 'valid' outage, a window will
open and provide choices of withdrawing the
outage.
Set this value to false: The pop-up window is
disabled. This operation may cause some
unapproved planned downtimes be
synchronized to OMi.
By default, this value is set to true.

Category or
workflow (Process
Designer) name of
changes

Change

The final
approval
phase for
changes

Set the final approval phase for downtime,
which is the indication of valid downtime
information.

Category or
workflow (Process
Designer) name of
tasks

Task

The final
approval
phase for
tasks

Set the final approval phase for downtime,
which is the indication of valid downtime
information.

sm.host

General

<sm server
name >

Set the Service Manager server host name or
DNS name to compose the External Process
Reference and the Reference Number of
Scheduled Downtime CI in UCMDB.
Note: Do not include a colon in this field.
Otherwise, the logic will be broken.

sm.reference.prefix

General

urn:xSet the prefix to compose the External
hp:2009:sm Process Reference of Scheduled Downtime
CI in UCMDB.
Note: This field has a fixed value. Do not
change it.

Notes:
a. Type category or workflow name of change/task in the Name column. This value is casesensitive and it must match the record in Service Manager database.
b. Set the value to Change for changes in the Category column. Similarly, set the value to
Task for tasks.
c. Type the final approval phase in the Value column. This value is case-sensitive and it
must match the record in Service Manager database. You can separate multiple phases
by semicolons, which must be the English character.
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d. Detailed information will be displayed in the integration log when the following errors
occur:
n User input of categories/phases for the changes/tasks is not correct.
n

The category and phase pair does not exist in the database.

e. For Change Management categories which do not have approval phase, the downtime
integration will treat its downtime information as final approved once created. You do not
need to define any phases in SMIS parameters.
f. For the category or workflow name of the changes and the tasks, the integration will
ignore all the final phases defined for the redundant category or workflow.
8. Click Next twice and then click Finish. Leave the Integration Instance Mapping and Integration
Instance Fields settings blank. This integration does not use these settings.
Service Manager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.
9. Enable the integration instance. SMIS will validate all the final phases you filled in the Integration
Instance Parameters page and print warning messages if there are errors.

Step 2: Tailor Service Manager to handle phase change
In the Service Manager Change Management module, authorized users can manually change the
phase of a change record. If the phase is changed to the one prior to the final approval phase in the
SMBSM_DOWNTIME instance, the system will check if there are existing planned downtimes that
have been set to Ready. If such downtimes exist, a window will open and provide two options for the
corresponding planned downtimes:
l

l

Click Yes to withdraw the corresponding planned downtimes from the RTSM. The changes or tasks
need to be approved again to synchronize with the RTSM at another time.
Click No. There will be no change to the planned downtimes even if the actual status of the changes
or tasks are not approved.
Note: To disable the pop-up window when withdrawing the planned downtimes, you must set the
WithdrawDowntime parameter to false in the SMBSM_DOWNTIME instance. This operation
may cause some unapproved planned downtimes to be synchronized to OMi.

With Process Designer (PD) Content Pack 2 applied in Service Manager, you can tailor the process to
transit changes or tasks from one phase that is after the final approval phase in the SMBSM_
DOWNTIME instance to another that is prior to the final approval phase. To withdraw the related
planned downtime for this kind of transition, you need to add a rule set for the transition in the Closed
Loop Incident Process (CLIP) solution. Follow these steps:
1. Go to the target workflow that needs tailoring.
2. Select the transition that moves a phase from before the final approval phase to after the final
approval phase.
3. In the Rule Sets section, click Add and select the clip.downtime.withdraw rule set.
4. Click OK to save the workflow.
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Step 3: Set up downtime sync jobs in OMi
As part of CI synchronization, you have already set up an integration point between SM and OMi. In
this step, you add downtime synchronization jobs, so that scheduled downtime CIs are created in OMi
based on Requests for Change in SM.
To add the downtime synchronization jobs:
1. Log in to your OMi system as an administrator.
2. Edit the existing integration point that connects to your Service Manager server.
3. Click Administration > RTSM Administration> Data Flow Management > Integration
Studio. OMi displays a list of integration points.
4. Select the existing SM integration point. Make sure that CIs have already been synchronized
between SM and OMi.
5. Create two integration jobs in the integration point on the Population tab:
a. Create a new job including the SM CLIP Down Time Population job definition. Under
Scheduler Definition, select the Scheduler enabled checkbox and set the Repeat Interval
to 1 Minute. Click OK to save the job.
b. Create another new job including the SM CI Connection Downtime CI job definition. Under
Scheduler Definition, select the Scheduler enabled checkbox and set the Repeat Interval
to 1 Minute. Click OK to save the job.
Pay attention to the running order. The CLIP Down Time Population job must be run first. You
can set the two jobs as schedule-based and set the schedule interval according to your needs.
Note: If no related CIs exist in RTSM when creating relationships, the population will fail or
succeed with a warning. To disable the warning, remove the downtime CI that does not have
related CIs in RTSM.

Step 4: Set up creation of BSM Downtime CIs
In this step, BSM Downtime CIs are created based on Scheduled Downtime CIs.
Important:
l

Following the initial integration, a large amount of data may be communicated from SM to OMi. It is
highly recommended that you perform this procedure during off-hours, to prevent negative impact on
system performance.

To create BSM Downtime CIs:
1. Create a new Integration Point or, if existing, edit the SM Scheduled Downtime Integration Into
BSM Integration Point:
a. Do the following on your OMi system.
Go to:
Administration > RTSM Administration > Data Flow Management > Integration Studio
b. Click New Integration Point or Edit, enter a name and description of your choice, and select
the adapter SM Scheduled Downtime Integration Into BSM from the Service Manager
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folder.
If you have upgraded from an older version of OMi to OMi 10.10, you may still see the old
"BSM Downtime Adapter", or you may see the "SM Scheduled Downtime Integration Into
BSM" adapter in the Third Party Products folder (not in the Service Manager folder). In this
case, you must upgrade your adapter by doing the following:
i. Open the Package Manager.
ii. Deploy the package: /opt/hp/BSM/odb/conf/factory_
packages/BSMDowntimeAdapter.zip on the data processing server.
iii. You should now find the SM Scheduled Downtime Integration Into BSM adapter in
the Service Manager folder.
c. Enter the following information for the adapter: OMi GW or Lolad Balancer/Reverse Proxy
FDQN and port (80/44), communication protocol (http/https), and the context root (if you have
a non-default context root).
d. Specify the credentials for the OMi system. The specified user must have administrative
rights in the RTSM. Choose generic protocol as protocol.
e. Click OK, then click the Save button above the list of the integration points.
2. You can use the Statistics tab in the lower pane to track the number of downtimes that are created
or updated. By default, the integration job runs every minute. If a job has failed, you can open the
Query Status tab and double-click the failed job to see more details on the error.
If there is an authentication error, verify the OMi credentials entered for the integration point.
If you receive an unclear error message with error code, this generally indicates a communication
problem. Check the communication with OMi.
A failed job will be repeated until the problem is fixed.

Step 5: Verify the SM-OMi downtime synchronization setup
When you have set up the Downtime integration, you can perform the following tasks to see if you have
successfully set up your downtime synchronization.

Task 1. Open a new change of a category that has the final
approval phase defined in SMIS
1. Click Change Management > Create New Change.
2. Select Hardware for example.
3. In the Affected CI field, choose a CI that has been synchronized. For example: adv-afr-desk101.
4. Set Scheduled Downtime Start and Scheduled Downtime End to a future time.
5. Select the Configuration Item(s) Down checkbox.
6. Set other required fields.
7. Click Validation Accepted. If you are prompted to fill in more required fields, supply the required
information and click Validation Accepted again.
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8. Click Request Authorization.
9. Click Save&Exit the change.

Task 2. Approve the change at the final approval phase
1. Click Change Management > Task Queue.
2. Search for the task that was created in Task 1 and click Close to close the task.
3. Click Change Management > Search Change and search for the change opened in Task 1.
4. Move the Change to the Change Approval phase by selecting Request Authorization.
5. Log on to Service Manager with user account Change.Approver.
6. Select Approval Inbox and search for the change created in Task 1.
7. Approve the change.

Task 3. Create new format for the intClipDownTime table
1. Open the SM Windows client.
Note: This step can only be performed in the SM Windows client.
2. Enter fd into the search field to open the Forms Designer and click New.
3. Create a new format for the intClipDownTime table by using the Form Wizard.
4. Add all fields to this format.

Task 4. Check the corresponding intClipDownTime record
1. From Database Manager, open the format of the intClipDownTime table.
2. Click Search to see the record created for this downtime.
3. Check the External Status field:
External Status values

Description

NULL

The downtime is waiting for final approval, or the scheduler has not
proceeded this record yet.

0 (Canceled)

The downtime is canceled before being implemented.

1 (Ready)

The downtime has been approved and is ready to be synchronized to
UCMDB or BSM (RTSM).

2 (Withdrawn)

The downtime is approved firstly and then the approval is retracted
(withdrawn).

HPE Operations Manager i (10.12)

Page 118 of 207

OMi Integrations Guide
Chapter 23: OMi-SM Integration with RTSM

Notes:
a. Only downtime records with External Status 1 can be synchronized.
b. If the External Status is not 1, wait some time for background schedulers SLA and
SMBSM_DOWNTIME to process this record.

Task 5. Populate downtime from Service Manager to UCMDB
1. From UCMDB, run the CLIP Down Time Population job and the CI To Down Time CI With
Connection job in a fixed order.
2. Search for the adv-afr-desk-101 CI in UCMDB. Check that a corresponding Scheduled
Downtime CI is created, and a relationship between the Scheduled Downtime CI and the affected
CI is created.

Task 6. Test if BSM Downtime CIs have been created
1. In OMi, got to Administration > Service Health > Downtime Management.
2. Check if a corresponding Downtime was created.

Sending downtime notifications from OMi to SM (RTSM)
OMi can send downtime start and end events to SM to notify operators of when a downtime occurs.
This provides additional information to the SM operator in case of a downtime that was not driven by an
RFC.
To create downtimes in OMi based on RFCs in SM, see "Downtime Forwarding from Service Manager
to OMi (RTSM)" on page 112.

Step 1: Send OMi Downtime Events to SM
To enable OMi to send downtime start and end events to SM, follow these steps:
1. Access the following location in OMi:
Administration > Setup and Maintenance > Infrastructure Settings > Foundations >
Downtime
2. Change the value of the Downtime Send Event parameter to true.
3. Restart your OMi services on all Gateway Servers and Data Processing Servers.
This procedure generates events in OMi. After performing it, make sure you edit and enable the
Automatically forward "downtime started" and "downtime ended" events to Trouble Ticket
System event forwarding rule to forward downtime-start and downtime-end events to the SM server
that should be specified in the alias connected server called "Trouble Ticket System". For details on
event forwarding and connected servers, see the OMi Administration Guide.
Downtime events use the following formats:
l

Downtime Start
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l

Event field

OMi Downtime

Severity

Normal

Category

Downtime Notification

Title

Downtime for <CI Type><Affected CI Name>started at <Downtime Start Time>

Key

<OMi Downtime ID>:<Affected CI ID>:downtime-start

SubmitCloseKey

False

OutageStartTime

<Downtime Start Time>

OutageEndTime

<Downtime End Time>

CiName

<Affected CI Name>

CiId

<Affected CI Global ID>

CiHint

GUCMDB:<Affected CI Global ID>|UCMDB:<Affected CI ID>

HostHint

GUCMDB:<Related Host Global ID>|UCMDB:<Related Host ID>

EtiHint

downtime:start

Downtime End
Event field

OMi Downtime

Severity

Normal

Category

Downtime Notification

Title

Downtime for <CI Type><Affected CI Name> ended at < Downtime End Time>

Key

<OMi Downtime ID>:<Affected CI ID>:downtime-stop

SubmitCloseKey

true

CloseKeyPattern

<OMi Downtime ID>:<Affected CI ID>:downtime-start

EtiHint

downtime:end

LogOnly

true

View Changes and Incidents in OMi (RTSM)
This integration enables you to view planned changes and incident details in the Changes and Incidents
and Hierarchy components in OMi.
This chapter includes the following:
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l

"Prerequisite" below

l

"Step 1: Configure the Service Manager Adapter Time Zone" below

l

"Step 2: Create an Integration Point in OMi" on the next page

l

"Step 3: Edit Integration TQLs " on page 123

l

"Step 4: Verify View changes and incidents" on page 124

l

"How to Customize the Changes and Incidents Component" on page 124

Prerequisite
This integration requires that CIs are synchronized between the RTSM and SM. For information on CI
synchronization, see "Operations Manager i - Service Manager Integration Overview" on page 81.
This integration requires an administrator user account for OMi to connect to SM. This user account
must already exist in both OMi and SM. For details on creating required user accounts, see "Create
User Accounts for the OMi-SM Integration (RTSM)" on page 86

Step 1: Configure the Service Manager Adapter Time Zone
Configure the time zone so Incidents and Planned Changes have the correct time definitions:
1. In SM, select Navigation pane > Menu navigation > System Administration > Base System
Configuration > Miscellaneous > System Information Record. Open the Data Info tab.
2. In the Date Info tab, look up the value for the Time Zone.

3. In OMi, select Administration > RTSM Administration > Data Flow Management > Adapter
Management.
4. In the Resources window, open ServiceManagerAdapter9-x > Configuration Files >
ServiceManagerAdapter9-x/serviceDeskConfiguration.xml
Find the row that includes the following string:
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<globalConnectorConfig><![CDATA[<global_configuration><date_pattern>MM/dd/yy
HH:mm:ss</date_pattern><time_zone>US/MOUNTAIN</time_zone>

Check the date and time format, as well as a time zone. Note that the date is case-sensitive.
Change either SM or the xml file so that they both match each other's settings.
Note: Specify a time zone from the Java time zone list that matches the time zone used in
SM (for example, America/New York).
5. If you changed the time zone on SM, restart the SM server; if you changed the time zone on OMi,
you do not need to restart the OMi server.)

Step 2: Create an Integration Point in OMi
To create an integration point, follow these steps:
1. In OMi, select Administration > RTSM Administration > Data Flow Management >
Integration Studio.
2. In the Integration Point pane, select Create New Integration Point or choose an existing
integration point to edit. The Create New Integration Point dialog box opens. Enter the following:

Name

Recommended
Value
Description

Integration Name

SM Integration
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Name

Recommended
Value
Description

Adapter

<user defined>

Select Software Products > Service Manager >
Service Manager 9.xx.
This adapter, which supports CI/ relationship
Data Push from RTSM to Service Manager, and
Population and Federation from Service
Manager to RTSM.

Is Integration Activated

selected

Select this check box to create an active
integration point.

Hostname/IP

<user defined>

The name of the SM server.

Port

<user defined>

The port through which you access SM.

Credentials ID

<user defined>

Click Generic Protocol, click the Add button
to add the integration user account you created
in "Create User Accounts for the OMi-SM
Integration (RTSM)" on page 86 and then select
it.

Probe Name (for
<user defined>
ServiceManagerAdapter9x only)

Select the probe that you installed for this
integration.

Note: It is recommended to click the Test Connection button to verify that the details
entered are working before continuing.
3. In the Integration Point pane, click the Integration Point you just created, and click the
Federation tab in the right pane.
4. In the Supported and Selected CI Types area, verify that Incident and RequestForChange are
selected.

Step 3: Edit Integration TQLs
In this step, edit the integration TQLs so that they use the Integration Point created in the previous step.
1. In OMi, select Administration > RTSM Administration > Modeling > Modeling Studio.
2. On the Resources tab, select Resource Type: Queries. Open the Console folder.
3. Open the TQL: CollectRequestForChangeWithImpacts.
4. In the Query Definition pane, right click one of the objects of CI Type: RequestForChange.
5. From its Context Menu, select Set Integration Points. Choose the Integration Point that you
configured in the previous step.
6. Repeat steps 4 and 5 for all objects of CI Type: RequestForChange.
7. Open the TQL: CollectRequestForChangeWithoutImpacts.
8. Repeat steps 4 and 5 for all objects of CI Type: RequestForChange.

HPE Operations Manager i (10.12)

Page 123 of 207

OMi Integrations Guide
Chapter 23: OMi-SM Integration with RTSM

9. Open the TQL: CollectTicketsWithImpacts.
10. In the Query Definition pane, right click one of the objects of CI Type: Incident.
11. From its Context Menu, select Set Integration Points. Choose the Integration Point that you
configured in the previous step.
12. Repeat steps 10 and 11 for all objects of CI Type: Incident.
13. Open the TQL: CollectTicketsWithoutImpacts.
14. Repeat steps 10 and 11 for all objects of CI Type: Incident.
15. Save all TQLs.

Step 4: Verify View changes and incidents
To verify that you can view changes and incidents in OMi, make sure that you have an incident in SM
that is related to a CI in the OMi RTSM. To do so, send a test event related to a CI that has been
synchronized between OMi and SM.
1. Send an event, for example, by using the following command:
submitEvent -t testViewIncidents -rch <hintForExistingCI>
2. Select the event in the OMi Event Browser and select Transfer Control To in the Context Menu.
Select the SM target system.
3. Open the 360° View and select a view containing the related CI.
4. Select the CI, and verify that the Incident Count is at least 1. Click Incidents to show the
Changes in Incidents window, and verify that the incident is displayed in the Incidents section.
By default, the Changes and Incidents component displays data for the previous week. You can
change this setting to previous week, day, or hour (up to the current time) by using the Configure
Component button.

How to Customize the Changes and Incidents Component
By default, incidents and requests for change are displayed for the following CI types: Business
Service, Siebel Application, Business Application, and Node. If you want to view change and incident
information for other CITs, perform the following procedure:
1. Open the Modeling Studio:
Administration > RTSM Administration > Modeling > Modeling Studio
Copy one of the TQLs within the Console folder, and save your copy with a new name. These
default TQLs perform the following:
TQL name

Description

CollectTicketsWithImpacts

Retrieves SM incidents for the selected CI, and
for its child CIs which have an Impact
relationship.

CollectTicketsWithoutImpacts

Retrieves SM incidents for the selected CI.
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TQL name

Description

CollectRequestForChangeWithImpacts

Retrieves SM requests for change, for the
selected CI, and for its child CIs which have an
Impact relationship.

CollectRequestForChangeWithoutImpacts

Retrieves SM requests for change, for the
selected CI.

2. Edit the new TQL as needed. You can add CITs as described in "Naming Constraints for New
Request for Change TQLs" below.
3. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
a. Select Applications.
b. Select Service Health Application.
c. In the Service Health Application - Hierarchy (360) properties area, enter the name of the
new TQL you created in the corresponding infrastructure setting.
Note: By default, these infrastructure settings contain the default TQL names. If you enter a
TQL name that does not exist, the default value will be used instead.
After you modify the infrastructure setting, the new TQL will be used, and the Changes and Incidents
component will show this information for the CITs you defined.

Naming Constraints for New Request for Change TQLs
The following naming constraints must be followed in the request for change without impact TQL (see
the TQL example below, on the right side of the image):
l

The request for change CI type must start with directPlannedChange.

l

The CI type related to the request for change must start with trigger.

The following naming constraints must be followed in the request for change with impact TQL (see the
TQL example below, on the left side of the image):
l

impacterPlannedChange represents the request for change CI type.

l

The CI type related to the request for change must start with impacter.

l

triggerITUniverse represents the "impacted" child CIs.
Examples of request for change TQLs:
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Naming Constraints for New Incident TQLs
The following naming constraints must be followed in the incidents without impact TQL (see the TQL
example below, on the right side of the image):
l

The incident CI type must start with directITIncident.

l

The CI type related to the incident must start with trigger.

The following naming constraints must be followed in the incidents with impact TQL (see the TQL
example below, on the left side of the image):
l

impacterITIncident represents the incident CI type.

l

The CI type related to the incident must start with impacter.

l

triggerITUniverse represents the "impacted" child CIs.
Examples of incident TQLs:
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Business Impact Report (BIR) (RTSM)
OMi includes a report that you can use to help evaluate the impact of incidents on your business. For
example, if a host CI has critical status, you can use the report to display the status of the Business
Service CIs to which the host CI is attached.
Incident Management users can launch an impact report from an incident in context with the incident's
affected configuration item (CI). Service Desk Agents can validate the updated status of the business
impact to categorize and prioritize the incident accordingly.
Note:
l
This integration requires that CIs are synchronized between both Service Manager and OMi.
l

Only one instance of this integration is allowed.

Step 1: Add a Business Impact Report Integration in SM
To use the Service Manager to BIR integration, you must add and enable an instance of this integration
in Integration Manager.
To add and enable a Service Manager to BIR integration instance:
1. Click Tailoring > Integration Manager. Integration Instance Manager opens.
2. Click Add. The Integration Template Selection wizard opens.
3. Select SMBIR from the Integration Template list. Ignore the Import Mapping check box, which
has no effect on this integration.
Note: Only one instance of this integration is allowed. If an instance of this integration already
exists in Integration Manager, the SMBIR template is unavailable. You have to delete the
existing integration instance before you can add a new one.
4. Click Next. The Integration Instance Information page opens.
5. Update the following fields:
Note: Only Name and Version are required fields. This integration does not use the Interval
Time (s) and Max Retry Times fields as it is UI-based.
Field

Value

Name

(Required) The name of the integration instance.
Default: SMBIR

Version

(Required) The version of the integration template.
Default: 1.0

SM Server

The name of the Service Manager server machine.
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Field

Value

Endpoint
Server

The name of the OMi Server machine.

Log Level

Select one from: DEBUG, INFO (default), WARNING, ERROR, and OFF.

Log File
Directory

A directory on the Service Manager Server machine in which log files will be
stored.

Description

If you want, modify the default description of the instance.

Run at
system
startup

Select this check box only if you want this instance to be automatically enabled
when the Service Manager Server is started.

6. Click Next. The Integration Instance Parameters page opens.
7. On the General Parameters tab, replace "BSM_host" in the baseurl parameter with the
hostname of the real OMi server.
8. Click Next twice and then click Finish. Leave the Integration Instance Mapping and Integration
Instance Fields settings blank. This integration does not use these settings.
Service Manager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.
9. Enable the integration instance.

Step 2: Launch a Business Impact Report from an Incident
To launch a Business Impact Report from an incident:
1. Log on to the Service Manager Web client.
2. From Incident Management, search for an incident record and open it.
3. Click More and then select Launch Business Impact Report. The OMi Business Impact
window opens, showing the KPI over time data for the related CI and related business services.
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Chapter 24: OMi-SM Integration with UCMDB
This section describes the integration of Service Manager with OMi in the case of an external UCMDB.
This section includes:
l

"Data Flow Probes" below

l

"Create User Accounts for the OMi-SM Integration (UCMDB)" on the next page

l

"UCMDB-Service Manager Integration" on page 131 (prerequisite for all other integration options)

l

"OMi-UCMDB Integration" on page 131 (prerequisite for all other integration options)

l

"Enable LW-SSO for the OMi-SM Integration (UCMDB)" on page 131

l

"View Actual State in SM (UCMDB)" on page 139

l

"Event Forwarding from OMi to SM (UCMDB)" on page 139

l

"Downtime Forwarding from Service Manager to OMi (UCMDB)" on page 157

l

"Sending downtime notifications from OMi to SM (UCMDB)" on page 164

l

"View Changes and Incidents in OMi (UCMDB)" on page 165

l

"Business Impact Report (BIR) (UCMDB)" on page 172

Data Flow Probes
Figure: Setup OMi with a UCMDB and two Data Flow Probes
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The DFP1 is necessary for
l

Topology synchronization (CIs) between UCMDB and OMi

l

Topology synchronization (CIs) between UCMDB and Service Manager

DFP2 is necessary for
l

Topology data push from OMi to UCMDB

l

Federation of incidents and changes from SM into OMi

Create User Accounts for the OMi-SM Integration
(UCMDB)
The OMi-SM integration requires integration accounts to be set up for the three systems to access
each other.
1. In Service Manager, create an operator record with system administration privileges, and give it a
descriptive name, like UCMDBSMIntegrUser.
To create a dedicated integration user account in SM:
a. Log on to SM as a system administrator.
b. Type contacts in the SM command line, and press ENTER.
c. Create a new contact record for the integration user account.
i. In the Full Name field, type a full name. For example, UCMDB.
ii. In the Contact Name field, type a name. For example, UCMDB.
iii. Click Add, and then OK.
d. Type operator in the SM command line, and press ENTER.
e. In the Login Name field, type the user name of an existing system administrator account, and
click Search.
The system administrator account displays.
f. Create a new user account based on the existing one:
i. Change the Login Name to the integration account name you want (for example,
UCMDB).
ii. Type a Full Name. For example, RTSM.
iii. In the Contact ID field, click the Fill button and select the contact record you have just
created.
iv. Click Add.
v. Select the Security tab, and change the password.
vi. Click OK.
This is the user account that the OMi server uses to access Service Manager. It is used to forward
events and retrieve incidents and RFCs from Service Manager. Remember the user name and
password you specify here, as the UCMDB system will need them to access the Service
Manager target server in later steps.
2. On each OMi server, create a user account with system administration privileges. This account is
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used by SM to access the OMi system to retrieve the actual state information of a CI. Give it a
descriptive name, like SMOMiIntegrUser.
Remember the user name and password you specify here, as Service Manager will need the
accounts to access the OMi server(s) in later steps.
3. In OMi, create a user account with the system administration privileges for the UCMDB-OMi
integration. Give it a descriptive name, like UCMDBOMiIntegrUser. Remember the user name and
password you specify here, as the UCMDB system will need the account details to access the
OMi server in later steps.
4. In UCMDB, create a user account with system administration privileges for the OMi-UCMDB
integration. Give it a descriptive name, like OMiUCMDBIntegrUser. Remember the user name and
password you specify here, as OMi will need the account details to access the UCMDB server in
later steps.
5. In UCMDB, create a user account with system administration privileges for the SM-UCMDB
integration. Give it a descriptive name, like SMUCMDBIntegrUser. Remember the user name and
password you specify here, as SM will need the account to access the UCMDB server in later
steps.

UCMDB-Service Manager Integration
For details about how to integrate UCMDB with Service Manager, see the HPE Service Manager
Universal CMDB Integration Guide. This integration, and the OMi-UCMDB integration, which
synchronize important CIs, such as services, business applications and infrastructure CIs, are
prerequisites for all other integration features.

OMi-UCMDB Integration
For details about how to integrate UCMDB with OMi, see Universal CMDB Online Help and the RTSM
Best Practices document.

Enable LW-SSO for the OMi-SM Integration (UCMDB)
Lightweight Single Sign-On (LW-SSO) is optional but recommended for the OMi-SM Integration. You
have different LW-SSO configuration choices depending on your needs. The following describes how
LW-SSO can be used in the OMi-SM workflow.

LW-SSO options for the OMi-SM integration
When OMi creates an incident from an OMi event record
OMi creates an incident from an OMi event record by sending RESTful-based requests to Service
Manager. The incident ID is then stored in the event record.
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LW-SSO is NOT needed in this process. A dedicated Service Manager user account was specified
when configuring the Service Manager integration in OMi. OMi uses this dedicated user account when
calling the Service Manager RESTful Web Service to create the incident.

When an OMi user views the incident details
The user can log in to Service Manager and view the incident details by using the incident ID stored in
the event record.
If the user wants to view the incident details by clicking the incident link from the event record, LWSSO can be used; otherwise a Service Manager login prompt will appear.
LW-SSO is optional for this process. To enable LW-SSO for this process, configure LW-SSO in both
the Service Manager server and Web tier (because the server needs to trust the Web tier), as well as in
OMi.

When Service Manager synchronizes the OMi incident status back to OMi
When a user has updated the OMi incident, Service Manager calls the OMi server's RESTful Web
Service to update the incident changes to the OMi event record.
LW-SSO is NOT needed in this process. A dedicated OMi user account was specified when the
Incident Exchange (OMi - SM) integration was set up in SMIS, and Service Manager uses this user
account when calling the OMi server's RESTful Web Service to synchronize the incident status back
to the OMi event record.

When a user views the event details or the Business Impact Report from an OMi
incident
The user clicks the View OMi Event option or Launch Business Impact Report from the incident to
view the event details or Business Impact Report.
LW-SSO is optional for this process. If you enable LW-SSO in the Service Manager Web tier and in
OMi, the OMi login prompt is bypassed.
Required user permissions
In order to be able to view events, a user needs to be assigned a role with sufficient permission to read
events. To manage permissions in OMi, select:
Administration > Users > Users, Groups, and Roles
Select a role or create a new one. In the Permissions section, go to the Operations Console category,
select Events and specify the actions users can perform on Events assigned to user.
You can optionally grant the permission to view events not assigned to each user.

When CIs are synchronized between OMi/UCMDB and SM
LW-SSO is NOT needed in this process. Dedicated users are specified in the OMi-UCMDB, UCMDBSM and OMi-SM integration points.
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Configuring LW-SSO for the OMi-SM integration
To use LW-SSO for the SM-OMi integration, LW-SSO must be enable for both products. In SM, you
must enable LW-SSO in both the SM server and web tier.

Step 1: Configure LW-SSO in the SM server
Service Manager servers, version 9.30 and later, support Lightweight Single Sign-On (LW-SSO). A
Service Manager integration can pass an authentication token to Service Manager and does not require
re-authentication. This simplifies the configuration of Single Sign-On for HPE solutions by removing the
need to use Symphony Adapter (which proxies LW-SSO-based authentication with the Service
Manager Trusted Sign-On solution).
Enabling LW-SSO in the Service Manager server enables web service integrations from other HPE
products (for example, Release Control) to bypass Service Manager authentication if the product user
is already authenticated and a proper token is used; enabling LW-SSO in both the Service Manager
server and web tier enables users to bypass the login prompts when launching the Service Manager
web client from other HPE applications.
Note: Existing integrations that use the Symphony Adapter and Trusted Sign-On rather than this
new LW-SSO mechanism can continue to work.
To configure LW-SSO in the Service Manager server:
1. Go to the <Service Manager server installation path>/RUN folder, and open lwssofmconf.xml
in a text editor.
2. Make sure that the enableLWSSOFramework attribute is set to true (default).
3. Change the domain value example.com to the domain name of your Service Manager server host.
Note: To use LW-SSO, your Service Manager web tier and server must be deployed in the
same domain; therefore you should use the same domain name for the web tier and server. If
you fail to do so, users who log in from another application to the web tier can log in but may
be forcibly logged out after a while.
4. Set the initString value. This value MUST be the same with the LW-SSO setting of the other
HPE product you want to integrate with Service Manager.
Note:
l
LW-SSO version 2.5 is supported.
l

l

Optionally, you can change attributes paddingModeName, keySize, encodingMode,
engineName, and cipherType. However, you must make sure that they are same with the
LW-SSO setting of the other HPE product that you want to integrate with Service Manager.
Do not change the other configurations, such as the content in tag <restURLs>, and the
attribute of tag <service>.

Example:
<?xml version="1.0" encoding="UTF-8"?>
<lwsso-config xmlns="http://www.hpe.com/astsecurity/idmenablmentfw/lwsso/2.0">
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<enableLWSSO enableLWSSOFramework="true"
enableCookieCreation="true" cookieCreationType="LWSSO" />
<web-service>
<inbound>
<restURLs>
<url>.*7/ws.*</url>
<url>.*sc62server/ws.*</url>
<url>.*/ui.*</url>
</restURLs>
<service service-type="rest" >
<in-lwsso>
<lwssoValidation>
<domain>example.com</domain>
<crypto cipherType="symmetricBlockCipher" engineName="AES"
paddingModeName="CBC" keySize="256" encodingMode="Base64Url"
initString="This is a shared secret passphrase"</crypto>
</lwssoValidation>
</in-lwsso>
</service>
</inbound>
<outbound/>
</web-service>
</lwsso-config>

Step 2: Configure LW-SSO in the SM Web Tier
If Lightweight Single Sign-On (LW-SSO) is enabled in the Service Manager Web tier, integrations from
other HPE products will bypass Service Manager authentication when launching the Service Manager
Web client, provided that the HPE product user is already authenticated and a proper token is used.
Note:
l
To enable users to launch the Web client from another HPE product by using LW-SSO, you
must also enable LW-SSO in the Service Manager server.
l

Once you have enabled LW-SSO in the web tier, web client users should use the web tier
server's fully-qualified domain name (FQDN) in the login URL:
http://<myWebtierHostName>.<myDomain>:<port>/webtier-x.xx/index.do

The following procedure is provided as an example, assuming that the Service Manager Web tier is
deployed on Tomcat.
To configure LW-SSO in the Service Manager Web tier:
1. Open the <Tomcat>\webapps\< Service Manager Web tier>\WEB-INF\web.xml file in a text
editor.
2. Modify the web.xml file as follows:
a. Set the <serverHost> parameter to the fully-qualified domain name of the Service Manager
server.
Note: This is required to enable LW-SSO from the web tier to the server.
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b. Set the <serverPort> parameter to the communications port of the Service Manager server.
c. Set the secureLogin and sslPort parameters.
n

If you do not want to configure TLS between Tomcat and the browser, set
secureLogin to false.

n

We recommend that you enable secure login in a production environment. Once
secureLogin is enabled, you must configure TLS for Tomcat. For details, see the
Apache Tomcat documentation.

d. Change the value of context parameter isCustomAuthenticationUsed to false.
e. Remove the comment tags (<!-- and -->) enclosing the following elements to enable LW-SSO
authentication.
<!-<filter>
<filter-name>LWSSO</filter-name>
<filter-class>com.hp.sw.bto.ast.security.lwsso.LWSSOFilter</filterclass>
</filter>
-->
......
<!-<filter-mapping>
<filter-name>LWSSO</filter-name>
<url-pattern>/*</url-pattern>
</filter-mapping>
-->

f. Save the web.xml file.
3. Open the <Tomcat>\webapps\<Service Manager Web tier>\WEBINF\classes\lwssofmconf.xml file in a text editor.
4. Modify the lwssofmconf.xml file as follows:
a. Set the value of enableLWSSOFramework to true (default is false).
b. Set the <domain> parameter to the domain name of the server where you deploy your Service
Manager Web tier. For example, if your Web tier's fully qualified domain name is
mywebtier.domain.hpe.com, then the domain portion is domain.hpe.com.
Note: To use LW-SSO, your Service Manager web tier and server must be deployed in
the same domain; therefore you should use the same domain name for the web tier and
server. If you fail to do so, users who log in from another application to the web tier can
log in but may be forcibly logged out after a while.
c. Set the <initString> value to the password used to connect HPE applications through LWSSO (minimum length: 12 characters). For example, smintegrationlwsso. Make sure that
other HPE applications (for example, Release Control) connecting to Service Manager
through LW-SSO share the same password in their LW-SSO configurations.
d. In the <multiDomain> element, set the trusted hosts connecting through LW-SSO. If the
Service Manager web tier server and other application servers connecting through LW-SSO
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are in the same domain, you can ignore the <multiDomain> element ; If the servers are in
multiple domains, for each server, you must set the correct DNSDomain (domain name),
NetBiosName (server name), IP (IP address), and FQDN (fully-qualified domain name) values.
The following is an example.
<DNSDomain>example.com</DNSDomain>
<NetBiosName>myserver</NetBiosName>
<IP>1.23.456.789</IP>
<FQDN>myserver.example.com</FQDN>

Note: As of version 9.30, Service Manager uses <multiDomain> instead of
<protectedDomains>, which is used in earlier versions. The multi-domain functionality is
relevant only for UI LW-SSO (not for web services LW-SSO). This functionality is based
on the HTTP referrer. Therefore, LW-SSO supports links from one application to another
and does not support typing a URL in a browser window, except when both applications
are in the same domain.
e. Check the secureHTTPCookie value (default: true).
n

If you set secureHTTPCookie to true (default), you must also set secureLogin in the
web.xml file to true (default); if you set secureHTTPCookie to false, you can set
secureLogin to either true or false. In a production environment, you are
recommended to set both parameters to true.

n

If you do not want to use TLS, set both secureHTTPCookie and secureLogin to
false.

Here is an example of lwssofmconf.xml:
<?xml version="1.0" encoding="UTF-8"?>
<lwsso-config
xmlns="http://www.hp.com/astsecurity/idmenablmentfw/lwsso/2.0">
<enableLWSSO
enableLWSSOFramework="true"
enableCookieCreation="true"
cookieCreationType="LWSSO"/>
<webui>
<validation>
<in-ui-lwsso>
<lwssoValidation id="ID000001">
<domain>example.com</domain>
<crypto cipherType="symmetricBlockCipher"
engineName="AES" paddingModeName="CBC" keySize="256"
encodingMode="Base64Url"
initString="This is a shared secret passphrase"/>
</lwssoValidation>
</in-ui-lwsso>
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<validationPoint
enabled="false"
refid="ID000001"
authenicationPointServer="http://server1.example.com:8080/bsf"/>
</validation>
<creation>
<lwssoCreationRef useHTTPOnly="true" secureHTTPCookie="true">
<lwssoValidationRef refid="ID000001"/>
<expirationPeriod>50</expirationPeriod>
</lwssoCreationRef>
</creation>
<logoutURLs>
<url>.*/goodbye.jsp.*</url>
<url>.*/cwc/logoutcleanup.jsp.*</url>
</logoutURLs>
<nonsecureURLs>
<url>.*/images/.*</url>
<url>.*/js/.*</url>
<url>.*/css/.*</url>
<url>.*/cwc/tree/.*</url>
<url>.*/sso_timeout.jsp.*</url>
</nonsecureURLs>
<multiDomain>
<trustedHosts>
<DNSDomain>example.com</DNSDomain>
<DNSDomain>example1.com</DNSDomain>
<NetBiosName>myserver</NetBiosName>
<NetBiosName>myserver1</NetBiosName>
<IP>xxx.xxx.xxx.xxx</IP>
<IP>xxx.xxx.xxx.xxx</IP>
<FQDN>myserver.example.com</FQDN>
<FQDN>myserver1.example1.com</FQDN>
</trustedHosts>
</multiDomain>
</webui>
<lwsso-plugin type="Acegi">
<roleIntegration
rolePrefix="ROLE_"
fromLWSSO2Plugin="external"
fromPlugin2LWSSO="enabled"
caseConversion="upperCase"/>
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<groupIntegration
groupPrefix=""
fromLWSSO2Plugin="external"
fromPlugin2LWSSO="enabled"
caseConversion="upperCase"/>
</lwsso-plugin>
</lwsso-config>

f. Save the lwssofmconf.xml file.
5. Open the <Tomcat>\webapps\<Service Manager Web tier>\WEBINF\classes\application-context.xml in a text editor.
6. Modify the application-context.xml as follows:
a. Add lwSsoFilter to filterChainProxy:
/**=httpSessionContextIntegrationFilter,
lwSsoFilter,anonymousProcessingFilter
Note: If you need to enable web tier LW-SSO for integrations and also enable trusted
sign-on for your web client users, add lwSsoFilter followed by preAuthenticationFilter, as
shown in the following:
/**=httpSessionContextIntegrationFilter,
lwSsoFilter,preAuthenticationFilter,anonymousProcessingFilter.
b. Uncomment bean lwSsoFilter:
<bean id="lwSsoFilter"
class="com.hp.ov.sm.client.webtier.lwsso.LwSsoPreAuthenticationFilter">
c. Save the application-context.xml file.
7. Repack the updated Service Manager web tier files and replace the old web tier .war file
deployed in the <Tomcat>\webapps folder.
8. Restart Tomcat so that the configuration takes effect.

Step 3: Configure LW-SSO in OMi
l

In OMi:
a. Navigate to Authentication Management:
Administration > Users > Authentication Management
b. Click the Configure button under the Single Sign-On Configuration list to open the Single
Sign-On Configuration wizard.
c. In the Single Sign-On dialog, select Lightweight.
d. Paste the initString you copied above from JMX to get/set Token Creation Key (initString) to
the Token Creation String (initString).
e. Click Finish to save your configuration.
For details on configuring LW-SSO, see the OMi Administration Guide.
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View Actual State in SM (UCMDB)
To display the Actual State information in the SM configuration item form, do the following:
1. Log on to SM as a system administrator.
2. Click System Administration > Base System Configuration > Miscellaneous > System
Information Record.
3. Click the Active Integrations tab.
4. Select the HP Universal CMDB option.
The form displays the UCMDB web service URL field.
5. In the UCMDB web service URL field, type the URL to the Universal CMDB web service API.
The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService
6. In the UserId and Password fields, type the user credentials that are required to manage CIs on
the UCMDB system.
Replace <UCMDB server name> with the host name of your UCMDB server, and replace <port>
with the port used by your UCMDB server web service.
7. Click Save. SM displays the message: Information record updated.
8. Log out of the SM system.
9. To verify that the setup worked, log back into the SM system with an administrator account. The
Actual State section will be available in CI records pushed from OMi.

Event Forwarding from OMi to SM (UCMDB)
OMi enables you to forward events from OMi to Service Manager, which then become incidents in
Service Manager. Subsequent event/incident changes are synchronized between Service Manager and
OMi. You can also drill down from OMi events to Service Manager incidents and vice versa.
Follow the steps below to set up an incident exchange between Service Manager and OMi.
This section includes:
l

"Step 1: Configure the Service Manager server as a connected server in OMi" on the next page

l

"Step 2: (optional) Configure an Event Forwarding Rule " on page 142

l

"Step 3: Configure the OMi integration in Service Manager" on page 143

l

"Step 4: Configure Launch of Service Manager Incident Details from OMi" on page 147

l

"(optional) Step 5: Attribute Synchronization" on page 148

l

"Step 6: Test the Event Forwarding and Cross Launches" on page 153

l

"Advanced Configuration" on page 153
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Step 1: Configure the Service Manager server as a connected
server in OMi
To synchronize events and event changes between OMi and Service Manager incidents, configure
Service Manager as a target connected server in the OMi Connected Servers manager.
To configure the Service Manager server as a target connected server, perform the following steps:
1. Navigate to the Connected Servers manager:
Administration > Setup and Maintenance > Connected Servers
2. Click the New button and select External Event Processing. The Create New Server
Connection - External Event Processing dialog box opens.
3. In the General page, in the Display Name field, enter a name for the target Service Manager
server. By default, the Name field is filled automatically. For example, if you enter Service
Manager 1 as the Display Name for the target Service Manager server, Service_Manager_1 is
automatically inserted in the Name field. You can specify your own name in the Name field, if you
want to change it from the one suggested automatically.
Note: Make a note of the name of the new target server (in this example, Service_Manager_
1). You need to provide it later as the username when configuring the Service Manager server
to communicate with the server hosting OMi.
Optional: Enter a description for the new target server.
Make sure that you select the Active check box.
Click Next to open the Server Properties page.
4. In the Server Properties page, select Service Manager System in the mandatory CI Type field.
Then, enter the Fully Qualified DNS Name of the Service Manager target server.
Click Next to open the Integration Type page.
5. In the Integration Type page, complete the following information:
a. Select Call Script Adapter as the integration type.
b. From the Script Name menu, select the Service Manager Groovy script adapter
sm:ServiceManagerAdapter.
c. Click Next to open the Outgoing Connection page.
6. In the Outgoing Connection page, enter the credentials (user name, password, and port number)
required to access the Service Manager target server and to forward events to that server:
a. In the User Name field, enter the user name for the integration user you set up in Service
Manager.
b. In the Password field, enter the password for the user you specified. Repeat the password
entry in the Verify Password field.
c. In the Port field, specify the port configured on the Service Manager side for the integration
with OMi.
To find the port number to enter:
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n

If you are using default ports in Service Manager, select or clear Use Secure HTTP as
appropriate, and then click Set default port. The port is set automatically.
Note: If you do not want to use secure HTTP, make sure that the Use secure HTTP
check box is cleared.
If the Use Secure HTTP check box is selected, download and install a copy of the
target server’s TLS certificate by using the Retrieve from Server or Import from
File link, if the certificate is available in a local file.

n

If you need to find the port number, access the following file on your Service Manager
system:
<Service Manager root directory>/HP/Service Manager
<version>/Server/RUN/sm.cfg
In the sm.cfg file, check for the sm -loadBalancer line and add the port entry at the end
of the line. The line looks similar to this:
sm -loadBalancer -httpPort:13080
Enter the appropriate value of the port used by Service Manager in the Port field of the
Outgoing Connection page.

d. Select the Enable Synchronize and Transfer Control check box.
If the Enable Synchronize and Transfer Control check box is selected, an OMi operator can
transfer ownership of the event to the target connected server by using the Transfer Control
option in the Event Browser context menu.
If it is not selected, the Synchronize and Transfer Control option is not available from the
Event Browser context menu or from the list of forwarding types for configuring forwarding
rules.
e. Test the connection by clicking the Test Connection link in the upper center of the dialog box.
A Success or ERROR hyperlink is displayed. Click the link to get a more detailed message.
f. Click Next to open the Event Drilldown page.
7. If you want to drill down into Service Manager, in addition to automatically generating Service
Manager incidents from OMi events, you need to specify the fully qualified DNS name and port of
the Service Manager system into which you want to perform the incident drill down.
Note: To enable incident drill down to Service Manager, you must install a web tier client for
your Service Manager server according to your Service Manager server installation or
configuration instructions.
In the Event Drilldown page, configure the server where you installed the web tier client
along with the configured port used.
If you do not specify a server in the Event Drilldown page, it is assumed that the web tier
client is installed on the server used for forwarding events and event changes to SM, and
receiving event changes back from Service Manager.
If nothing is configured in the Event Drilldown dialog box, and the web tier client is not
installed on the Service Manager server machine, the web browser will not be able to find the
requested URL.
Select or clear the Use Secure HTTP check box according to your configuration.
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Click Next to open the Incoming Connection page.
8. To enable event changes to be synchronized back from Service Manager to OMi, you must
provide credentials for the Service Manager server to access the server hosting OMi.
a. In the Incoming Connection page, select the Accept event changes from external event
processing server check box, and then enter a password that the Service Manager server
requires to connect to the server hosting OMi.
Note: Make a note of this password. You need to provide it later when configuring the
Service Manager server to communicate with the server hosting OMi. This password is
associated with the user name (Service_Manager_1) you configured in Service Manager.
If Enable Synchronize and Transfer Control was previously selected, the Accept
event changes from external event processing server option is assumed and cannot
be disabled.
b. Click Finish. The target Service Manager server appears in the list of Connected Servers.
9. If you have SM 9.34 or higher, perform the following additional steps:
a. Reopen the Service Manager connected server that you configured in the previous steps. To
do so, double-click the connected server entry in the connected servers list.
b. Copy the ID of the connected server (displayed in the lower right corner of the General tab)
and save it. You need to specify this ID as omi.mgr.id on the Service Manager system.
An example of a connected server ID is as follows:
ID: 22f42836-fd36-473e-afc9-a81290f4f73b

Step 2: (optional) Configure an Event Forwarding Rule
Once you have configured the Service Manager server as a connected server in OMi, you can forward
events manually by using Transfer Control To from the Context Menu. If you want to automatically
forward events, you can configure an Event Forwarding Rule for the OMi server.
1. Open the Event Forwarding manager:
Administration > Event Processing > Automation > Event Forwarding
2. In the Event Forwarding Rules pane, click the
Event Forwarding Rules dialog box.

New Item button to open the Create New

3. Enter a display name, and (optional) a description of the event forwarding rule being specified.
4. Select Active. A rule must be active in order for its status to be available in Service Manager.
5. Select an event filter for the event forwarding rule from the Events Filter list. The filter determines
which events to consider for forwarding.
Filters for Event Forwarding Rules can screen events based on the following date-related event
attributes which, for example, help you to ignore outdated events:
o

Time Created

o

Time Received

o

Time Lifecycle State Changed
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4. If no appropriate filter is already configured, create a new filter as follows:
a. Click the
New Item button to open the Filter Configuration dialog box. You can choose
between New Simple Filter or New Advanced Filter.
b. In the Display Name field, enter a name for the new filter, in this example, FilterCritical.
Clear the check boxes for all severity levels except for the severity Critical.
Click OK.
c. You should see your new filter in the Select an Event Filter dialog box (select it, if it is not
already highlighted).
Click OK.
6. Under Target Servers, select the target server you configured in the previous step on connecting
servers. Click the Add button next to the target servers selection field. You can now see the
connected server's details. In the Forwarding Type field, select the Synchronize and Transfer
Control forwarding type. Although other selections are technically possible, only Synchronize and
Transfer Control is supported by Service Manager.

Step 3: Configure the OMi integration in Service Manager
Service Manager can integrate with more than one OMi server. To configure more than one server, first
complete "Configure the Instance Count in the Service Manager-OMi integration template" below
before adding integration instances. To proceed with the default of one server, skip to "Add an SMOMi
integration instance for each OMi server" below.

Configure the Instance Count in the Service Manager-OMi integration template
To integrate Service Manager with more than one OMi server, configure the Instance Count setting in
the SMOMi integration template, as described below.
1. Log on to Service Manager as a system administrator.
2. Type db in the command line, and press Enter.
3. In the Table field, type SMISRegistry, and click Search.
The SMIS integration template form opens.
4. Click Search.
A list of SMIS integration templates opens.
5. Select SMOMi from the list.
6. In the Instance Count field, change the value of 1 to the number of OMi servers that you want to
integrate with Service Manager. For example, if you need two OMi servers, change the value to 2.
7. Click Save.

Add an SMOMi integration instance for each OMi server
Once you have completed configuration in OMi, you are ready to add and enable a separate integration
instance in Service Manager for each OMi server.
To add and enable an Incident Exchange (OMi - SM) integration instance:
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1. Log on to Service Manager as a system administrator.
2. Click Tailoring > Integration Manager.
3. Click Add.
The Integration Template Selection wizard opens.
4. Select SMOMi from the Integration Template list.
Note: Ignore the Import Mapping check box, which has no effect on this integration.
5. Click Next.
6. Complete the integration instance information:
o

Modify the Name and Version fields to the exact values you need.

o

In the Interval Time (s) field, enter a value. For example: 600. If an OMi opened incident fails
to be synchronized back to OMi, Service Manager will retry the failed task at the specified
interval (for example, 600 seconds).

o

In the Max Retry Times field, enter a value. For example: 10. This is the maximum allowed
number of retries for each failed task.

o

(Optional) In the SM Server field, specify a display name for the Service Manager server host.
For example: my_Local_SM.

o

(Optional) In the Endpoint Server field, specify a display name for the OMi server host. For
example: my_OMi_1.

o

(Optional) In the Log File Directory field, specify a directory where log files of the integration
will be stored. This must be a directory that already exists on the Service Manager server host.

o

(Optional) In the Log Level field, change the log level from INFO (default) to another level. For
example: WARNING.

o

(Optional) If you want this integration instance to be automatically enabled when the Service
Manager Server service is started, select Run at system startup.

7. Click Next. The Integration Instance Parameters page opens.
8. On the General Parameters tab, complete the following fields as necessary:
Field

Sample Value

Description

omi.server.url

http://<servername>:oprgateway/rest/synchronization/event

This is the URL address of the
OMi server's RESTful web
service. Replace
<servername> with the fully
qualified domain name of your
OMi server.
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Field

Sample Value

Description

http.conn.timeout

30

The HTTP connection timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds), and
15 (seconds) is used if this
field is empty.

http.rec.timeout

30

The HTTP receive timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds), and
15 (seconds) is used if this
field is empty.

http.send.timeout

30

The HTTP send timeout
setting in seconds.
Note: The out-of-box
value is 30 (seconds), and
15 (seconds) is used if this
field is empty.

sm.mgr.id

55436DBE-F81E-4799-BA0565DE9404343B

The Universally Unique
Identifier (UUID) automatically
generated for this instance of
Service Manager.
Note: This field is
automatically completed
each time when you add
an SMOMi integration
instance. Do not change
it, otherwise the
integration will not work
properly.
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Field

Sample Value

Description

omi.reference.prefix

urn:x-hp:2009:opr:

The prefix of the BDM External
Process Reference field,
which will be present in
incoming synchronization
requests from the OMi server.
Note: This field is
automatically completed
and has a fixed value. Do
not change it.

sm.reference.prefix

urn:x-hp:2009:sm:

The prefix of the BDM External
Process Reference field,
which will be present in
outgoing synchronization
requests from Service
Manager.
Note: This field is
automatically completed
and has a fixed value. Do
not change it.

omi.eventdetail.baseurl http://<servername>/oprconsole/opr-evtdetails.jsp?eventId=

The basic URL address of the
event detail page in OMi.
Replace <servername> with
the fully qualified domain name
of your OMi server.

9. On the General Parameters and Secure Parameters tabs, enter three parameter values that you
specified when configuring the Service Manager server as a connected server in OMi. The
following table lists the parameters, whose values you can copy from your OMi server.
To copy the parameter values from OMi, follow these steps:
a. Log on to OMi as a system administrator.
b. Navigate to Admin > Operations Management > Setup > Connected Servers.
c. Locate your Service Manager server configuration entry and double-click anywhere on the
entry pane.
d. On the General tab, copy the ID string at the bottom into the omi.mgr.id field in Service
Manager.
e. On the Incoming Connection tab, copy the User Name and Password to the username
and Password fields in Service Manager, respectively.
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Field
omi.mgr.id
(on the
General
Parameters
tab)

Sample
Value

Description

f3832ff4The Universally Unique Identifier (UUID) automatically
a6b9-4228generated in OMi for the target Service Manager server.
9fedNote: This parameter was introduced to support multiple
b79105afa3e4
OMi servers. Service Manager uses the UUID to identify
from which OMi server an incident was opened. Be aware
that if you delete the connected server configuration for the
Service Manager server in OMi and then recreate the same
configuration, OMi generates a new UUID. You need to
reconfigure the integration instance by changing the old
UUID to the new one.
Tip: If you have only one OMi server, you can simply
remove this parameter (remove both the parameter name
and value) from the integration instance.

username
SM_Server
omi.mgr.id
(on the
General
Parameters
tab)

This is the user name that the Service Manager server uses to
synchronize incident changes back to the OMi server.

Password
SM_Server_
(on the
Password
Secure
Parameters
tab)

This is the password that the Service Manager server uses to
synchronize incident changes back to the OMi server.

10. Click Next twice, and then click Finish.
Note: Leave the Integration Instance Mapping and Integration Instance Fields settings blank.
This integration does not use these settings.
Service Manager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.
11. Enable the integration instance.
12. If you have multiple OMi servers, repeat the steps above for the rest of your OMi servers.

Step 4: Configure Launch of Service Manager Incident Details from
OMi
If you want to be able to drill down to Service Manager incidents from the OMi Event Browser, you need
to configure the Service Manager web tier in the sm:ServiceManagerAdapter script in OMi.
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1. Navigate to Connected Servers in OMi:
Administration > Setup and Maintenance > Connected Servers
Click the Manage Scripts icon.
2. Select the sm:ServiceManagerAdapter script, and click the Edit Item button.
3. Click the Script tab and locate the following text in the Groovy script:
private static final String SM_WEB_TIER_NAME = 'webtier-9.30'
4. Change the value of webtier-9.30 to the value required to access the Service Manager web tier
client.
The drill-down URL is made up like this:
http://<FQDN of Service Manager web tier server>/<web path to Service
Manager>/<URL query parameters>
In this instance, <FQDN of Service Manager web tier server> is the fully qualified DNS
name of the Service Manager server where the web tier client is installed. This part of the URL is
added automatically (together with http:// or https://) according to the values that you
provided when you configured Service Manager as a target connected server in the Connected
Servers manager. The address of the Event Drilldown page of the Connected Server makes up the
rest of the URL. For details, see the previous step on connecting servers.
An example of a drill-down URL:
http://smserver.example.com/SM930/index.do?ctx=docEngine&file=probsummary&query
=number%3D%22IM10216%22&queryHash=bf52f465
In this example, you need to replace webtier-9.30 with SM930. All the other parts of the URL are
configured automatically.
5. When finished editing, save the new version of the script. Note that the script can always be
reverted to its original version.
For details, see the OMi Administration Guide.
6. If you are using SM 9.34 or lower, set the values of the querysecurity parameter and the
querySecurity Web parameter from the default values (true) to false in the SM web tier
configuration file web.xml.
For details about the querysecurity parameter and the querySecurity Web parameter, see
Service Manager Online Help.

(optional) Step 5: Attribute Synchronization
Attribute Synchronization Using Groovy Scripts
When the SM incident is initially created from an OMi event, event attributes are mapped to the
corresponding SM incident attribute. Out of the box, after the initial incident creation, whenever the
incident or event subsequently changes, only a subset of the changed event and incident attributes are
synchronized. The following describes how to customize the list of attributes to synchronize upon
change. If you want to change the out-of-the-box behavior regarding which attributes are updated, you
can specify this in the Groovy script used on the OMi side for synchronization or incident creation. In
the Groovy script, you can specify which fields are updated in SM, and which fields are updated in OMi.
You can also specify custom attributes in the Groovy script.

HPE Operations Manager i (10.12)

Page 148 of 207

OMi Integrations Guide
Chapter 24: OMi-SM Integration with UCMDB

Bidirectional Synchronization of Attributes
Individual OMi event attributes can be synchronized from an OMi event to the corresponding SM
incident, whenever the event is changed in OMi. Similarly, individual SM incident attributes can be
synchronized from an SM incident to the corresponding event in OMi, every time the event is changed
in SM. To change the attributes that are synchronized from an OMi event to a corresponding SM
incident, change the attributes included in the SyncOPRPropertiesToSM list in the Groovy script. To
change the attributes that are synchronized from an SM incident to an OMi event, change the attributes
included in the SyncSMPropertiesToOPR list in the Groovy script. By default, the state, solution, and
cause attributes are synchronized from OMi events to their corresponding SM incidents, and the
incident_status and solution attributes are synchronized from an SM incident to the corresponding
OMi event.
To enable synchronization of all attributes in both directions, you can set the SyncAllProperties
variable to true. In this case, all other variables will be ignored.
Example:
l

private static final Set SyncOPRPropertiesToSM = ["state", "solution", "cause"]

l

private static final Set SyncSMPropertiesToOPR = ["incident_status", "solution"]

The following table lists the OMi event attributes that can by synchronized with an SM incident, and the
matching SM incident attributes that can be synchronized with an OMi event:
OMi event attribute SM incident attribute
title

name

description

description

state

incident_status

severity

urgency

priority

priority

solution

solution

Unidirectional Synchronization of Attributes
The assigned_user, assigned_group, and cause event properties can be synchronized from an OMi
event to a corresponding SM incident. To synchronize these attributes, add them to the
SyncOPRPropertiesToSM list in the groovy script.
Example:
l

private static final Set SyncOPRPropertiesToSM = ["assigned_user", "assigned_
group", "cause"]

Individual OMi event properties can be synchronized to a corresponding SM incident Activity Log.
Updates are not synchronized back from the SM incident Activity Log to the corresponding OMi event.
To change the properties that are synchronized, add the desired properties to the
SyncOPRPropertiesToSMActivityLog list in the Groovy script. By default, the title, description,
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state, severity, priority, annotation, duplicate_count, cause, symptom, assigned_user, and
assigned_group properties are synchronized.
Example:
l

private static final Set SyncOPRPropertiesToSMActivityLog = ["title",
"description", "priority"]

The following list includes all properties that can by synchronized from OMi events to the SM incident
Activity Log:
l

title

l

description

l

state

l

severity

l

priority

l

solution

l

annotation

l

duplicate_count

l

assigned_user

l

assigned_group

l

cause

l

symptom

l

control_transferred_to

l

time_state_changed

Custom Mappings for Custom Attributes
You can define your own mappings for custom attributes between OMi and SM. These mapping can be
either unidirectional, if the attributes are only contained in one map, or bidirectional, if the attributes are
contained in both maps. To create custom mappings for custom attributes, you can edit the
MapSM2OPRCustomAttribute and MapOPR2SMCustomAttribute lists in the Groovy script. These maps
are empty by default.
Example:
l

l

private static final Map <String, String> MapSM2OPRCustomAttribute =
[“MySMAttribute” : “MyOMiCustomAttribute”]
private static final Map <String, String> MapOPR2SMCustomAttribute = [
“MyOtherOMiCustomAttribute” : “MyOtherSMAttribute”, “MyThirdOMiCA”, “activity_
log”]

Mapping OPR Lifecycle States to BDM Lifecycle States
Individual OPR event state and SM incident status changes may be selected for synchronization. Out
of the box, only the "closed" state is synchronized in both directions. To change this behavior, add the
desired states to the appropriate list, SyncOPRStatesToSM or SyncSMStatusToOPR.
Examples:
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private static final Set SyncOPRStatesToSM = ["closed", "in_progress",
"resolved"]

l

private static final Set SyncSMStatusToOPR = ["closed", "resolved"]

l

In the example, the OPR event lifecycle states closed, in_progress, and resolved are synchronized
to the SM incident status, and SM incident statuses closed and resolved are synchronized to the
OPR event state.
Note: The special state "*" denotes all states, so to synchronize all OPR event states to the SM
incident status property, specify the following:
private static final Set SyncOPRStatesToSM = ["*"]
Additionally, two maps are used to specify the mapping of the OPR event lifecycle state to the BDM
incident status. The maps are named MapOPR2SMStatus and MapSM2OPRState. Out of the box, all
possible states have a mapping.
Examples:
l

l

private static final Map MapOPR2SMStatus = ["open": "open", "in_progress": "workin-progress", "resolved": "resolved", "closed": "closed"]
private static final Map MapSM2OPRState = ["accepted": "open", "assigned":
"open", "open": "open", "reopened": "open",
"pending-change": "in_progress", "pending-customer": "in_progress", "pendingother": "in_progress",
"pending-vendor": "in_progress", "referred": "in_progress", "suspended": "in_
progress",
"work-in-progress": "in_progress", "rejected": "resolved", "replaced-problem":
"resolved",
"resolved": "resolved", "cancelled": "resolved", "closed": "closed"]

Tips for customizing Groovy Scripts
This section provides some tips about customizing Groovy scripts. It contains a few selected
examples of what you can customize. To see further items that can be modified, see the configuration
section of a Groovy script.
In the configuration section of the Groovy script, you can define and modify the attributes that are to be
synchronized between OMi and SM. The configuration section of the Groovy script also contains the
default value mappings for lifecycle state, severity, and priority. You can also modify these, and it is
possible to define the mappings for in-going and out-going requests differently.
More advanced configuration can be done in other parts of the Groovy script if required.
The beginning and the end of the configuration section of the Groovy script is marked as follows:
//
//*BEGIN Configuration: Customization of properties for synchronization*
//
...
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...
//
// *END Configuration: Customization of properties for synchronization*
//

Note: Modifications to Groovy scripts are not overwritten by patches and hotfixes. Your
customized version of a script will remain after an update or a patch. If you want to use the newer
version of a script, make a copy of your version, revert back to the predefined version, and then
reapply your changes.
The mapping from OMi to SM is compliant to BDM 1.1 incident web service specifications. The
mapping of the BDM 1.1 incident web service to SM is specified in SM in the BDM Mapping Manager.
For more information about the BDM Mapping Manager, see Service Manager Online Help.

Avoiding Errors with Large TQL Queries
If the Groovy script executes a TQL query that produces a large number of results, an error message
appears informing you about the TQL query result exceeding the size limit. As a consequence, the
integration event is not sent. It is possible, however, to increase this limit by modifying the value of the
tql.compound.link.max.visited.objects setting.
Note: To check the default value of the tql.compound.link.max.visited.objects setting, from
the JMX console, select UCMDB:service=Settings Services, and then locate the
showSettingsByCategory method and enter TQL Settings as the category name.
To modify the value of the tql.compound.link.max.visited.objects setting, follow these steps:
1. From the JMX console, select UCMDB:service=Settings Services.
2. Click setSettingValue.
3. Enter tql.compound.link.max.visited.objects as the name of the setting you want to modify
and a new value for it.
Caution: Increasing the value of the tql.compound.link.max.visited.objects setting also
increases the load on the RTSM. Therefore, make sure to carefully consider how much to increase
this value.

Syntax Errors
The ServiceManagerAdapter Groovy script uses the Apache Wink client to communicate with
Service Manager. It therefore will throw a ClientWebException when there is an HTTP error status
returned by Service Manager.
If you get a syntax error when customizing your Groovy scripts, you will get an event in the event
browser with a detailed description of the error. In addition, you may view the opr-event-syncadapter.log log file for information about how to resolve the error. You can find this log file at the
following location:
<Gateway Server root directory>/log/opr-scripting-host/opr-event-sync-adapter.log
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Step 6: Test the Event Forwarding and Cross Launches
To test the event forwarding, forward an event manually to SM and then verify that the event is
forwarded to SM as expected, and that the cross launches work in both directions.
1. Open an OMi Event Browser.
2. Select an event and select Transfer Control To in the Context Menu. Select the SM target
system.
3. Select the Forwarding tab.
4. In the External Id field, you should see a valid SM incident ID after a few seconds.
5. Verify that the incident appears in the Incident Details in Service Manager by using the cross
launch (see next step).
If the event drill-down connection is not configured, verify the forwarding by using the following:
a. In the Forwarding tab in the OMi Event Browser, copy or note the incident ID from the External
Id field.
b. In the Service Manager user interface, navigate to:
Incident Management > Search Incidents
c. Paste or enter the incident ID in the Incident Id field.
d. Click the Search button. This takes you to the incident in the Incident Details.
6. Test the cross launch from OMi to SM:
Click the hyperlink created with the incident ID. A browser window opens, which takes you
directly to the incident in the Incident Details in Service Manager.
7. Test the cross launch from SM to OMi:
In the Incident Details in Service Manager, click More and then select View OMi Event. A
browser window opens, which takes you directly to the event in the Event Browser in OMi.
Note: The View OMi Event option displays only when the omi.mgr.id parameter in the
corresponding SM-OMi integration instance is set correctly.
8. Close the incident in Service Manager.
9. Verify that the change in the state of the incident (it is now closed) is synchronized back to OMi.
You should not be able to see the event that was closed in SM in the active Event Browser, but it
should now be in the Closed Events Browser.

Advanced Configuration
Configure forwarding of affected business services from OMi to SM
Service Manager versions 9.40 and higher support the display of multiple affected business services
associated with an event in OMi. By default, when an event is created in OMi that affects more than
one business service CI, all affected services are automatically forwarded to SM. The most critical
service is displayed on the "Primary Service" tab in SM, and all other affected services are displayed
on the "Impacted Services" tab.
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If you only want to forward the most critical affected service associated with an event from OMi to SM,
you can change the ForwardAllAffectedBusinessServices flag in the sm:ServiceManagerAdapter
script to false.
1. Navigate to Connected Servers in OMi:
Administration > Setup and Maintenance > Connected Servers
Click the Manage Scripts icon.
2. Select the sm:ServiceManagerAdapter script, and click the Edit Item button.
3. Click the Script tab and search for ForwardAllAffectedBusinessServices. Change the value to
false.
4. When finished editing, save the new version of the script. Note that the script can always be
reverted to its original version. For details, see the OMi Administration Guide.

Configure automatic closure for OMi incidents in SM
Incidents created from OMi events will be automatically closed when the corresponding OMi event is
closed. You can also configure SM incidents created from OMi events to be automatically closed after
a predefined amount of time since they were last updated (or resolved if they have not been updated
after being resolved).
The workflow is as follows:
1. An incident is opened from OMi.
2. If the Schedule Condition is met, the system creates a schedule record for the incident. The
schedule record will expire at a future time based on the Calc Expression.
3. A user updates the incident and saves the changes.
4. The Reset alerts if expression on the Alerts tab of the probsummary object definition is
evaluated. If it evaluates to true, the Expiration time of the schedule record is updated based on
the Calc Expression. By default, the expiration time of the schedule record is updated only when
the incident has a category of incident.
5. When the schedule record expires, the Alert Condition is evaluated. If it evaluates to true, the
incident is automatically closed.
To enable automatic closure for OMi incidents:
1. Configure the global settings in the Incident Management Environment record.
a. In SM versions lower than 9.40, click System Administration > Ongoing Maintenance >
Environment Records > Incident Management Environment.
In SM versions 9.40 and higher, click Incident Management > Administration >
Environment.
b. Change the following settings as necessary.
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Field

Value

Close Incident
Automatically?

This option disables or enables the automatic closure of OMi incidents
at the global level.
n If this option is not selected, no incidents will be automatically
closed.
If this option is selected, incidents will be automatically closed
under specified conditions.
Default: Not selected
n

Closure Code

This value will be copied to the Closure Code field of incidents when
they are automatically closed.
Default: Automatically Closed

Solution

This description will be appended to the end of the Solution field of
incidents when they are automatically closed.
Default: This incident which belongs to OMi has been closed
automatically.

c. Click Save.
d. Restart the Service Manager server.
Note: If you have made any changes to any of the configuration options in the Incident
Management Environment record, the Service Manager server must be restarted for the
changes to take effect.
2. Configure the alert definition that determines when an incident should be closed.
Note: The alert and problem processes must be running to enable the successful closure of
OMi incidents.
a. Click Tailoring > Document Engine > Alerts.
b. In the Alert Name field, enter: OMI Auto-Close.
c. Click Search. The OMiAuto-Close alert definition detail form opens.
Caution: These fields in the alert definition are used to control automatic closure of OMi
incidents. You can change the default values of these fields. However, you must be
aware of the risk that automatic closure of OMi incidents will not work properly if the
Schedule Condition and Alert Condition fields are not configured correctly.
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Field

Value

Schedule
Condition

This expression is used to determine if an incident should be scheduled for
automatic closure.
Default: jscall("SMOMi.isAutoCloseAndResolved").
An incident is scheduled for automatic closure when the following conditions
are met.

Alert
Condition

n

The Close Incident Automatically? option in the Incident Management
Environment record is selected.

n

In the incident record, the Do not close this incident automatically
option is not selected.

n

The incident has a status of Resolved.

This expression is evaluated when an incident is about to be automatically
closed. If it evaluates to true, the incident is closed.
Default: jscall("SMOMi.isAutoCloseEnabled").
An incident is closed when the following conditions are met.
n

The Close Incident Automatically? option in the Incident Management
Environment record is selected.

n

In the incident record, the Do not close this incident automatically
option is not selected.

Calc
This expression is used to determine how much time will elapse before an
Expression incident is automatically closed.
Default: $L.alert.time=update.time in $L.file+'7 00:00:00'.
The default value means the amount of time elapsed is equal to seven days
since the incident was last updated.
3. Configure alert information in the probsummary object.
The OMi autoclose alert definition is configured to only be used by OMi incidents. The closure time
is reset each time the incident is updated. If the closure time is reached without the incident being
updated then Service Manager will automatically close the incident.
a. Click Tailoring > Document Engine > Objects.
b. In the File name field, enter probsummary and press ENTER. The probsummary object
definition is displayed.
c. Select the Alerts tab.
The Reset alerts if expression is used to reset the automatic closure time of OMi incidents.
Default: category in $L.file="incident" and not null(1 in
external.process.reference in $L.file).

Configure TLS for the Incident Exchange integration
When OMi is configured to accept https connections only, you must configure TLS for the integration. If
you do not do so, changes on an incident that is created from OMi cannot be synchronized back to OMi.
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Note: The following steps describe how you do so by using the built-in keytool in Service Manager,
and the file paths are for Windows only. Be sure to change the file paths accordingly if your Service
Manager system is running on Unix.
To configure TLS for the integration, follow these steps:
1. Import the OMi root certificate to the Service Manager server trusted keystore.
The following is an example of the command line:
<SM Install path>\server\RUN\jre\bin\keytool -import -alias myCA -file <.pem
file of your BSM root certificate> -keystore <SM Install
path>\Server\RUN\jre\lib\security\cacerts -storepass <changeit>
Note: Where: changeit is the default password of the trusted keystore. Change it to your own
password if you have changed it.
2. Add the following parameters to the Service Manager server configuration file (<SM install
path>\Server\RUN\sm.ini):
truststoreFile:<SM install path>\Server\RUN\jre\lib\security\cacerts
truststorePass:<changeit>
3. Restart the Service Manager Server service.

Downtime Forwarding from Service Manager to OMi
(UCMDB)
You can create downtimes (also known as outages) in OMi based on Requests for Changes (RFCs) in
SM. This is done in two steps. First, scheduled downtime CIs are created in the UCMDB based on
RFCs in SM. Then, a BSM downtime CI is created in OMi based on the scheduled downtime.
You can also send downtime start and end information from OMi to SM to notify operators of when a
downtime occurs, especially if the downtime was not driven by an RFC in SM. For more information on
this integration, see "Sending downtime notifications from OMi to SM (UCMDB)" on page 164
Notes:
1. For Changes/Tasks that have final approval phases defined in Service Manager Integration
Suite (SMIS), the downtimes will be synchronized after the Changes/Tasks get final
approval.
2. Only downtimes that end at a future time will be synchronized.
3. Select the Configuration Item(s) Down checkbox when scheduling downtimes in
Changes/Tasks.
4. The SLA scheduler needs to be started in the System Status form.
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Step 1: Add an SMBSM_DOWNTIME integration instance in SM
To set up the integration from Service Manager to OMi, you must add an instance of this integration in
the Service Manager Integration Suite (SMIS). Note that additional setup is required on the OMi side for
integration from OMi to Service Manager.
To add the SMBSM_DOWNTIME instance:
1. Click Tailoring > Integration Manager. Integration Instance Manager opens.
2. Click Add. The Integration Template Selection wizard opens.
3. Select SMBSM_DOWNTIME from the Integration Template list. Ignore the Import Mapping
check box, which has no effect on this integration.
4. Click Next. The Integration Instance Information page opens.
5. Do the following:
o

Modify the Name and Version fields to the exact values you need.

o

In the Interval Time(s) field, enter a value based on your business needs in regard to downtime
exchange frequency. Note that a short interval time can be safe because the next scheduled
task will not start until the previous task is completed and the interval time passed.

o

In the Max Retry Times field, enter a value. This is the maximum allowed number of retries (for
example, 10) for each failed task.

o

In the Log File Directory field, specify a directory where log files of the integration will be
stored. This must be a directory that already exists on the Service Manager server. By default,
logging message is output to sm.log.

o

(Optional) In the SM Server field, specify a display name for the Service Manager server host.
For example: my_local_SM.

o

(Optional) In the Endpoint Server field, specify a display name for the OMi server host. For
example: my_BSM_1.

o

(Optional) In the Log Level field, change the log level from INFO (default) to another level. For
example: WARNING.

o

(Optional) If you want this integration instance to be automatically enabled when the Service
Manager Server service is started, select Run at system startup.

6. Click Next. The Integration Instance Parameters page opens.
7. On the General Parameters tab, complete the following fields as necessary:
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Name

Category Value

WithdrawDowntime General

true/false

Description
Set this value to true: When authorized users
are manually changing the phase of a change
record which has 'valid' outage, a window will
open and provide choices of withdrawing the
outage.
Set this value to false: The pop-up window is
disabled. This operation may cause some
unapproved planned downtimes be
synchronized to OMi.
By default, this value is set to true.

Category or
workflow (Process
Designer) name of
changes

Change

The final
approval
phase for
changes

Set the final approval phase for downtime,
which is the indication of valid downtime
information.

Category or
workflow (Process
Designer) name of
tasks

Task

The final
approval
phase for
tasks

Set the final approval phase for downtime,
which is the indication of valid downtime
information.

sm.host

General

<sm server
name >

Set the Service Manager server host name or
DNS name to compose the External Process
Reference and the Reference Number of
Scheduled Downtime CI in UCMDB.
Note: Do not include a colon in this field.
Otherwise, the logic will be broken.

sm.reference.prefix

General

urn:xSet the prefix to compose the External
hp:2009:sm Process Reference of Scheduled Downtime
CI in UCMDB.
Note: This field has a fixed value. Do not
change it.

Notes:
a. Type category or workflow name of change/task in the Name column. This value is casesensitive and it must match the record in Service Manager database.
b. Set the value to Change for changes in the Category column. Similarly, set the value to
Task for tasks.
c. Type the final approval phase in the Value column. This value is case-sensitive and it
must match the record in Service Manager database. You can separate multiple phases
by semicolons, which must be the English character.
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d. Detailed information will be displayed in the integration log when the following errors
occur:
n User input of categories/phases for the changes/tasks is not correct.
n

The category and phase pair does not exist in the database.

e. For Change Management categories which do not have approval phase, the downtime
integration will treat its downtime information as final approved once created. You do not
need to define any phases in SMIS parameters.
f. For the category or workflow name of the changes and the tasks, the integration will
ignore all the final phases defined for the redundant category or workflow.
8. Click Next twice and then click Finish. Leave the Integration Instance Mapping and Integration
Instance Fields settings blank. This integration does not use these settings.
Service Manager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.
9. Enable the integration instance. SMIS will validate all the final phases you filled in the Integration
Instance Parameters page and print warning messages if there are errors.

Step 2: Tailor Service Manager to handle phase change
In the Service Manager Change Management module, authorized users can manually change the
phase of a change record. If the phase is changed to the one prior to the final approval phase in the
SMBSM_DOWNTIME instance, the system will check if there are existing planned downtimes that
have been set to Ready. If such downtimes exist, a window will open and provide two options for the
corresponding planned downtimes:
l

l

Click Yes to withdraw the corresponding planned downtimes from UCMDB. The changes or tasks
need to be approved again to synchronize with UCMDB at another time.
Click No. There will be no change to the planned downtimes even if the actual status of the changes
or tasks are not approved.
Note: To disable the pop-up window when withdrawing the planned downtimes, you must set the
WithdrawDowntime parameter to false in the SMBSM_DOWNTIME instance. This operation
may cause some unapproved planned downtimes to be synchronized to OMi.

With Process Designer (PD) Content Pack 2 applied in Service Manager, you can tailor the process to
transit changes or tasks from one phase that is after the final approval phase in the SMBSM_
DOWNTIME instance to another that is prior to the final approval phase. To withdraw the related
planned downtime for this kind of transition, you need to add a rule set for the transition in the Closed
Loop Incident Process (CLIP) solution. Follow these steps:
1. Go to the target workflow that needs tailoring.
2. Select the transition that moves a phase from before the final approval phase to after the final
approval phase.
3. In the Rule Sets section, click Add and select the clip.downtime.withdraw rule set.
4. Click OK to save the workflow.
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Step 3: Set up downtime sync jobs in UCMDB
As part of CI synchronization, you have already set up an integration point between SM and UCMDB.
In this step, you add downtime synchronization jobs, so that scheduled downtime CIs are created in
UCMDB based on Requests for Change in SM.
To add the downtime synchronization jobs:
1. Log in to your UCMDB system as an administrator.
2. Edit the existing integration point that connects to your Service Manager server.
3. Click Managers > Data Flow Management > Integration Studio. UCMDB displays a list of
integration points.
4. Select the existing SM integration point. Make sure that CIs have already been synchronized
between SM and UCMDB.
5. Create two integration jobs in the integration point on the Population tab:
a. Create a new job including the SM CLIP Down Time Population job definition. Under
Scheduler Definition, select the Scheduler enabled checkbox and set the Repeat Interval
to 1 Minute. Click OK to save the job.
b. Create another new job including the SM CI Connection Downtime CI job definition. Under
Scheduler Definition, select the Scheduler enabled checkbox and set the Repeat Interval
to 1 Minute. Click OK to save the job.
Pay attention to the running order. The CLIP Down Time Population job must be run first. You
can set the two jobs as schedule-based and set the schedule interval according to your needs.
Note: If no related CIs exist in UCMDB when creating relationships, the population will fail or
succeed with a warning. To disable the warning, remove the downtime CI that does not have
related CIs in UCMDB.

Step 4: Set up creation of BSM Downtime CIs
In this step, BSM Downtime CIs are created based on Scheduled Downtime CIs.
To enable downtimes defined in SM to be sent to OMi, you must install the DFP2 in the OMi
deployment.
Important:
l

Following the initial integration, a large amount of data may be communicated from SM to OMi. It is
highly recommended that you perform this procedure during off-hours, to prevent negative impact on
system performance.

To create BSM Downtime CIs:
1. Create a new Integration Point or, if existing, edit the SM Scheduled Downtime Integration Into
BSM Integration Point:
a. Do the following on your UCMDB:
Go to:
Managers> Data Flow Management > Integration Studio
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b. Click New Integration Point or Edit, enter a name and description of your choice, and select
the adapter SM Scheduled Downtime Integration Into BSM from the Service Manager
folder.
If you have upgraded from an older version of OMi to OMi 10.10, you may still see the old
"BSM Downtime Adapter", or you may see the "SM Scheduled Downtime Integration Into
BSM" adapter in the Third Party Products folder (not in the Service Manager folder). In this
case, you must upgrade your adapter by doing the following:
i. Open the Package Manager.
ii. Deploy the package: /opt/hp/BSM/odb/conf/factory_
packages/BSMDowntimeAdapter.zip on the data processing server.
iii. You should now find the SM Scheduled Downtime Integration Into BSM adapter in
the Service Manager folder.
c. Enter the following information for the adapter: OMi GW or Lolad Balancer/Reverse Proxy
FDQN and port (80/44), communication protocol (http/https), and the context root (if you have
a non-default context root).
d. Specify the credentials for the user you created in "Create User Accounts for the OMi-SM
Integration (UCMDB)" on page 130 to access the OMi system. Choose generic protocol as
protocol.
e. Click OK, then click the Save button above the list of the integration points.
2. You can use the Statistics tab in the lower pane to track the number of downtimes that are created
or updated. By default, the integration job runs every minute. If a job has failed, you can open the
Query Status tab and double-click the failed job to see more details on the error.
If there is an authentication error, verify the OMi credentials entered for the integration point.
If you receive an unclear error message with error code, this generally indicates a communication
problem. Check the communication with OMi.
A failed job will be repeated until the problem is fixed.

Step 5: Verify the SM-OMi downtime synchronization setup
When you have set up the Downtime integration, you can perform the following tasks to see if you have
successfully set up your downtime synchronization.

Task 1. Open a new change of a category that has the final
approval phase defined in SMIS
1. Click Change Management > Create New Change.
2. Select Hardware for example.
3. In the Affected CI field, choose a CI that has been synchronized. For example: adv-afr-desk101.
4. Set Scheduled Downtime Start and Scheduled Downtime End to a future time.
5. Select the Configuration Item(s) Down checkbox.
6. Set other required fields.
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7. Click Validation Accepted. If you are prompted to fill in more required fields, supply the required
information and click Validation Accepted again.
8. Click Request Authorization.
9. Click Save&Exit the change.

Task 2. Approve the change at the final approval phase
1. Click Change Management > Task Queue.
2. Search for the task that was created in Task 1 and click Close to close the task.
3. Click Change Management > Search Change and search for the change opened in Task 1.
4. Move the Change to the Change Approval phase by selecting Request Authorization.
5. Log on to Service Manager with user account Change.Approver.
6. Select Approval Inbox and search for the change created in Task 1.
7. Approve the change.

Task 3. Create new format for the intClipDownTime table
1. Open the SM Windows client.
Note: This step can only be performed in the SM Windows client.
2. Enter fd into the search field to open the Forms Designer and click New.
3. Create a new format for the intClipDownTime table by using the Form Wizard.
4. Add all fields to this format.

Task 4. Check the corresponding intClipDownTime record
1. From Database Manager, open the format of the intClipDownTime table.
2. Click Search to see the record created for this downtime.
3. Check the External Status field:
External Status values

Description

NULL

The downtime is waiting for final approval, or the scheduler has not
proceeded this record yet.

0 (Canceled)

The downtime is canceled before being implemented.

1 (Ready)

The downtime has been approved and is ready to be synchronized to
UCMDB or BSM (RTSM).

2 (Withdrawn)

The downtime is approved firstly and then the approval is retracted
(withdrawn).
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Notes:
a. Only downtime records with External Status 1 can be synchronized.
b. If the External Status is not 1, wait some time for background schedulers SLA and
SMBSM_DOWNTIME to process this record.

Task 5. Populate downtime from Service Manager to UCMDB
1. From UCMDB, run the CLIP Down Time Population job and the CI To Down Time CI With
Connection job in a fixed order.
2. Search for the adv-afr-desk-101 CI in UCMDB. Check that a corresponding Scheduled
Downtime CI is created, and a relationship between the Scheduled Downtime CI and the affected
CI is created.

Task 6. Test if BSM Downtime CIs have been created
1. In OMi, got to Administration > Service Health > Downtime Management.
2. Check if a corresponding Downtime was created.

Sending downtime notifications from OMi to SM
(UCMDB)
OMi can send downtime start and end events to SM to notify operators of when a downtime occurs.
This provides additional information to the SM operator in case of a downtime that was not driven by an
RFC.
To create downtimes in OMi based on RFCs in SM, see "Downtime Forwarding from Service Manager
to OMi (UCMDB)" on page 157.

Step 1: Send OMi Downtime Events to SM
To enable OMi to send downtime start and end events to SM, follow these steps:
1. Access the following location in OMi:
Administration > Setup and Maintenance > Infrastructure Settings > Foundations >
Downtime
2. Change the value of the Downtime Send Event parameter to true.
3. Restart your OMi services on all Gateway Servers and Data Processing Servers.
This procedure generates events in OMi. After performing it, make sure you edit and enable the
Automatically forward "downtime started" and "downtime ended" events to Trouble Ticket
System event forwarding rule to forward downtime-start and downtime-end events to the SM server
that should be specified in the alias connected server called "Trouble Ticket System". For details on
event forwarding and connected servers, see the OMi Administration Guide.
Downtime events use the following formats:
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l

l

Downtime Start
Event field

OMi Downtime

Severity

Normal

Category

Downtime Notification

Title

Downtime for <CI Type><Affected CI Name>started at <Downtime Start Time>

Key

<OMi Downtime ID>:<Affected CI ID>:downtime-start

SubmitCloseKey

False

OutageStartTime

<Downtime Start Time>

OutageEndTime

<Downtime End Time>

CiName

<Affected CI Name>

CiId

<Affected CI Global ID>

CiHint

GUCMDB:<Affected CI Global ID>|UCMDB:<Affected CI ID>

HostHint

GUCMDB:<Related Host Global ID>|UCMDB:<Related Host ID>

EtiHint

downtime:start

Downtime End
Event field

OMi Downtime

Severity

Normal

Category

Downtime Notification

Title

Downtime for <CI Type><Affected CI Name> ended at < Downtime End Time>

Key

<OMi Downtime ID>:<Affected CI ID>:downtime-stop

SubmitCloseKey

true

CloseKeyPattern

<OMi Downtime ID>:<Affected CI ID>:downtime-start

EtiHint

downtime:end

LogOnly

true

View Changes and Incidents in OMi (UCMDB)
This integration enables you to view planned changes and incident details in the Changes and Incidents
and Hierarchy components in OMi.
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This chapter includes the following:
l

"Prerequisite" below

l

"Step 1: Configure the Service Manager Adapter Time Zone" below

l

"Step 2: Create an Integration Point in OMi" on page 168

l

"Step 3: Edit Integration TQLs " on page 169

l

"Step 4: Verify View changes and incidents" on page 169

l

"How to Customize the Changes and Incidents Component" on page 170

Prerequisite
This integration requires that CIs are synchronized between UCMDB and SM. For information on CI
synchronization, see "Operations Manager i - Service Manager Integration Overview" on page 81.
Out-of-the-box, OMi provides queries that are used to retrieve changes and incidents from SM. These
queries need to be manually deployed to your UCMDB. On the OMi data processing server, go to
<OMi_Home>/odb/conf/factory_packages and find the Console.zip package. Copy the package to
the local directory on your UCMDB system and use the UCMDB Package Manager to deploy the
console.zip package to the UCMDB.
This integration requires an administrator user account for OMi to connect to SM. This user account
must already exist in both OMi and SM. For details on creating required user accounts, see "Create
User Accounts for the OMi-SM Integration (UCMDB)" on page 130

Step 1: Configure the Service Manager Adapter Time Zone
Configure the time zone so Incidents and Planned Changes have the correct time definitions:
1. In SM, select Navigation pane > Menu navigation > System Administration > Base System
Configuration > Miscellaneous > System Information Record. Open the Data Info tab.
2. In the Date Info tab, look up the value for the Time Zone.
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3. In OMi, select Administration > RTSM Administration > Data Flow Management > Adapter
Management.
4. In the Resources window, open ServiceManagerAdapter9-x > Configuration Files >
ServiceManagerAdapter9-x/serviceDeskConfiguration.xml
Find the row that includes the following string:
<globalConnectorConfig><![CDATA[<global_configuration><date_pattern>MM/dd/yy
HH:mm:ss</date_pattern><time_zone>US/MOUNTAIN</time_zone>
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Check the date and time format, as well as a time zone. Note that the date is case-sensitive.
Change either SM or the xml file so that they both match each other's settings.
Note: Specify a time zone from the Java time zone list that matches the time zone used in
SM (for example, America/New York).
5. If you changed the time zone on SM, restart the SM server; if you changed the time zone on OMi,
you do not need to restart the OMi server.)

Step 2: Create an Integration Point in OMi
To create an integration point, follow these steps:
1. In OMi, select Administration > RTSM Administration > Data Flow Management >
Integration Studio.
2. In the Integration Point pane, select Create New Integration Point or choose an existing
integration point to edit. The Create New Integration Point dialog box opens. Enter the following:

Name

Recommended
Value
Description

Integration Name

SM Integration

The name you give to the integration point.

Adapter

<user defined>

Select Software Products > Service Manager >
Service Manager 9.xx.
This adapter, which supports CI/ relationship
Data Push from RTSM to Service Manager, and
Population and Federation from Service
Manager to RTSM.

Is Integration Activated

selected

Select this check box to create an active
integration point.

Hostname/IP

<user defined>

The name of the SM server.

Port

<user defined>

The port through which you access SM.

Credentials ID

<user defined>

Click Generic Protocol, click the Add button
to add the integration user account you created
in "Create User Accounts for the OMi-SM
Integration (UCMDB)" on page 130 and then
select it.

Probe Name (for
<user defined>
ServiceManagerAdapter9x only)

Select the probe that you installed for this
integration.

Note: It is recommended to click the Test Connection button to verify that the details
entered are working before continuing.
3. In the Integration Point pane, click the Integration Point you just created, and click the
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Federation tab in the right pane.
4. In the Supported and Selected CI Types area, verify that Incident and RequestForChange are
selected.

Step 3: Edit Integration TQLs
In this step, edit the integration TQLs so that they use the Integration Point created in the previous step.
1. In OMi, select Administration > RTSM Administration > Modeling > Modeling Studio.
2. On the Resources tab, select Resource Type: Queries. Open the Console folder.
3. Open the TQL: CollectRequestForChangeWithImpacts.
4. In the Query Definition pane, right click one of the objects of CI Type: RequestForChange.
5. From its Context Menu, select Set Integration Points. Choose the Integration Point that you
configured in the previous step.
6. Repeat steps 4 and 5 for all objects of CI Type: RequestForChange.
7. Open the TQL: CollectRequestForChangeWithoutImpacts.
8. Repeat steps 4 and 5 for all objects of CI Type: RequestForChange.
9. Open the TQL: CollectTicketsWithImpacts.
10. In the Query Definition pane, right click one of the objects of CI Type: Incident.
11. From its Context Menu, select Set Integration Points. Choose the Integration Point that you
configured in the previous step.
12. Repeat steps 10 and 11 for all objects of CI Type: Incident.
13. Open the TQL: CollectTicketsWithoutImpacts.
14. Repeat steps 10 and 11 for all objects of CI Type: Incident.
15. Save all TQLs.

Step 4: Verify View changes and incidents
To verify that you can view changes and incidents in OMi, make sure that you have an incident in SM
that is related to a CI in the OMi RTSM. To do so, send a test event related to a CI that has been
synchronized between OMi and SM.
1. Send an event, for example, by using the following command:
submitEvent -t testViewIncidents -rch <hintForExistingCI>
2. Select the event in the OMi Event Browser and select Transfer Control To in the Context Menu.
Select the SM target system.
3. Open the 360° View and select a view containing the related CI.
4. Select the CI, and verify that the Incident Count is at least 1. Click Incidents to show the
Changes in Incidents window, and verify that the incident is displayed in the Incidents section.
By default, the Changes and Incidents component displays data for the previous week. You can
change this setting to previous week, day, or hour (up to the current time) by using the Configure
Component button.
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How to Customize the Changes and Incidents Component
By default, incidents and requests for change are displayed for the following CI types: Business
Service, Siebel Application, Business Application, and Node. If you want to view change and incident
information for other CITs, perform the following procedure:
1. Open the Modeling Studio:
Administration > RTSM Administration > Modeling > Modeling Studio
Copy one of the TQLs within the Console folder, and save your copy with a new name. These
default TQLs perform the following:
TQL name

Description

CollectTicketsWithImpacts

Retrieves SM incidents for the selected CI, and
for its child CIs which have an Impact
relationship.

CollectTicketsWithoutImpacts

Retrieves SM incidents for the selected CI.

CollectRequestForChangeWithImpacts

Retrieves SM requests for change, for the
selected CI, and for its child CIs which have an
Impact relationship.

CollectRequestForChangeWithoutImpacts

Retrieves SM requests for change, for the
selected CI.

2. Edit the new TQL as needed. You can add CITs as described in "Naming Constraints for New
Request for Change TQLs" below.
3. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
a. Select Applications.
b. Select Service Health Application.
c. In the Service Health Application - Hierarchy (360) properties area, enter the name of the
new TQL you created in the corresponding infrastructure setting.
Note: By default, these infrastructure settings contain the default TQL names. If you enter a
TQL name that does not exist, the default value will be used instead.
After you modify the infrastructure setting, the new TQL will be used, and the Changes and Incidents
component will show this information for the CITs you defined.

Naming Constraints for New Request for Change TQLs
The following naming constraints must be followed in the request for change without impact TQL (see
the TQL example below, on the right side of the image):
l

The request for change CI type must start with directPlannedChange.

l

The CI type related to the request for change must start with trigger.
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The following naming constraints must be followed in the request for change with impact TQL (see the
TQL example below, on the left side of the image):
l

impacterPlannedChange represents the request for change CI type.

l

The CI type related to the request for change must start with impacter.

l

triggerITUniverse represents the "impacted" child CIs.
Examples of request for change TQLs:

Naming Constraints for New Incident TQLs
The following naming constraints must be followed in the incidents without impact TQL (see the TQL
example below, on the right side of the image):
l

The incident CI type must start with directITIncident.

l

The CI type related to the incident must start with trigger.

The following naming constraints must be followed in the incidents with impact TQL (see the TQL
example below, on the left side of the image):
l

impacterITIncident represents the incident CI type.

l

The CI type related to the incident must start with impacter.

l

triggerITUniverse represents the "impacted" child CIs.
Examples of incident TQLs:
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Business Impact Report (BIR) (UCMDB)
OMi includes a report that you can use to help evaluate the impact of incidents on your business. For
example, if a host CI has critical status, you can use the report to display the status of the Business
Service CIs to which the host CI is attached.
Incident Management users can launch an impact report from an incident in context with the incident's
affected configuration item (CI). Service Desk Agents can validate the updated status of the business
impact to categorize and prioritize the incident accordingly.
Note:
l
This integration requires that CIs are synchronized between both Service Manager and OMi.
l

Only one instance of this integration is allowed.

Step 1: Add a Business Impact Report Integration in SM
To use the Service Manager to BIR integration, you must add and enable an instance of this integration
in Integration Manager.
To add and enable a Service Manager to BIR integration instance:
1. Click Tailoring > Integration Manager. Integration Instance Manager opens.
2. Click Add. The Integration Template Selection wizard opens.
3. Select SMBIR from the Integration Template list. Ignore the Import Mapping check box, which
has no effect on this integration.
Note: Only one instance of this integration is allowed. If an instance of this integration already
exists in Integration Manager, the SMBIR template is unavailable. You have to delete the
existing integration instance before you can add a new one.
4. Click Next. The Integration Instance Information page opens.
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5. Update the following fields:
Note: Only Name and Version are required fields. This integration does not use the Interval
Time (s) and Max Retry Times fields as it is UI-based.
Field

Value

Name

(Required) The name of the integration instance.
Default: SMBIR

Version

(Required) The version of the integration template.
Default: 1.0

SM Server

The name of the Service Manager server machine.

Endpoint
Server

The name of the OMi Server machine.

Log Level

Select one from: DEBUG, INFO (default), WARNING, ERROR, and OFF.

Log File
Directory

A directory on the Service Manager Server machine in which log files will be
stored.

Description

If you want, modify the default description of the instance.

Run at
system
startup

Select this check box only if you want this instance to be automatically enabled
when the Service Manager Server is started.

6. Click Next. The Integration Instance Parameters page opens.
7. On the General Parameters tab, replace "BSM_host" in the baseurl parameter with the
hostname of the real OMi server.
8. Click Next twice and then click Finish. Leave the Integration Instance Mapping and Integration
Instance Fields settings blank. This integration does not use these settings.
Service Manager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.
9. Enable the integration instance.

Step 2: Launch a Business Impact Report from an Incident
To launch a Business Impact Report from an incident:
1. Log on to the Service Manager Web client.
2. From Incident Management, search for an incident record and open it.
3. Click More and then select Launch Business Impact Report. The OMi Business Impact
window opens, showing the KPI over time data for the related CI and related business services.
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Tip: The following is a high-level overview of the Operations Manager i - Network Node Manager i
(NNMi) integration. You can find comprehensive details on NNMi integrations in the Network Node
Manager i Software—Business Service Management/Universal CMDB Topology Integration
Guide.
You can integrate NNMi with OMi to provide the following capabilities:
l

l

NNMi topology > OMi RTSM topology. The topology integration populates the OMi RTSM with
the NNMi network topology. OMi stores each device, interface, IP address, and a few other artifacts
in the NNMi network topology as a CI and includes it in the relevant views.
NNMi events > OMi events. NNMi events are displayed in the Event Browser in OMi. You can also
access the NNMi console from the OMi Event Browser. The NNMi events are sent to OMi using the
Operations Connector.
This integration has item ID 344 in the Integrations Catalog at the following location:
https://softwaresupport.hpe.com/km/KM01694988

l

l

NNMi events > OMi health indicators. After you have set up the integration, if the NNMi events
have corresponding health indicators defined, these health indicators affect the status of relevant
CIs in OMi applications, such as Service Health.
OMi > NNMi drill down. In OMi, you can configure a link to the NNMi management server that
enables you to drill down from My Workspace and other locations to NNMi, to view trace route
information between the client and the destination machine. You can also use URL tools to launch a
browser that enables you to connect to the NNMi management server and further analyze incoming
events in NNMi.
In addition, certain NNMi user interface components (network maps, items, detailed information
dialogs, and so on) can be displayed directly in Workspaces > My Workspace.
Note: If the NNMi topology is not synchronized with the OMi RTSM topology, the Monitored by
property of the OMi CIs corresponding to the NNMi CIs is empty, and these CIs are not displayed
in the System Monitors only Perspective, System Hardware Monitoring, and System Software
Monitoring views.
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This chapter describes how to integrate NNMi with OMi.
1.

Prerequisite
Make sure you have the OMi and NNMi licenses installed. For details, see the OMi Administration
Guide.

2.

Perform the integration in NNMi
Perform the steps needed to integrate NNMi with OMi in the NNMi application.
For details, see the Network Node Manager i Software—Business Service
Management/Universal CMDB Topology Integration Guide.

3.

Configure LW-SSO in both OMi and NNMi
To be able to seamlessly switch between NNMi and OMi, it is recommended to use LW-SSO.
Make sure that LW-SSO is configured in both OMi and NNMi with the same initString. For details
on how to configure the initString in OMi, see the OMi Administration Guide. For details on how to
configure the initString in NNMi, see the NNMi Deployment Reference.
It is also possible to integrate NNMi with OMi without using LW-SSO. In this case, you are
prompted for a password every time you switch to an NNMi component.

4.

Connect NNMi to more than one OMi instance
After connecting the first OMi instance to NNMi, NNMi stores in its own database the CI IDs
gained from the topology synchronization of the OMi's RTSM. When another OMi instance is
connected, another topology synchronization is carried out. As the OMi instances might contain
some of the same CI IDs, the IDs need to be reconciled in the NNMi database. This reconciliation
works only partially and the NNMi log files still include several reconciliation errors that are caused
by the non-existing RTSM IDs. To fix the problem, perform the following steps:
a. Change the integration to the new OMi system.
b. Log on to the NNMi JMX console http://<NNMi_fqdn_and_port>/jmx-console using the
system account and password.
c. Go to mbean NnmBsmModule.
d. Run java.lang.String resetNnmBsmIds().
You should see a list of devices from which the RTSM ID was removed.
e. Disable and enable the topology integration to get the CIs into RTSM.

5.

Configure OMi to display NNMi data
To display NNMi data in OMi and to access the NNMi components in Workspaces > My
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Workspace:
a. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
b. Select Foundations.
c. Select Integrations with other applications.
d. In the Integrations with other applications - HP NNM table, locate and modify the
following parameters:

6.

n

HP NNM Integration URL. The NNMi host and port number (protocol://host:port/nnm).

n

HP NNM User name. The user name that is used for logging on to NNMi.

n

HP NNM User password. The user password that is used for logging on to NNMi.

Results
You can view NNMi data in Workspaces > My Workspace, as described in "NNMi Components
in My Workspace" on page 178.
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If you set up an integration between NNMi and OMi, you can view the NNMi components described
below in Workspaces > My Workspace as follows:
Note: Make sure you have a View Explorer component configured in addition to the new NNMi
component. The View Explorer component pulls the node information needed by the NNMi
component. For more information on the View Explorer component, see the OMi User Guide.
1. Click the New Page icon.
2. Click Add Component. The Component Gallery window opens.
3. In All Categories, select the NNMi check box.
To access the NNMi components, you must have the appropriate licenses installed. NNMi
components are only displayed if you configured a connection to an NNMi server in Infrastructure
Settings:
Administration > Setup and Maintenance > Infrastructure Settings
Select Foundations > Integrations with other applications > HP NNM.
Component
Name

Description

Layer 2
Neighbor
View

Shows a map view of a selected device and its connector devices within a
specified number of hops from the selected device. This view is useful for
understanding the switch connectivity between devices.

Layer 3
Neighbor
View

Shows a map view of a selected device and its connector devices within a
specified number of hops from the selected device. This view is useful for
understanding the router connectivity between devices.

MPLS VPN
Inventory

This is an enterprise customer view of how their sites are connected via service
provided MPLS networks.

Open Key
Incidents

Shows the incidents that are most important to network operators and that often
require more immediate action.

Overall
Network
Health (Node
Group
Overview)

Displays a map containing all (top-level) Node Groups that do not have parent Node
Groups.

Overall
Network
Health Routers

Displays a Node Group Map of the Router connectivity in your network.
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Component
Name

Description

Overall
Network
Health Switches

Displays a Node Group map of the Switches connectivity in your network.

Router
Redundancy
Groups
Inventory

Shows the available Router Redundancy Groups created by the NNMi
administrator. Each Router Redundancy Group is a set of two or more routers that
use one or more virtual IP addresses to help ensure that information packets reach
their intended destination.
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HPE Operations Orchestration (OO) provides a simple way for customers to run scripts for automatic
actions. The integration with OMi uses the OO capabilities for building investigation tools or service
remediation scripts, providing the operators with a simple way to validate a problem, investigate it, or
automatically correct it. A run book can be executed manually.
OO run books can be launched from the Service Health and Event Browser applications.
The integration of OMi and OO provides the capability of mapping CI types to OO run books.
After you create such mappings, you can run the mapped OO run books:
l

l

On CIs, using the Invoke Run Books context menu option in Service Health. The OO run
book parameters are populated using the map to the CI attributes defined in the Run Book Mapping
Configuration wizard. For detailed information about the wizard, see the OMi Administration Guide.
At the event level. OMi opens an event and checks if the CI for this event has a run book assigned
to it, and if the run book is set to run automatically. The OO run book parameters are populated using
the map to the CI or event attributes defined in the Run Book Mapping Configuration wizard. For
detailed information about the wizard, see the OMi Administration Guide.
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This chapter describes how to integrate OMi and OO.
1.

Prerequisites
Before you configure the integration, the OO administrator needs to perform the following:
a. Enable user authentication and create an integration user with the Administrator role:
n

OO version 10.02 or higher: The user must be internal.

n

OO 9.xx: The user must be external.
Users must have the following capabilities in OO: AUTHOR, SCHEDULE, MANAGE_
RUNS, RUN_REPORTS, and HEADLESS_FLOWS. You can either add users to groups
with these capabilities (for example, the administrator group has these capabilities) or you
can create such a group.

b. Deploy the following OO Content Packs (CPs) on the OO server: Base, Middleware, and
Operating Systems. For OO version 10.50 and higher, also deploy the Third-party content
pack.
First deploy the Base CP, and then the other CPs.
For details on how to deploy CPs in OO, see the OO documentation.
Note: If you have upgraded to a newer OO version, you must also upgrade the OO
Content Packs. For more information on Content Packs, see the HPOO documentation.
c. If you want to configure run book automation in a set up with a load balancer and a firewall,
ensure that port 8443 is open. If port 8443 is not open, the automatic run book execution will
fail. The Automatic Run Book Execution is triggered from the data processing server.
2.

Configure the link between OMi and OO
To configure the integration between OMi and OO, in OMi:
a. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
b. Select Foundations.
c. Select Integrations with other applications.
d. In the HPE Operations Orchestration table, locate Operations Orchestration application
URL, and modify the setting to the URL used to access the OO application.
When connecting an OMi instance that employs Lightweight Single Sign-On (LW-SSO) to OO
version 10.02 or higher, you must specify the connection URL of OO using the following
format: <protocol>://<FQDN>:<portNumber> (for example, http://lab.lab:8080). The port
can be 8080 for HTTP or 8443 for HTTPS, according to your needs. For OO 9.xx, use:
https://<fully qualified server name>:8443.
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If you want to enable run books to be invoked automatically, you must enter a User Name and
Password in the same table. In this case, the user should be defined as internal in OO.
e. OO 9.xx only: To be able to invoke run books automatically, the user must be internal.
3.

Configure LW-SSO authentication
Configure LW-SSO authentication between OMi and OO. You must configure LW-SSO in both
OMi and OO. Proceed to the relevant section depending on your version of OO.
For OO version 9.05 or lower:
a. Make sure Single Sign-On for OMi is enabled (it is disabled by default). In OMi, open
Authentication Management:
Administration > Users > Authentication Management
Copy the Token Creation Key (initString) to OO, and replace, in OO, all the initStrings in the
lwssofmconf.xml file located in the <OO installation directory>\Program Files\HewlettPackard\Operations Orchestration\Central\conf\ directory.
b. In OO, in the web.xml and applicationContext.xml files located in the
<OO installation directory>\Program Files\Hewlett-Packard\
Operations Orchestration\Central\WEB-INF\ directory, enable all filters and mappings
between LWSSO_SECTION_BEGIN and LWSSO_SECTION_END.
c. If OO and OMi are in different domains in the Windows operating system, you must make sure
that the Trusted Hosts/Domains parameter is the same in OO and OMi. To set the
parameter in OMi, open Authentication Management:
Administration > Users > Authentication Management
Configure the Trusted Hosts/Domains parameter.
d. Restart the following OO services:
n

For OO version 9.02 or lower: RSCentral, RSJRAS, and RSScheduler.

n

For OO version 9.03, 9.04, or 9.05: RSCentral and RSJRAS.

Note: If you need to enable logging for debugging LW-SSO: In OO, in the <OO installation
directory>\jetty\resources\log4j.properties file, uncomment the line that appears under the
LW-SSO comment.
For OO version 9.06 or higher:
a. Make sure Single Sign-On for OMi is enabled (it is disabled by default). In OMi, open
Authentication Management:
Administration > Users > Authentication Management
n

In the Single Sign-On Configuration section, click Configure. In the resulting window,
click Next. Select Lightweight as the Single Sign-On authentication mode.

n

Copy the Token Creation Key (initString).

n

Add the domain where your OMi and OO systems are located to the Trusted
Hosts/Domains section.

n

Click Finish.

b. In OO, access the following:
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n

For OO version 10.20 or higher, select System Configuration > Security > SSO.

n

For OO version 10.02 or higher (except version 10.20), select System Workspace >
Security > SSO.

n

For OO version 9.xx, select Administration > System Configuration >
Authentication.

c. For OO version 9.2x, select the Enable Authentication check box in the LW SSO Settings
area.
d. Replace the value of the LW SSO passphrase or the InitString parameter with the Token
Creation Key you copied from OMi. (This must have the same value on all OMi instances that
are integrated using LW-SSO.)
e. Define domain-related parameters in the LW SSO Settings area:
n

Domain. The domain of the OO server.

n

Protected Domains. List of comma-separated domains used by the OMi instances that
employ LW-SSO.
Note: If OO and OMi are in different domains in the Windows operating system, make
sure that the Trusted Hosts/Domains parameter is the same in OO and OMi.

In OMi, open Authentication Management:
Administration > Users > Authentication Management
Configure the Trusted Hosts/Domains parameter.
Note: Limitation with OO 10.02 or higher and OMi
The integration of OO 10.02 or higher with OMi is currently only supported if OO and OMi are
in the same domain. If they are in different domains, the integration fails.
For further details on configuring LW-SSO in OO, see the OO documentation.
For further details on configuring LW-SSO in OMi, see the OMi Administration Guide.
4.

Export server certificates from OO
To export server certificates from OO and import them into OMi in a Windows or Linux
environment, use the keytool utility, which is included in JRE.
For OO 9.xx:
a. On the OO server, enter:
n

Windows:
[OO install folder]\jre1.6\bin\keytool -keystore "[OO install folder]\Central\conf\rc_
keystore" -export -alias pas -file "<path>\<Operations Orchestration fully qualified
host name>.cer"

n

Linux:
keytool -keystore "$ICONCLUDE_HOME/Central/conf/rc_keystore" -export -alias
pas -file "<path>/<Operations Orchestration fully qualified host name>.cer"

b. When prompted for a password, enter bran507025.
For OO version 10.02 or higher
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a. On the OO server, enter:
n

Windows:
[OO install folder]\java\bin\keytool.exe -keystore "[OO install
folder]\central\var\security\key.store" -export -alias tomcat -file
"<path>\<Operations Orchestration fully qualified host name>.cer"

n

Linux:
keytool -keystore "$ICONCLUDE_HOME/central/var/security/key.store" -export alias tomcat -file "<path>/<Operations Orchestration fully qualified host
name>.cer"

b. When prompted for a password, enter changeit.
5.

Import OO server certificates to OMi
Import the server certificate from the OO server to the OMi Gateway Server so that the two
systems can communicate with each other securely.
a. Import the Server Certificate to OMi. To import the server certificate you exported from OO
to the OMi cacerts keystores, on the OMi Gateway Server and Data Processing Server:
n

Windows:
Enter the following commands:
l

n

"%TOPAZ_HOME%\JRE\bin\keytool" -keystore "%TOPAZ_
HOME%\JRE\lib\security\cacerts" -import -alias "<Operations Orchestration
fully qualified host name>" -file "<path>\<Operations Orchestration fully
qualified host name>.cer"

Linux:
Enter the following command:
$TOPAZ_HOME/JRE/bin/keytool -keystore "$TOPAZ_
HOME/JRE/lib/security/cacerts" -import -alias "<Operations Orchestration fully
qualified host name>" -file "<path>/<Operations Orchestration fully qualified host
name>.cer"
Note: If TOPAZ_HOME is not set, use the following script:
. /opt/HP/BSM/scripts/topaz_env.sh

b. When prompted for a password, enter changeit.
c. To prevent a certificate error, make sure that this certificate is imported as a trusted root
certification authority on any browser that will be accessing OMi.
The procedure for importing the certificate may vary slightly depending on the type of browser
that you are using. For example, if you are using Internet Explorer, follow these steps:
i. Click Tools > Internet Options > Content > Certificates.
ii. In the Trusted Root Certification Authorities tab, click the Import... button.
iii. Click Next to start the Certificate Import Wizard.
iv. Specify the file you want to import, and then click Next.
v. Select the Place all certificates in the following store radio button, and then click
Browse.
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vi. Select Trusted Root Certification Authorities, and then click Next.
vii. Click Finish.
d. Restart OMi on the Gateway server.
Note: Repeat the above steps on the Data Processing Server as well.
6.

Grant permissions
Grant permissions so that users can create, view, and modify the mapping between OMi CI types
and OO run books, and invoke OO run books from OMi.
To integrate with OO, you must set up users in OMi with specific permissions. Select
Administration > Users > Users, Groups, and Roles
Select the user or create a new user and grant them a role with Operations Orchestration
Integration permissions.
When setting up the users, keep in mind the following:
o

Set up an integration user with the same name in OMi and OO (for example, OMiOO_integr_
user).
Note: The username in OO should have all lowercase letters. If users with the same
username but different case sensitivity exist in OO, the lowercase username is used.

o

o

7.

In OMi, the user must have the following permissions to execute Run Books:
n

The Operations Console > Run Book Execution permission.

n

The Advanced RTSM Permissions > Resources (tab) > Resource Type > Queries
permission.

n

The Advanced RTSM Permissions > Resources (tab) > Resource Type > Views
permission.

n

The Advanced RTSM Permissions > General Actions (tab) > CI Related Actions
permission.

n

The Advanced RTSM Permissions > General Actions (tab) > Data Retrieval Actions
permission.

To enable an OMi user to map a run book to the selected CI type, in OMi, the user must have
the Operations Console > Run Book Mappings permission to administer Run Books.

Map run books to CI Types
You can map OO run book parameters to:
o

CI type attributes. For details on the user interface, see the OMi Administration Guide.
The child CIs of a CI, for which you configure a run book, are also assigned to that run book.
Note: To be able to map run books to CI types, either create a run book flow in OO, or
import a content pack in OO with the Content Workspace.

o

The event attributes are predefined in OMi.
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For details, see the OMi Administration Guide.
8.

Use OO functionality from OMi
You can trigger a run book:
o

From Service Health by using the Invoke Run Books context menu option.

o

From the Event Browser by using the context menu or from the Action Panel.
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Log Files
The oo_integration.log file enables you to perform basic troubleshooting of problems with OO
integration and runbook execution.
For automatic runbook execution, the oo_integration.log file is available on the data processing
server:
<OMi_HOME>/log/opr-backend/oo_integration.log
Log configuration can be performed in:
<OMi_HOME>/conf/core/Tools/log4j/opr-backend/OOIntegration.properties
For setting up and configuring the OO integration, as well as manual runbook execution, the log file is
available on the gateway server:
<OMi_HOME>/log/jboss/oo_integration.log
Log configuration can be performed here:
<OMi_HOME>/conf/core/Tools/log4j/jboss/OOIntegration.properties
Connection Errors
If you receive a connection error when you select run books in the Available Run Books pane
(Library > Operations), change the run.book.timeout and service.center.ws.timeout settings from
10000 to 60000 (1 minute):
1. Open a JMX console on the OMi server:
https://localhost:29000
2. Select Foundations > service=Infrastructure Settings Manager.
3. To set the values, use setSettingValuePerCustomerId() with contextName: integrations and
settingName: settings.pm.settings.run.book.timeout or
settings.pm.settings.service.center.ws.timeout. Change to newValue: 60000.
Note: Restarting OMi is not required.
Different Domains
If OMi and OO are in different domains, and you are using Internet Explorer as your browser, you may
need to add the domains to the list of allowed domains in the Privacy tab (Internet Options > Privacy
> Sites).
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This section describes two possible scenarios to integrate OMi and OO.

Use Case Scenario in Service Health
In OO, the Restart a Node run book is associated with a Node CI Type. The parameters of the run
book are mapped to the relevant CI attributes of the Node CI.
In Service Health, the operator detects that a host has a system problem. The operator right-clicks the
CI to get a list of the run books relevant to the CI. One of the run books is Restart a Node. The run
book can execute automatically because the values of the parameters such as the host name or the IP
address are automatically populated by data taken from the CI context.

Use Case Scenario in the Event Browser
In the OMi Event Browser, the operator is going through the assigned events. The operator detects an
event related to a lack of disk space that causes a database performance issue. From the event
context, the operator can get a list of relevant run books. The operator can launch the appropriate run
book manually. The run book continues running without further input from the operator as all run book
parameters are extracted from the event or related CI.
Tip: If you set up the integration between OO and OMi, you can also use Automatic Run Book
Execution to run an OO flow as an automatic action. For details, see the OMi Administration
Guide.
Although OO flows are not set up as an automatic action in the policy, you can run OO flows
automatically when the event comes into OMi, or as a result of time-based event automation.
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Starting from the Operations Analytics (OpsA) version 2.30, you can integrate OpsA into your OMi
environment.
The integration between OMi and OpsA provides you with the following capabilities:
l

l

l

Cross Launch Integration. You can configure an integration that enables you to open Operations
Analytics directly from OMi in the context of a specific event or host. For more information, see
"Operations Analytics Cross Launch" on page 192.
OMi Dashboard Integration. It is possible to configure a dashboard that displays the OpsA user
interface within OMi. This can be done by adding opsa as a new component to OMi. For more
information, see the "Operations Analytics Dashboard Integration" on page 193.
OpsA alerts > OMi events. You can enable forwarding of OpsA alerts to OMi, so that they are
managed as OMi events. OpsA alerts are triggered by the OpsA operator for the selected topology
elements in OpsA. To be able to manage OpsA alerts within OMi, you must first configure
connections between OMi and OpsA. For more information on how to do this, see "Workflow:
Configuring Connections Between OMi and OpsA" on page 196.
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Chapter 33: Operations Analytics Cross Launch
You can configure an integration that allows you to open Operations Analytics from OMi in the context
of a specific event or host. This allows you to open analysis tools from Operations Analytics, such as
log analytics and predictive analytics, quickly and easily in the appropriate context.

How to set up a Cross Launch Integration for OMi
Events
You can configure a cross launch for individual CI types from the OMi Operations Console. To do so,
perform the following steps:
1. In OMi, navigate to:
Administration > Operations Console > Tools
2. In the CI Types pane, select the CI type for which you want to enable the cross launch.
3. In the Tools pane, select

New. Fill in the appropriate values on the General tab.

4. On the Type tab, select URL.
5. On the URL tab, specify a URL as seen in the following example:
http://<opsa_
server>:8080/opsa/#/dashboard&search=host%20withkey%20%22${event.node.dnsNam
e}%22&start=${event.timeReceieved.seconds}&end=~0h&selectedTimeRange=CUSTOM_
TIME
For details, see "Operations Analytics URL Syntax" on page 201.

How to Use a Cross Launch Integration from OMi
1. In OMi, navigate to:
Workspaces > Operations Console > Event Perspective
2. Right click the desired event, and selected Launch > Tool... from the context menu.
3. Select the tool that you created for the OpsA cross launch and click Run.
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Chapter 34: Operations Analytics Dashboard
Integration
In this chapter, you will configure an OMi dashboard that displays the event browser and the Operations
Analytics user interface.
1. Prerequisite. LWSSO must be configured in the Operations Analytics environment. For more
information on configuring LWSSO in Operations Analytics, see the Operations Analytics
Configuration Guide.
2. In OMi, create a new component with a name of your choice and the URL <opsa server
FQDN>:<port>/<dashboard name>.
3. Use the Configure Wiring section to append the URL you want to use when opening OpsA. For
example, the fragement /dashboard&search=host%20withkey%20%22<<relatedCi.name>>%22
opens a dashboard focusing on a CI.
For details, see "Operations Analytics URL Syntax" on page 201.

4. Create a new page, and add the component you just created, as well as the Event Browser
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component to the page.
5. Verify the wiring configuration for the page is as follows:

6. Save the page.
7. In Operations Analytics, locate <opsa_
server>/opt/HP/opsa/jboss/standalone/deployments/opsa-ui-web.war/WEBINF/web.xml.
Modify the following section from:
<init-param>
<param-name>X-Frame-Options</param-name>
<param-value>SAMEORIGIN</param-value>
</init-param>

To:
<init-param>
<param-name>X-Frame-Options</param-name>
<param-value>Allow-From http://<OMi URL>/opr-web</param value>
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8. Restart Operations Analytics by running the command opsa-server restart.
9. HPE recommends adding a mapping of the Operations Analytics IP and the Operations Analytics
FQDN in the window host file in every client machine that will be used to access Operations
Analytics.
10. Delete the cookies of all browsers used to access OMi.
11. Add the FQDN of the Operations Analytics environment to the list of trusted hosts in OMi from the
Authentication Management section. To do so, navigate to Administration > Users >
Authentication Management. In the Single Sign-On Configuration section, click Configure
and add the OpsA FQDN to the list of trusted hosts.
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1.

Install the Operations Agent on the OpsA server
To be able to manage OpsA alerts as OMi events, it is necessary to configure an OpsA server as
an OMi managed node. This means that you must have the Operations Agent installed on the
OpsA server, which then enables monitoring the OpsA alerts and forwarding them to OMi.
For task details, see "Installing the Operations Agent on the OpsA Server " on page 198.

2.

Connect the Operations Agent to the OMi server
In addition to monitoring OpsA alerts, Operations Agent forwards them to OMi. Therefore, make
sure to connect the Operations Agent to OMi.
For task details, see "How to Connect the Operations Agent to OMi" on page 199.

3.

Deploy and assign the management template from OMi to OpsA
Import the OMi_Content_Pack-OPSA.zip from OpsA to OMi. The imported management template
must be deployed and assigned to the OpsA server so that it can monitor the log file in which the
OpsA alerts are written.
For task details, see "How to Deploy and Assign Management Templates to an OpsA Server " on
page 200.

Overview: Forwarding OpsA Alerts to OMi
You can configure the Operations Agent to retrieve alerts from OpsA and forward them to OMi as
events. This enables you to get the benefit from using both the capabilities of OpsA to identify events
by using analytic tools and the advanced event management capabilities available with OMi.
If configured so in OpsA, the OpsA alerts are logged into a predefined log file located on the OpsA
server. When the Operations Agent is installed and configured on the OpsA server as an OMi monitored
node, it enables Logfile Entry policies to monitor this log file and then forward the OpsA alerts to OMi to
be managed as events. You can filter the log file entries by a set of rules in these policies. The following
is the pattern of the log line in the policy:
<*.instanceId>;<*.tenant>;<*.userId>;<*.alertId>;<*.alertName>;<*.alertType>;<*.sev
erity>;<*.conditionString>;<*.schedule>;<*.triggerTime>;<*.calculationPeriod>;<*.al
ertInstanceLink>;<*.allAlertsLink>;<*.description>

Note: The OpsA alerts are sent with the Low, Medium and High severities, which are then mapped
to the OMi severities (Critical, Major and Normal) in the policies.
For more information about policy management in OMi, see the OMi Administration Guide.
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The following diagram shows the details of this integration:
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the OpsA Server
To be able to manage OpsA alerts as OMi events, you must configure the OpsA server as an OMi
monitored node. This means that you must install the Operations Agent on the OpsA server so that the
policy templates can monitor the log file in which OpsA alerts are written and create appropriate events
in OMi.
Note: To be able to use OMi Monitoring Automation features, the Operations Agent 12 or later is
required.
When installing the agent, specify the gateway server, the load balancer, or the reverse proxy as the
agent's management server. For information about installing the Operations Agent, see the Operations
Agent and Operations Smart Plug-ins for Infrastructure Installation and Configuration Guide.
When the communication between the agent and the OMi server is established and the agent
processes are running, a node CI is created in the RTSM for the OpsA server. You can then deploy
management templates, aspects, policies, and instrumentation to the node. Alternatively, if the node
matches an automatic assignment rule, OMi creates an assignment for the CI, and starts the
deployment jobs required to transfer the monitoring configuration to the node. After the agent starts
monitoring the system, it sends events to OMi, which you can view in the Event Browser.
Note: The Operations Agent is available on the HPE Operations Agent media DVD, which is
included in the OMi media kit. The latest agent updates can be downloaded from the HPE
Software Support website.

HPE Operations Manager i (10.12)

Page 198 of 207

Chapter 37: How to Connect the Operations
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When you install the Operations Agent on the OpsA server, you connect it to OMi if you enter the
management server. If this is not the case, for example, when the agent is installed in inactive mode,
you must manually connect the agent to OMi, and then grant the required certificates to connect the
OpsA server as a monitored system to Monitoring Automation. To do so, follow these steps:
1. Connect the agent to OMi:
a. Log on to the OpsA server.
b. Navigate to the following location:
n

Windows 64-bit: %OvInstallDir%\bin\win64\OpC\install
Windows 32-bit: %OvInstallDir%\bin\OpC\install
%OvInstallDir% default: C:\Program Files\HP\HP BTO Software\

n

AIX, HP-UX, Linux, and Solaris: /opt/OV/bin/OpC/install/

c. Run the following script to install the Operations Agent on the gateway server:
n

Windows: cscript oainstall.vbs -a -i

n

AIX, HP-UX, Linux, and Solaris: oainstall.sh -a -i

d. Run the following script:
n

Windows: cscript opcactivate.vbs -srv <Gateway_Server>

n

AIX, HP-UX, Linux, and Solaris: opcactivate.sh -srv <Gateway_Server>

2. In the OMi user interface, open the Certificate Requests manager and accept the new certificate
request:
Administration > Setup and Maintenance > Certificate Requests
For more information about granting certificate requests, see the OMi Administration Guide.
Tip: You can grant certificates automatically by using preconfigured IP ranges or a groovy
script. For details, see the OMi Administration Guide.
3. Optional. Check HTTPS communication in both directions:
bbcutil -ping https://<FQDN>
If the connection is successful, the command returns status=eServiceOK.
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Management Templates to an OpsA Server
You import a content pack form OpsA to OMi, and then deploy and assign the imported management
templates to the OpsA server so that they can listen to the log file where the OpsA alerts are written. To
do so, follow these steps:
1. Import the OMi_Content_Pack-OPSA.zip content pack to OMi from the following location on the
OpsA server:
<opsa_server>/opt/HP/opsa/omi_content_pack/
For more information on importing content packs to OMi, see the OMi Administration Guide.
2. In OMi, open Management Templates & Aspects:
Administration > Monitoring > Management Templates & Aspects
3. In the Configuration Folders pane, select the OPSA folder.
4. In the Management Templates & Aspects pane, select OPSA alerts and click Assign and
Deploy Item...

.

Note: The Assign and Deploy Item button is grayed out if the policy template contains a stub
instrumentation. Upload the instrumentation by using the Content Manager.
5. In the Assign and Deploy wizard, select ops as the configuration item to which you want to
assign the management template. Specify parameters and configuration as needed, then click
Finish.
6. Optional. In the Configure Options page, clear the Enable Assignment(s) check box if you do not
want to enable the assignment immediately. You can enable the assignment later by using the
Assignments & Tuning manager.
7. Click Finish. OMi creates deployment job, which deploys the management template to the node.
Note: After a policy template is deployed, the OMi server specified in the Default Virtual
Gateway Server for Data Collectors URL infrastructure setting becomes the owner of the
policy on the node.
8. To verify the deployment, select OPSA alerts in the Management Templates & Aspects pane and
click

List Assignments for Selected Item...

Note: After a policy template is deployed, the OMi server specified in the Default Virtual
Gateway Server for Data Collectors URL infrastructure setting becomes the owner of the
policy on the node.
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Chapter 39: Operations Analytics URL Syntax
The following section contains syntax examples that can be used when creating URLs to Operations
Analytics servers.
Note: These examples are for illustration purposes to help you construct your own URLs. They
have not been tested with every possible integration.
The following section contains syntax examples that can be used when creating URLs to Operations
Analytics servers.
Time

Symbol

Examples

Hours

h

1h, 2h, 3h

Days

d

1d, 2d, 3d

Weeks

w

1w, 2w, 3w

Months

m

1m, 2m, 3m

Using start and end to specify the time window

URL examples:
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URL

Use Case

Display
http://<opsa_
main
server>:8080/opsa/#/dashboard&search=withkey"${event.node.dnsName}"&sta
dashboar rt=1h
d focused
on the
relevant
event
focused
on the
last 1
hour.
Display
http://<opsa_
main
server>:8080/opsa/#/dashboard&search=withkey"${event.node.dnsName}"&sta
dashboar rt=${event.timeCreated.seconds}&end=~8h~
d focused
on the
relevant
event
focused
on 8
hours
before
and after
the
current
time.
Display
http://<opsa_
main
server>:8080/opsa/#/dashboard&search=withkey"${event.node.dnsName}"&sta
dashboar rt=${event.timeCreated.seconds}&end=~2d
d focused
on the
relevant
event
focused
on the
last two
days.
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URL

Use Case

Display
http://<opsa_
the
server>:8080/opsa/#/dashboard&search=OAEnvironmentOverview&start=1h
OAEnvir RTSM
onment
dashboar
d, which
displays
a
performa
nce
overview,
focusing
on the
last hour.
Display
the
RTSM
overview
dashboar
d
focusing
on the
last
week.

http://<opsa_server>:8080/opsa/#/dashboard&search=RTSMOverview&start=1w

Display
http://<opsa_server>:8080/opsa/#/dashboard&search=Multiple Hosts
the main ("host1", "host2", "hostN") dashboard
dashboar &start=1436088226634&end=1436091826634&selectedTimeRange=ONE_HOUR
d focused
on more
than one
host.
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OpsCx captures data such as events, metrics, and topology from third-party systems. Events and
topology data are forwarded to OMi; metrics data is stored locally on the OpsCx system and can be
viewed in OMi by using the embedded Performance Graphing component. Service Health Reporter, a
high-capacity performance reporting solution also enables you to generate reports on data collected by
OpsCx.

To access
In OMi, select:
Administration > Setup and Maintenance > Connected Servers
For details on configuring an Operations Connector server in OMi, see the Operations Connector User
Guide.

OpsCx Integrations Overview
From the Connected Servers page, you can access and maintain all OpsCxs in the OMi deployment
environment, regardless of the operating system or host location on which the OpsCx is installed.
The Connected Servers page enables you to add, modify, or remove OpsCx integrations from the OMi
deployment environment.
Before you can add an OpsCx integration, OpsCx must be installed in the OMi deployment
environment. That is, the OpsCx host must have access to at least one OMi Gateway Server in the
OMi deployment environment to which it sends the collected data. Additionally, OpsCx must have
access to the third-party system from which it is collecting data.
For some types of data sources, OpsCx must be installed and run locally on the host of the third-party
system with which it is integrating. Examples for local data sources are XML files, open message
interface messages, and scheduled tasks. For other types of data sources, OpsCx can be installed on
the host of the third-party system or on a remote system. For more information on supported data
sources, see OpsCx Help.
The following diagram shows an example of an OMi deployment environment with four OpsCx
integrations.
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For information about installing OpsCx, see the OpsCx Installation and Upgrade Guide.
Controlling data transfer with policies
The data transfer is controlled by policies that you define in OpsCx. Policies monitor the data sources
and, if certain conditions apply, forward the data in the form of events or metrics to OMi. The policies
can optionally also map the data to topology and create configuration items (CIs) and CI relationships in
OpsCx. This enables OMi to associate the events and metrics it receives with CIs.
Out-of-the box integrations
You can use one of the out-of-the box integrations that are available for Operations Connector.
Alternatively, if you do not find the integration that you are looking for, you can develop your own
custom integration.
HPE is continually updating the list of the integrations with third-party products. For details and for
download information, see the HPE Live Network Content Marketplace:
https://hpln.hpe.com/group/bsm-integrations.
More information
For complete information about the features, capabilities, and usage of OpsCx, see OpsCx Help after
you install OpsCx. To access the help, click Help
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:
Feedback on OMi Integrations Guide (Operations Manager i 10.12)
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to ovdoc-asm@hpe.com.
We appreciate your feedback!

Go OMi!

